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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
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Saturn DigiSizer II 5205 Organization of the Manual
1.  GENERAL INFORMATION 

This manual provides a description of the Saturn DigiSizer system, its menu options, and oper-
ating instructions. 

To help you operate the Saturn DigiSizer more efficiently:

• read Chapter 2, User Interface, before operating the analyzer and its software
• use the step-by-step instructions in Chapter 3 when performing common operations 

Organization of the Manual

The Saturn DigiSizer operator’s manual is organized as follows:

Chapter 1 General Information

Provides a general description of the Saturn DigiSizer system, its 
features, and specifications. 

Chapter 2 USER INTERFACE

Provides basic instrument and software interface. 

Chapter 3 OPERATIONAL PROCEDURES

Provides step-by-step procedures of common operations for the Saturn 
DigiSizer.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS

Provides instructions for installing software updates and for modifying 
setup configurations.

Chapter 5 FILE MENU

Provides a description of the commands available from the File menu.

Chapter 6 UNIT MENU

Provides a description of the commands available from the Unit menu.

Chapter 7 REPORTS MENU

Provides a description of the commands available from the Reports 
menu.
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Chapter 8 OPTIONS MENU

Provides a description of the commands available from the Options 
menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE

Provides user maintenance and service information.

Chapter 10 ORDERING INFORMATION

Provides ordering information for the Saturn DigiSizer system 
components.

Appendix A ERROR MESSAGES

Lists the error messages displayed by the Saturn DigiSizer analysis 
program; includes cause(s) and action(s) for each.

Appendix B SAMPLE DISPERSION AND CONCENTRATION

Provides methods for dispersing samples and adjusting sample 
concentration.

Appendix C CHEMICAL AIDS FOR PARTICLE DISPERSION

Provides a list of dispersants and their active ingredients.

Appendix D LIQUID DENSITY AND VISCOSITY DATA

Provides density and viscosity data for common dispersants.

Appendix E SOURCES OF DISPERSING AIDS

Provides a list of suppliers for common dispersants.

Appendix F DATA REDUCTION

Contains the calculations used for producing reports.

Appendix G FORMAT OF EXPORTED DATA

Contains the format and a description of exported data.
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Manual Conventions

This manual uses the icons shown below to identify notes of importance, cautions, and 
warnings.

Appendix H BACKGROUND QUALITY

Provides criteria for obtaining and determining an acceptable 
background.

Appendix J MASTERTECH INSTALLATION

Provides instructions for installing the MasterTech autosampler.

Appendix J LIQUID SAMPLE HANDLER INSTALLATION

Provides instructions for uninstalling and installing a liquid sample 
handler.

Index INDEX

Provides quick access to a subject matter.

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that may cause personal 
injury.

Cautions contain information that help you prevent actions that may damage the 
analyzer.
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Safety Awareness

Safety precautions and warnings are inserted throughout this manual in appropriate sections. It 
is important that you read and observe these precautions and warnings in order to prevent per-
sonal injury and/or damage to the instrument.

The Saturn DigiSizer uses a laser beam in its analysis process. Direct exposure to a laser beam 
can be hazardous. Therefore, for your protection, the Saturn DigiSizer contains an interlock 
safety device which disables laser operation if the analysis compartment is opened during an 
analysis. Do not, under any circumstances, attempt to override this safety interlock. Doing so 
may allow exposure to the laser beam at an intensity of up to 7 mW at 658 nm.

The Saturn DigiSizer is completely safe to operate. There is no danger of exposure to the laser 
beam when the Saturn DigiSizer is operated as directed in the operator’s manual, and all cau-
tions and warnings are observed.

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous laser light exposure.
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Equipment Description

Saturn DigiSizer

The Saturn DigiSizer 5205 System consists of up to two particle size analyzers, each with a 
liquid sample handler, and one multifunction personal computer. You can also install up to two 
MasterTech 052 Autosamplers allowing automatic analysis of up to 18 samples each.

The Saturn DigiSizer uses a laser in conjunction with a CCD (charge-coupled device) contain-
ing over three million detector elements to measure particle size. These detectors are placed so 
that they can measure the intensity of light scattered by the particles at various angles. Light is 
scattered by particles in a pattern dependent on their size, shape, refractive index, and wave 
length of incident light. Based on the Mie theory, the particle size distribution is calculated 
from the angle distribution of the scattered light intensity collected by the detectors. 

Both organic and inorganic particles can be analyzed and measured over a range of 0.06 to 
2100 micrometers. The Saturn DigiSizer includes a complete system for circulating the dis-
persing liquid/sample mixture through the cell and reservoir, as well as to an external waste 
container.
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Liquid Sample Handler

The Saturn DigiSizer requires the use of a sample handler (shown with the DigiSizer in the 
previous illustration) to transfer the sample to the analyzer for analysis. The sample handler 
also allows for connection of an ultrasonic probe to assist in sample dispersion.

The sample handler enables automatic sample handling. All you have to do is define analysis 
conditions (in the sample file), add the sample to the reservoir (containing the dispersing liq-
uid), and start the analysis. Your sample will be automatically monitored and diluted when 
necessary; and your system rinsed after each analysis (when specified in the sample file).

The Liquid Sample Handler is available in two configurations: 

• Standard unit: includes a reservoir that holds 500 to 600 mL of dispersed sample. This 
model is best suited for samples containing coarse particles, or for those of high density. 

• Low-Volume unit: includes a reservoir that holds 100 to 120 mL of dispersed sample. 
This model is best suited for analyses where the sample quantity or dispersion liquid is 
limited, or where the dispersion liquid may be hazardous or difficult to dispose of. 

Analysis Program

The Saturn DigiSizer 5205 analysis program is designed to operate in the Windows XP Pro-
fessional or Windows Vista® Business or Ultimate environment and includes wizards and 
intuitive screens enabling you to perform system operations quickly and efficiently.

Also included is a report system which allows you to manipulate and customize reports. You 
can zoom in on portions of the graphs or shift the axes to examine fine details. Scalable graphs 
can be copied to the clipboard and pasted into other applications. Reports can be customized 
with your choice of fonts and a company logo added to the report header for an impressive 
presentation. Refer to Onscreen Reports, page 7-20 for additional information.

To make it easier for you to obtain information when needed, an online manual is included on 
the Help menu. This enables you to access the desired information in just a few mouse clicks. 
Refer to Online Manual, page 2-21 for additional information and navigation methods.
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MasterTech 052

The MasterTech 052 is an automatic sampling device that operates in conjunction with the 
Saturn DigiSizer. The MasterTech allows you to queue as many as 18 predispersed samples to 
run consecutively and unattended. It allows samples to be redispersed either by stirring only or 
by stirring and disruption with an ultrasonic probe. 

During operation, the beaker tray is loaded with beakers containing predispersed sample. 
When the Saturn DigiSizer is ready for a sample, the tray rotates until in the correct position 
for transfer. The sample is stirred for a user-specified length of time just before transfer to the 
Saturn DigiSizer for analysis. The ultrasonic probe can be activated to assist in redispersion if 
needed.

After redispersion, the sample is transferred to the reservoir of the analyzer. Then a small 
amount of analysis fluid is back-flushed to the MasterTech to rinse the stirrer, probe, and tub-
ing. After rinsing is complete, the MasterTech prepares itself for the next sample. The next 
sample can be redispersed while analysis of the current sample is in progress. Analysis pro-
ceeds as if you had filled the reservoir manually with predispersed sample. After analysis of 
the current sample is complete, the contents of the reservoir are discarded to the waste con-
tainer and the Saturn DigiSizer is rinsed. The system is now ready to transfer the next sample 
from the MasterTech.

Refer to Ordering Information, page 10-1 for details on placing an order for the MasterTech.
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Specifications

The Saturn DigiSizer Analysis System has been designed and tested to meet the specifications 
provided in Table 1-1. 

Table 1-1. Saturn DigiSizer Specifications

Characteristic Specification

———— SATURN DIGISIZER SYSTEM ——–—

Laser

Type: Solid-state, Diode

Wavelength: 658 nm

Power output: 6 to 9 mW

Beam type: Parallel

Beam width (in sample): 16 mm
Certified under IEC 825 as a Class 1 laser product

Lens Focal length, 200 mm (fixed)

Detector

Number of elements: 3,407,872

Geometry: Rectangular array with 3328 x 1024 pixels used at 14 
different angles to yield the equivalent of over 47 
million elements

Alignment: Automatic

Sample Circuit

Circulation pump rate: 5 to 19 L/min (Standard sample handler);
2 to 12 L/min (Low-volume sample handler)

Circulation system volume: 590 to 690 mL (Standard sample handler);
100 to 120 mL (Low-volume sample handler)

Materials routinely 
contacting sample:

Borosilicate glass; stainless steel; Tygon® (fuel grade) 
tubing; Titanium; Kel-F (CTFE); epoxy; Ertalyte®;  
Viton® F and Kalrez (Low-volume sample handler only)
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Characteristic Specification

Output

Measurement range: 0.04 to 2500 m Equivalent Spherical Diameter 
(Standard sample handler);
0.06 to 750 m (Low-volume sample handler)

Measurement time: Less than five minutes, sample to sample

Size class range: 40 per decade for four decades

Deconvolution Mie theory and Fraunhofer theory models applied.

Performance

Accuracy: 0.1 to 1 m, 10%
1 to 1000 m, 3%

Resolution: 0.1 to 1 m, not applicable
1 to 10 m, can resolve monosized particles 
    separated by 20% in size
10 to 1000 m, 30% in size

Repeatability: 0.1 to 1 m, 3%
1 to 1000 m, 1% (mean diameter for multiple analyses
    on the same instrument)

Reproducibility: 0.1 to 1 m, 5%
1 to 100 m, 2%
100 to 1000 m, 5% (particle size distribution, 
    instrument to instrument)

Electrical

Voltage
Saturn DigiSizer:
Sample Handler:

100/120, 220/240 VAC
85 to 264 VAC

Frequency: 47 to 63 Hz

Power
Saturn DigiSizer:
Sample Handler:

150 VA  
100 VA
520-42805-01 (Rev H) - Nov 2018                                             1-9 



Specifications Saturn DigiSizer II 5205
Characteristic Specification

Environment

Temperature: Ambient + 10 to 35 ºC, operating;
-10 to 55 ºC, storing or shipping

Humidity: Up to 90% (non-condensing)

Physical

Saturn DigiSizer: Height: 50 cm (19.7 in.)
Width: 47 cm (18.5 in.)
Depth: 65 cm (25.6 in.)
Weight: 45 kg (99 lbs)

Sample Handler: Height: 50 cm (19.7 in.)
Width: 27.5 cm (10.8 in.)
Depth: 65 cm (25.6 in.)
Weight: 26 kg (57 lbs)

———— COMPUTER ——–—

Minimum requirements: Computer capable of running Windows XP
      Professional or Windows Vista® Business or 
      Ultimate operating system
512 megabytes of main memory
20-gigabytes hard drive
CD-ROM drive
Ethernet port* (capable of communicating with a
      10 base-T or 100-TX card)
1024 x 768 monitor display capability

*An additional ethernet port is required if the
  computer is to be connected to a network.
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Characteristic Specification

———— MASTERTECH ——–—

Sample Capacity: 18 per tray, continuing indefinitely if tray is replenished

Sample Size: 0.001 to 4 g powder in 60 to 80 mL of liquid

Suspending Liquid: Any liquid compatible with wetted materials (typical 
liquids are water, glycols, mineral oils, alcohols, and 
mineral spirits)

Wetted materials: Stainless steel, Viton, Tygon, silicone rubber,  
polypropylene

Voltage: 100/120, 220/240 VAC  ± 10%

Power: 250 VA 

Frequency: 50/60 Hz

Temperature: 10 to 40 ºC, operating; -10 to 500 ºC, storing or shipping

Humidity: 20 to 80% relative (non-condensing)

Physical: Height: 71 cm (28 in.)
Width: 46 cm (18 in.)
Depth: 53 cm (21 in.)
Weight: 18 kg (40 lbs)
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Saturn DigiSizer II 5205 Controls, Indicators, and Connectors
2.  USER INTERFACE

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the 
front and rear panels of the Saturn DigiSizer, the liquid sample handler, and the MasterTech 
052.

Saturn DigiSizer

Front Panel

Power LED Illuminates when the analyzer has been turned on and the 
analysis program loaded. This LED will flash on and off until 
the program is completely loaded and ready for operation.

Retractable handle When pressed on the right side, the handle extends outward 
so that you can open the front panel.

Retractable Handle

Power LED
520-42805-01 (Rev H) - Nov 2018                                             2-1 



Controls, Indicators, and Connectors Saturn DigiSizer II 5205
Side Panel

The side panel of the analyzer contains two plumbing ports; an outlet (upper) and inlet (lower). 
These ports allow connection of the sample transfer tubing from the liquid sample handler to 
the sample cell holder.

Rear Panel 

Air filter Minimizes the buildup of dust within the analyzer.

Ethernet connector Allows communication between the computer and the 
DigiSizer analyzer.

Liquid Sample Handling 
Unit RS-232

Allows communication with the liquid sample handler.

ON/OFF switch Turns electrical power on and off to the analyzer. The up ( | ) 
position turns on the analyzer and the down (O) position 
turns off the analyzer.

Air Filter

RS-232 Connector for Liquid 
Sample Handling Unit

Linear Supply Breaker

Ethernet Connector

Power Connector

On/Off Switch

Voltage Selector Card
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Linear supply breaker This breaker serves to protect the linear supply that powers 
the detector. If the breaker trips after resetting, turn off the 
analyzer and contact your local Micromeritics service 
representative.

Power connector Supplies electrical power to the analyzer.

Voltage selector card Allows you to specify the proper operating voltage.
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Liquid Sample Handler

The Liquid Sample Handler is available in two configurations: the Standard unit and the Low-
volume unit. The Standard unit is shown for this illustration. The Low-volume unit is similar 
in appearance; the differences are:

• the size of the reservoir
• the inlet port for the rinse tubing is not used

Front Panel

Side Panel

The side panel of the liquid sample handler contains two plumbing ports; an outlet (lower) and 
inlet (upper). These ports allow connection of the sample transfer tubing from the liquid sam-
ple handler to the analyzer.

Reservoir The compartment into which the sample is placed for transfer 
to the DigiSizer analyzer for analysis.

Power indicator Illuminated when liquid sample handler is turned on.

Ports For tubing as indicated above.

Reservoir

Outlet Port for Overflow TubingOutlet Port for Drain Tubing

Power Indicator

Inlet Port for Analysis 
Liquid Tubing

Inlet Port for Rinse 
Liquid Tubing
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Rear Panel

On/Off switch Turns electrical power on and off to the liquid sample 
handler. The left ( | ) position turns on the unit and the right 
(O) position turns off the unit.

Power connector Supplies electrical power to the liquid sample handler.

Controller Allows communication between the ultrasonic probe and the 
liquid sample handler.

Probe Allows you to connect the ultrasonic probe.

RS232 from analyzer Allows communication between the liquid sample handler 
and the analyzer. 

RS232 spare Used for attaching a MasterTech.

Connector (controller) 
for Ultrasonic Probe

Power ConnectorOn/Off Switch

RS232 Spare

RS232 connector for 
Analyzer

Connector for 
Ultrasonic Probe
520-42805-01 (Rev H) - Nov 2018                                             2-5 



Controls, Indicators, and Connectors Saturn DigiSizer II 5205
MasterTech 052

Front Panel

ULTRASONIC PROBE 
AUTO/ON switch

LEDs on the switch indicate the mode of operation.

The AUTO position places the probe under automatic 
control.

The ON position turns on the probe. Remove the probe from 
its holder and place it in the liquid before turning on the 
probe.

Power Display

Intensity control

Pump Auto/Off Switch

Ultrasonic Probe Auto/On Switch Arm Auto/Load Switch

Transfer tube connector (one on each side)

Never turn the probe on unless the tip is submerged in liquid.

After using the probe, press the switch again to place the 
probe in automatic mode. Then replace it in its holder.

Power Display Displays the power being generated by the ultrasonic probe.

INTENSITY control Turn the control clockwise to increase the intensity of the 
probe, and counterclockwise to decrease the intensity.
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ARM AUTO/LOAD 
switch

The LEDs on the switch indicate the mode of operation.

Do not press the ARM AUTO/LOAD switch while an automatic operation is in
progress.

The AUTO position places the arm under automatic control.

The LOAD position raises the arm when you want to remove 
or load the tray.

This switch does not function unless the Saturn DigiSizer 
software is operating.

The MasterTech will not operate if the arm is in the Load 
position, so be sure to release the LOAD switch when you 
have finished removing or loading the beaker tray.

PUMP AUTO/OFF
switch

The LEDs on the switch indicate the mode of operation.

The AUTO position places the pump under automatic 
control.

The OFF position turns off power to the pump.

Transfer tubing connectors For attaching the sample transfer tubing. Attach the tubing to 
the side that coordinates with the one used on the MasterTech 
pump during installation of the MasterTech.
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Rear Panel

POWER ON/OFF 
switch

Turns the MasterTech on ( | ) and off (O). 

Power connector Supplies electrical power to the MasterTech.

Voltage selector card Allows you to specify the proper operating voltage.

+5 and +24 VDC 
indicators

Illuminate when appropriate power is present in the 
MasterTech.

RS232 port Allows connection of the communications cable.

DC Breakers Protects internal power supplies.

+5 and +24 VDC indicators

RS232 portPower On/Off switch

Voltage Selector card

Power Connector
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Turning On and Off the System

Turning On the System

Components of the DigiSizer system must be turned on in a certain order so that all installed 
components are detected. Turn on the components in the following order:

1. Computer
2. Ultrasonic probe (if installed)
3. MasterTech 052 Autosampler (if installed). Wait for initialization to complete (rotation 

of the turntable will stop) before turning on the liquid sample handler.
4. Liquid sample handler
5. DigiSizer analyzer

After all components have been turned on, start the analysis program.

Turning Off the System

Turn off the system as follows:

1. Select Close from the System menu or Exit from the File menu.

• If an analysis is in progress, the following message is displayed:

If you click Yes, the analysis program closes. However, analysis and data collection 
continue and queued reports will print. If a power failure occurs and an uninterruptible 
power supply (UPS) is not attached to the analyzer, the data collected after exiting the 
analysis program are lost.

• If data calculations are in progress, the following message is displayed:

You cannot exit the analysis program until calculations are complete.

2459- An analyzer is busy. A delay in restarting this application could 
result in loss of new data. Continue with program exit?

Yes                               No

2458- An analyzer is performing a critical operation. Wait a few moments 
before exiting the application.

OK
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2. Turn off components as follows:

• DigiSizer 
• Liquid sample handler
• MasterTech 052
• Ultrasonic probe
• Computer

Preparing the System for Idle Periods

When the DigiSizer is not being used for analyses, it should be left with liquid in the reservoir 
so that the plumbing system remains primed. Perform the following steps to prepare the Digi-
Sizer for idle periods of up to 7 days:

1. Fill the reservoir to the primed level with clean analysis (or rinse) liquid.

2. Select Unit [n] > Enable manual control (select Unit [n] > Show instrument schematic 
if the schematic is not displayed).

3. Select the circulating pump; right-click and choose Set speed.

4. Enter 600; click OK.

5. Exit the analysis program; DO NOT turn off the analyzer or liquid sample handler.

If the DigiSizer is to remain idle for a period of more than 7 days.

1. Select  Unit [n] > Drain to drain all liquid from the system. This also moves the rotation 
arm out of the way so that the sample cell is easily accessed.

2. Remove the sample cell (refer to Cleaning the Optics, page 9-4 for removal instructions).

3. Using a lens paper, dry the sample cell completely and place it inside its container. If the 
container is unavailable, wrap the cell with a lens paper and store it in a secure location. 

4. Exit the analysis program and turn off all components as outlined in Turning Off the 
System, page 2-9.

5. Be sure to clean the sample cell before reinstalling. When turning components back on, 
refer to Turning On the System, page 2-9 for the proper order.
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Using the Software

The DigiSizer analysis program requires familiarity with standard Windows operations such 
as using the mouse, menus, and dialog boxes. While this manual provides brief instructions for 
such standard operations, you may have to refer to your Windows documentation or to its 
online help system to clarify functions which are specific to Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for certain components on the instrument schematic when in manual mode, and for 
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which 
you wish to display its menu and clicking the right mouse button. For example, right-click in a 
column of an onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combina-
tions (if assigned) are listed to the right of the menu item. Instead of opening the menu and 
choosing the command, simply press the key combination. For example, to open a sample 
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined 
letter by pressing Alt plus the underlined letter in the command. For example, to access the 
File menu, press Alt, then F.

Table 2-1 provides a list of the Shortcut keys available for the Saturn DigiSizer program. 
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Table 2-1. Shortcut Keys

Select... To...

F1 Access electronic copy of operator’s manual in PDF format

F2 Open a sample information file (main menu bar)

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file (main menu bar)

Insert the current date (Select Dates dialog)

F4 Open a material properties file (main menu bar) 

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start a report

F9 Close all open report windows

Alt + F4 Exit the analysis program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List material properties files

Shift + F5 List report options files

Shift + F9 Access shortcut menu of (1) onscreen reports, or (2) selected component 
on instrument schematic when manual control is enabled
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when an item followed by an ellipsis (...) is selected. Subdialog 
boxes are displayed when certain push buttons are selected. Both types of boxes may contain 
one or more of the items listed below.

Data entry field A data entry field is used to enter text; either numeric 
(numbers only) or alphanumeric (numbers, letters, or 
printable characters). 

Information Bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of the 
dialog. For example, a range is shown for fields in which 
numeric entries are required.

Push Button A push button is used to display a subdialog box in which to 
enter additional information about the subject matter, or to 
cause an action.

Radio Button Radio buttons are contained within a group box and are used 
to make choices. Only one radio button can be selected.

Radio Button
Filled circle indi-
cates choice.

Push button
Displays a 
subdialog box.

Check box
Selected items contain a check mark.

Data Entry fields

Push button
Causes an action.

Information Bar
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The following push buttons are common to the DigiSizer analysis program and appear on 
many of the dialogs:

Check Boxes Check boxes are used to select options. You can select as 
many options as desired. 

Drop-down List A drop-down list contains a list of options and is indicated by 
a down arrow to the right of the field. If there are more items 
than can fit in the box, a scroll bar is provided for navigating 
through the list.

List box A list box also displays options, but allows you to select as 
many as you wish. To select an item in a list box: move the 
mouse pointer to the desired selection and double-click. 
Alternatively, you may highlight the desired item and press 
the Spacebar. An item is selected when it is preceded with a 
check mark (). 

Browse Displays a dialog allowing you to select a file for the subject 
matter.

Cancel Closes the open dialog, discarding any information you may 
have entered and/or cancels the current operation.

Next Advances you to the next screen. This push button is disabled 
if this is the last screen of a series.

OK Closes the open dialog, saving any entries you may have 
made.

Prev Returns to the previous screen. This push button is disabled if 
this is the first screen of a series.

Indicates an item
is selected.
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialogs contain a 
Files window which displays a list of files available for that particular operation. For example, 
the Open Sample Information dialog:

A default string appears in the File name field. To select a file, simply move the mouse 
pointer to the desired file in the list and double-click.

You may limit the list of files displayed in the Files list by choosing one of the following:

• Use wildcard characters in the path name you enter in the File name field. Wildcard 
characters such as * and ? can be used to filter file names. For example, you can limit 
the list of files displayed to those beginning with garnet by entering garnet*.smp.

Replace Allows you to copy file values from an existing file into the 
current one. This allows you to edit the values in the new file 
without changing the ones in the original file.

Resume Resumes a suspended operation.

Suspend Suspends the current operation. The push button changes to 
Resume.
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• Enter a range of dates. Select Date Range; the Select Dates dialog is displayed.

Select Show Date Range to enable the From and To fields and enter a beginning and 
ending date. Or, you can double-click in each field to display a calendar to select a 
date. The range of dates remains the default until you change the dates or select Show 
All Dates.

For convenience, the following shortcut keys are available when the Select Dates dia-
log is displayed:

• Select a file status from the Status drop-down list. Table 2-2 describes each file status.

Table 2-2. File Status and Description

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which to select a date

Use the Regional Settings function on the Windows Control Panel to change the date 
format.

Status Description

All All sample information files in the specified directory and within 
the specified range of dates.

Analyzing Sample information files that are currently being used in an 
analysis.

Complete Sample information files that have had at least one test performed. 
Eight tests can be performed with each file.

Entered Sample information files that contain manually entered data.

No Analysis Sample information files that have not been used in an analysis.
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• Use the Directories window to navigate to a different directory. The current directory 
is displayed just above the Directories list window.  To change directories: 1) double-
click a directory in the Directories list window, 2) double-click [...] to move up one 
level, or 3) enter the desired directory in the File Name field. For example, enter 
C:\5205file\sample\*.smp to display sample files in the 5205file\sample directory on 
your local drive.

Selecting Reports

Reports are selected from the Report Options dialog, or any dialog containing a Reports to 
Generate list. Simply select (highlight) the report and then double-click, or press the 
Spacebar. A report is selected when it is preceded with a check mark (). Reports are dese-
lected in the same manner. 

Double-click to move 
up one level.

Double-click to open 
the listed directory.

Displays the current 
directory.

Indicates a report
is selected.
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File Name Conventions

For sample information files, a default file name (the next available sequence number) and a 
default extension display. For Analysis Conditions, Report Options, and Material Properties 
files, only a default extension displays.

The following table shows the file name extensions for the Saturn DigiSizer analysis program.

Table 2-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Analysis Conditions ANC

Material Properties MTP

Report Options RPO

Export to disk (ASCII) EXP

Report (saved from the Report window) REP

List to disk LST
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Menu Structure

Main Menu Bar

All functions for the Saturn DigiSizer are accessed from the main menu bar. Brief descriptions 
are provided below; refer to the chapter given in parentheses for a detailed description of the 
commands contained on that menu.

File Allows you to manage sample and parameter files. 
(Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument 
operations. (Chapter 6, UNIT MENU) 

Reports Enables you to generate, open, and close reports. (Chapter 7, 
REPORTS MENU)

Options Allows you to edit sample defaults, select data presentation 
formats, and manage models. (Chapter 8, OPTIONS 
MENU)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open windows.
(this chapter, page 2-20)

Help Provides access to an electronic copy of the operator’s 
manual. (this chapter, page 2-20)
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Windows Menu

The Windows menu also displays all open files; the active window is preceded with a check 
mark ().

Help Menu

Tile Resizes all open windows and arranges them side by side so 
that the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the stack. 
Each window’s title remains visible, making it easy to select 
other windows.

Arrange icons Arranges all minimized icons in an orderly manner.

Operator’s Manual Provides an electronic copy of the DigiSizer operator’s 
manual in Adobe® PDF format.

About  DigiSizer Displays information about the Saturn DigiSizer analysis 
program.
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Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual 
by selecting Help, then Operator’s Manual from the analysis program main menu. The man-
ual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual. 
Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for 
more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

You can use the  +  and    buttons next to topics as they are used in Windows Explorer to 
expand or collapse the topic list.

Navigation Pane Topic Pane

Bookmarks

Topics
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To display a topic, click the topic name in the Bookmarks section. The related information 
appears in the topic pane of the window as shown in the following example.

 

 

Click bookmark
to display topic.
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Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are 
contained in:

• the table of contents
• index entries
• cross-references within the manual 

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the 
table of contents is displayed, you can click an entry to display its associated page. For exam-
ple, clicking Using the Software in the table of contents, displays the page containing 
information about the software.

 

Click topic name in 
table of contents to 
display topic.
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Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the 
last topic in Bookmarks), then click the + button to expand the index. The letters A through Z 
are displayed. Click a letter to display its corresponding index entries as shown in the follow-
ing example.

After you display the entries, locate the item of interest and click on the page reference to 
access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-refer-
ence, FILE MENU (shown on the screen in blue type) will display the first page of the 
chapter describing the commands found on the File menu.

FILE MENU

Provides a description of the commands available on the File menu.

Click a letter to display 
its index entries.
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Using the Find Command

The Adobe Acrobat Find command provides another method of easily accessing specific 
information. For example, suppose you want to know how the Save as command works. You 
could select Edit > Find from the Adobe Acrobat menu, then enter Save as in the Find dialog. 
The following example shows the results.
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Printing

You can print the entire manual, a selected page, or range of pages. There are several options 
for printing. You can:

• Select the printer icon ( ) on the Adobe Acrobat toolbar.
A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using 
this option (or the next one), be sure to enter the page number(s) displayed in Adobe 
Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

• Select File > Print. 
A standard Print dialog is displayed. Select the page(s) to print, then click OK.

• Click the Thumbnails tab.
Thumbnails of manual pages are displayed.

a. Click the pages you want to print.

b. Right-click to display a shortcut menu, then select Print Pages.

c. A standard Print dialog is displayed; click OK.

Enter 
this 
number.

Do not use 
number in 
footer of the 
manual.

Thumbnails 
tab
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3.  OPERATIONAL PROCEDURES

This chapter describes brief, step-by-step instructions on how to:

• Specify sample defaults, page 3-1
• Rinse the system, page 3-5
• Measure a background, page 3-8
• Change analysis liquids, page 3-10
• Create sample files, page 3-12
• Create parameter files, page 3-15
• Prepare a sample for analysis, page 3-21
• Perform an analysis, page 3-22
• List file statistics, page 3-30
• Export sample data, page 3-31
• Generate reports, page 3-32
• Overlay data, page 3-41

This chapter does not contain detailed descriptions of the dialogs used to perform these proce-
dures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index or the online 
manual to assist you in locating the appropriate dialog. 

Specifying Sample Defaults

You can specify sample defaults in the Advanced or Basic format. The defaults you specify 
are the ones you see when you create a new sample file in the respective format. Therefore it is 
best to specify (or enter) parameters that you plan to use most frequently. For example; specify 
defaults for your most commonly analyzed sample material. You can always edit parameters 
in the sample file when it is created.

Basic Format

Refer to Basic, page 8-9. for a detailed description of the fields on this dialog.

Perform the following steps to define defaults for a Basic sample information file.

1. Select Options > Option Presentation > Basic.

2. Select Options > Sample Defaults; the Default Basic Sample Information dialog is 
displayed.
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3. In the Sequence Number field, specify a default string for the sample file number, you 
can use up to eight characters. This is the number that appears in the File name field 
when you select File > Open > Sample information.

4. In the right field of the Sample line, enter a format for the sample’s identification. Be 
sure to include the $ symbol if you wish to have the sample file number included as part 
of the identification.

5. From the Analysis Conditions drop-down list, choose the analysis conditions file you 
wish to use as the default; selections chosen in the file display for the Autodilute, 
Number of tests, and Rinse options. 

6. In the Material Properties group box, choose the sample and dispersing liquid you wish 
to use as the defaults.

7. From the Report Options drop-down list, choose the report options file you wish to 
display as the default; reports selected in the file show in the Reports to Generate 
window.

8. Click Save, then Close.

You can also edit the word Sample. For example, you may prefer to use Test.
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Advanced Format

Defining sample defaults in this format allows you to customize sample files. The values you 
specify in the parameter portions of the sample file (Analysis Conditions, Material Properties, 
and Report Options) also are saved as the defaults for newly created parameter files.

For example, after specifying defaults: 

• Select File > Open > Sample Information; name and create the file; and all defaults 
you specified display for all parameters.

• Select File > Open > Analysis Conditions; Yes to create the file; and the defaults you 
specified in the Analysis Conditions portion of the Advanced Sample Defaults dialog 
display in the fields.

Refer to Advanced, page 8-6. for a detailed description of the fields on this dialog.

1. Select Options > Option presentation > Advanced.

2. Select Options > Sample Defaults; the DigiSizer Sample Defaults dialog is displayed.

3. In the Sequence Number field, specify a default string for the sample file number; you 
can use up to eight characters. This is the number that appears in the File name field 
when you select File > Open > Sample information.
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4. In the right field of the Sample line, enter a format for the sample’s identification. Be 
sure to include the $ symbol if you wish to have the sample file number included as part 
of the identification.

5. Edit the Operator and Submitter lines as desired. Or have them omitted entirely by 
selecting Omit.

6. Specify user parameters (if desired). These fields provide additional sample 
characterization available for SPC (statistical process control) reports. For example, you 
may wish to specify sample weight or temperature. If you specify a parameter, enter a 
default for that parameter in the field on the right. Or, if SPC reporting is not desired, you 
may have them omitted by selecting Omit.

7. Select the Analysis Conditions tab.

a. Choose analysis conditions appropriate for your most commonly analyzed sample. 

b. Click Save.

8. Select the Material Properties tab.

a. Choose the sample material you most commonly analyze, a suitable dispersing liquid, 
and appropriate values.

b. Click Save.

9. Select the Report Options tab.

a. Choose desired report options.

b. Click Save, then Close.

You can also edit the word Sample. For example, you may prefer to use Test.
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Performing a Rinse Operation

A rinse operation should be performed to rinse the analysis cell of any debris or contaminants 
from previous analyses. Since contaminants from previous analyses can affect results of sub-
sequent analyses, it is best to perform a rinse operation after each analysis. 

Refer to Rinse, page 6-26 for a detailed description of the fields on this dialog.

When you select Unit [n] > Rinse, three choices are presented: 

• DigiSizer - rinses the cell, the reservoir, and the tubing of the liquid sample handler 
and DigiSizer

• MasterTech - rinses the MasterTech tubing into a specified beaker 

• MasterTech then DigiSizer - rinses the MasterTech first, then the liquid sample 
handler and DigiSizer as described above

DigiSizer

Perform the following steps to rinse the analysis cell, the reservoir, and the tubing of the 
DigiSizer.

1. Select Unit [n] > Rinse > DigiSizer; the DigiSizer Rinse dialog is displayed.

2. Choose AutoRinse to have the analyzer automatically determine how many rinse cycles 
to perform based on beam obscuration, or Rinses to specify an exact number of rinses.

3. Click Start; progress messages are displayed until rinsing is complete, then the dialog 
closes automatically.
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MasterTech

This option is enabled only if a MasterTech is connected to the analyzer. 

Perform the following steps to rinse the MasterTech tubing:

1. Select Unit [n] > Rinse > MasterTech; the MasterTech Rinse dialog is displayed.

2. Enter the position number of the beaker that is to catch the rinse liquid. Be sure the beaker 
contains a small amount (approximately 10 mL) of liquid; otherwise, its presence may 
not be detected by the MasterTech.

3. Click Start; progress messages are displayed until rinsing is complete, then the dialog  
closes automatically.
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MasterTech then DigiSizer

This option is enabled only if a MasterTech is connected to the DigiSizer. 

Perform the following steps to rinse the analysis cell, the reservoir, and the tubing of the Digi-
Sizer and the MasterTech.

1. Select Unit [n] > Rinse > MasterTech then DigiSizer; the MasterTech then DigiSizer 
Rinse dialog is displayed.

2. In the MasterTech group box, enter the position number of the beaker that is to catch the 
rinse liquid. Be sure the beaker contains a small amount (approximately 10 mL) of liquid; 
otherwise, its presence may not be detected by the MasterTech. 

3. In the DigiSizer group box, choose Autorinse to have the analyzer automatically 
determine how many rinse cycles to perform based on beam obscuration, or Rinses to 
specify an exact number of rinses.

4. Click Start; progress messages are displayed until rinsing is complete, then the dialog 
closes automatically.
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Performing a Background Measurement

A background measurement is required for data collection. It is not necessary to measure a 
background for each analysis. It is recommended that you perform a background measurement 
once per shift and when you change analysis liquids. You can measure up to eight back-
grounds, but only the last one can be saved and used. Refer to Appendix H, page H-1 for a 
discussion and examples of acceptable and unacceptable backgrounds.

Perform the following steps to measure a background.

1. Select Unit [n] > Background; the Background Measurement dialog is displayed. 

2. Select the liquid you are using to measure the background (if different from the current 
one).

3. Click Next; another view of the Background Measurement dialog is displayed.

This group box displays 
statistics for the current 
background.

If using a different liquid, be sure that you have inserted the analysis liquid inlet tube 
(extending from the front panel of the liquid sample handler) into the new liquid.
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4. Ensure that the Flow rate option is selected; enter 6.

5. Select Report After Measurement to have a background report generated automatically 
after the background is measured. Then select the drop-down list to choose a destination.

This background can be overlaid with backgrounds from other analyses for comparison if 
desired.

6. Click Next; a progress screen of the background being measured is displayed. The 
measurement is displayed in the final view of the Background Measurement window 
when it is finished. The current background is also displayed for comparison.

7. Click Done to accept the measured background and close the window. 

The progress view of the background window provides a suspend and skip option if 
either action is desired.

If this background measurement is unsatisfactory, you can perform another one by 
selecting Repeat. If you choose to measure another background, the current one 
becomes inaccessible. You must use the last background measured. Refer to 
Appendix I, page H-1 for guidelines on determining acceptable backgrounds.
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Changing Analysis Liquids

When changing analysis liquids, it is very important to remove all traces of the old liquid from 
the system and any air bubbles remaining in the liquid inlet pump. 

If the new liquid is immiscible with the old liquid, this procedure must be performed twice:

• the first time to change to a transition liquid which is miscible with the old and new 
liquid. Isopropanol (IPA) is often used as a transition liquid because it is miscible with 
water and many hydrocarbon-based liquids.

• and the second time to change from the transition liquid to the new liquid.

If a MasterTech is attached, its tubing must be drained and rinsed along with the rest of the 
system. Note that if a MasterTech is attached, it must always contain the same type of liquid 
used in the rest of the system, even if it is not used in analyses. This is necessary in order to 
prevent contamination or air bubbles.

1. Remove the analysis liquid inlet tube from the liquid supply. Drain the inlet tube, then 
wipe clean the outer surface; place it on a paper towel to absorb any further residue.

• If your DigiSizer is equipped with the standard liquid sample handler, repeat this step 
for the rinse inlet tube. 

2. Select Unit > Drain to drain the system of liquid.

3. Select Unit > Enable Manual Control to enable manual control.

4. Click the analysis pump icon. Turn on the pump and allow the pump to operate for 
approximately 10 seconds, then turn it off.

5. Select Unit > Drain to drain any liquid remaining in the system.

• If your DigiSizer is equipped with the standard liquid sample handler, repeat steps 4 
and 5 for the rinse pump. 

6. If a MasterTech is attached:

a. Place an empty beaker in position 1 of the MasterTech tray. 

b. Select Unit > Load from MasterTech; ensure that beaker 1 is designated and that the 
stirrer and probe times are specified as 0.

A quick-and-easy method for turning pumps on and off is simply to press the 
spacebar after selecting the appropriate pump.

If you receive an error message indicating that the beaker is not present, press down 
on the beaker to enable the sensing mechanism. then repeat the Load operation (step 
6-b).
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c. Select Unit > Drain to drain the system again. 

7. Wipe any additional residue from the analysis liquid inlet tube and place it into the new 
liquid supply. If the new liquid requires a new Waste container, replace the container.

8. Turn on the analysis pump; allow the inlet tube to fill until the liquid level  reaches the 
fitting on the front panel of the liquid sample handler, then turn off the pump.

9. Repeatedly turn on and off the analysis pump at one-second intervals until the Full liquid 
level sensor is on (sensor turns blue).

10. Select Unit > Drain to drain the system again. 

11. For the standard sample handler, repeat steps 6 through 10 for the rinse inlet.

12. Select Unit > Rinse > DigiSizer; for the:

• Standard sample handler: perform three separate rinse operations of one rinse cycle 
each (this flushes both the analysis inlet and rinse inlet three times).

• Low-volume sample handler: perform one rinse operation with 3 rinse cycles.

13. If a MasterTech is attached:

a. Place an empty beaker in position 1 of the MasterTech tray.

b. Select Unit > Rinse > MasterTech.

c. Empty the beaker, replace it onto the MasterTech tray, and repeat the rinse cycle.

d. Select Unit > Rinse > DigiSizer; rinse the DigiSizer with one rinse cycle.

14. Select Unit > Background, select the new liquid, then complete the measurement. 

15. Select Unit > Rinse > DigiSizer; perform one rinse cycle.

16. Perform another Background analysis. 

17. Examine the overlay of the current and previous background intensities. With the graph 
window maximized, most of the intensity data for the two curves should coincide so that 
only one color is showing. It is acceptable to have small differences (two colors showing 
with little or no white space between them) in small regions, and particularly in the data 
at greater than 10 degrees scattering angle. If the difference in the two background 
intensity curves is greater than 10 degrees, repeat steps 15 and 16 until a stable 
background intensity is achieved.

If the background intensity is unusually high, remove and clean the cell (refer to 
Cleaning the Optics, page 9-4); then repeat this step. Appendix H, page H-1 provides 
guidelines for determining a good background.
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Creating a Sample Information File

Every analysis requires a sample information file. The file consists of information groups 
which, collectively, identify the sample (sample information), guide the analysis (analysis con-
ditions, material properties), and specify the data reduction (report options). 

A sample file may be created in three different formats:

• Advanced. This format provides complete access to all parts of the sample file, 
allowing you to quickly edit parameters as required.

• Basic. This format presents a single window in which you select predefined parameter 
files for your analysis.

• Restricted. This format is identical to the Basic format, except that certain menu 
options become disabled. In the Restricted mode, you cannot  define defaults for SPC 
reports or sample files, nor can you switch to the Advanced format. This mode is also 
password-protected.

Select Options > Option presentation to choose the format you wish to use.

Basic and Restricted Formats

The Basic and Restricted formats are the easiest and most popular methods for creating a sam-
ple file because you create your file using predefined parameter files. If more detailed 
conditions or custom files are required, you must use the Advanced format (discussed later). 
Even if you begin your sample file in the basic format, you can switch to the Advanced format 
by clicking Advanced.

The instructions for creating sample files in the Restricted format are the same as for the Basic 
format with the following exceptions:

• You must enter a password to access this format 
(refer to Restricted, page 8-4)

• Certain menu options become disabled 

• You cannot switch to the Advanced format 

Refer to Basic, page 5-5 for a detailed description of the fields on this dialog.

Perform the following steps to create a sample information file using the Basic format.

1. Select File > Open > Sample information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name (up to eight characters) in the 
File name field.
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3. Click OK, then Yes to create the file; the Basic Sample Information dialog is displayed. 

4. Select the down arrow at the Analysis Conditions field and choose an Analysis 
Conditions file from the drop-down list; selections specified in the file display for the 
Autodilute, Number of tests, and Rinse options. You can edit these selections if desired; 
it will not change the parameter file.

5. Choose the sample material and the analysis liquid from their respective drop-down lists.

6. Select the down arrow at the Report Options field and choose a Report Options file from 
the drop-down list; reports selected in the file show in the Reports to Generate window. 
You can edit these selections if desired.

7. Click Save, then Close.

Use this push button to copy 
parameters from an existing 
file into the current one.

Not displayed when using the 
Restricted format.

Click Replace All to copy parameters from an existing file into this one. After copying 
the parameters, you may edit them as desired. 
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Advanced Format

The Advanced format presents all parts of the sample file in an index-card  manner. This 
allows you to create a customized sample file. 

Refer to Advanced, page 5-8 for a detailed description of the fields on this dialog.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Advanced Sample Information dialog is 
displayed.

4. Enter the names of the operator and submitter.

5. Choose whether you wish to have data collected automatically or whether you plan to 
enter the data.

6. Unless you are gathering statistical process control information, it is unnecessary to enter 
parameter values. These are user-definable parameters that can be entered and tracked 
along with other statistical process control data.

The steps for completing the remaining parameters of the sample information file are 
explained in subsequent sections. Simply click on the next tab to open its associated dialog. 

These fields are used for SPC 
reporting only. The labels 
(parameters on which to report) 
can be specified by selecting 
Options > Sample Defaults.
3-14                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Creating Parameter Files
Creating Parameter Files

Parameter files can exist as part of the sample information file or as a standalone file:

• Analysis conditions, starting on this page 
• Material properties, page 3-18
• Report options, page 3-20

Having these files exist independently allows you to use them over and over again.

Several predefined parameter files are included with the Saturn DigiSizer program. Although 
these files may come close to the needs of your laboratory, you may wish to define additional 
ones. Or you can use a predefined file as a starting point. This is easily accomplished by creat-
ing a new file and then selecting Replace. A dialog is displayed so that you can select the 
existing file containing the values you wish to use. After the values are copied into the current 
file, you can edit the values as desired; the original file remains intact and ready for the next 
use. 

If you wish to have parameter files display in the drop-down list on the Basic Sample Informa-
tion dialog, be sure to save them to the directory specified as the Parameter Files Directory 
(see Parameter Files Directory, page 8-12). Unless you have edited the parameter files direc-
tory, the files are saved to the default params directory automatically.

Analysis Conditions

Analysis conditions specify the data used to guide an analysis. An analysis conditions file may 
be assigned a unique name, and you can direct any sample to be analyzed according to the con-
ditions in any existing analysis conditions file.

Refer to Analysis Conditions, page 5-11 for a detailed description of the fields on this dialog.

Perform the following steps to define an analysis conditions file.

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK. 

3. Click Yes to create the file; the Analysis Conditions dialog is displayed.
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4. Enter a description in the Analysis Conditions field. 

5. Specify flow rate requirements. You can have the flow rate calculated automatically by 
the DigiSizer or you can enter a value. 

6. In the Redispersion group box:

a. Select Ultrasonic probe if you are using an ultrasonic probe, then enter the percent of 
intensity for operation and how long you wish to have the sample agitated before 
analysis. You can also choose to have the probe remain on during analysis.

b. Select Circulate before data collection if you wish to have the analysis liquid 
circulated through the system after adding the sample, then enter how long circulation 
is to occur.

c. Select Redisperse before each test to have the sample redispersed just before each 
analysis.

7. In the Obscuration group box:

a. Specify a range for beam obscuration, or accept the defaults.

b. Select Autodilute to have the Saturn DigiSizer automatically maintain dilution of the 
sample concentration.

Use an intuitive description, one that will help you identify the type of sample you plan 
to analyze using these analysis conditions. You may want to use a description that 
contains the type of sample material and dispersing liquid. For example, Garnet/Water.
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8. In the Data Collection group box:

a. Enter the beam angle at which to stop data collection. This field defaults at 45, and is 
generally appropriate for most samples. The beam angle can be decreased if the 
sample does not contain small particles, or increased if the sample contains a 
significant quantity of particles smaller than 0.3 micrometers.

b. Enter the number of tests to be used with this file. Eight tests can be performed using 
the same file.

9. Select Rinse after analysis to rinse the system after all specified tests are complete. Then 
choose Autorinse (the system determines the rinses) or enter a specified number of 
rinses.

10. If you are using the MasterTech, click MasterTech Treatment and specify the stirring 
time, stirring speed, and probe time.

11. Click Save, then Close.
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Material Properties

Material properties specify data for the sample material and its dispersant. 

Refer to Material Properties, page 5-15 for a detailed description of the fields on this dialog.

1. Select File > Open > Material Properties; the Open Material Properties dialog is 
displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK. 

3. Click Yes to create the file; the Material Properties dialog is displayed.

4. Enter a description in the Material Properties field.

5. Choose the sample material from the Sample Material list box. If your material is not 
listed, add it to the list:

a. Enter the sample material in the Description field.

b. Enter the real and imaginary portions of the material’s refractive index.

c. Enter the material’s density.

d. Click Add.

Use an intuitive description, one that will help you identify the type of sample you plan 
to analyze using these analysis conditions. You may want to use a description that 
contains the type of sample material and dispersing liquid. For example, Garnet/Water.
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6. Choose a dispersing liquid from the Analysis Liquid list. If your dispersing liquid is not 
listed, add it to the list:

a. Enter the dispersing liquid in the Description field.

b. Enter the refractive index for the liquid.

c. Enter the viscosity and density for the liquid.

d. Click Add.

7. The refractive indices for the sample material (in parentheses) and the dispersing liquid 
are displayed on the top line of the Scattering Model group box. The model chosen by 
the system is displayed on the second line. Click Options to choose a different model or 
to generate a model for the exact refractive indices selected.

8. Click Save, then Close.

Refer to Appendix D, page D-1 for a list of common dispersing liquids and their 
density and viscosity values.
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Report Options

Report options files specify the types of reports which can be generated from an analysis or 
from manually entered data. They also contain details of the reports such as axis scale, axis 
range, and column headings. You can specify for reports to be generated automatically after 
each analysis, or you can generate reports at any time during or after an analysis.  A report 
generated during an analysis only includes data collected up to the time of the report. 

Report options files also may be defined to include three different types of overlays (refer to 
Generating Overlays, page 3-41). 

Refer to Report Options, page 5-19 for a detailed description of the fields on this dialog.

1. Select File > Open > Report Options; the Open Report Options dialog is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK. 

3. Click Yes to create the file; the Report Options dialog is displayed.

4. Enter a description in the Report options field. Enter an identifier which gives a more 
intuitive description of the file’s contents. For example, Tabular Report using Volume 
Distribution.

5. Select Show report title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you do not wish to have a report title.

If your company logo exists as a bitmap (bmp) or an enhanced metafile (emf) file and 
you wish to have it display in the report header, select Show graphic. Then click 
Browse to select the file.
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6. If you wish to compare analysis results for the current sample to those obtained for a 
reference sample, click Reference and choose a file. Results are reflected in the 
Difference from Reference report.

7. If you wish to determine if the results for the current sample are within coarse and fine 
specifications, click Specification and choose a sample file for each boundary. Results 
are reflected in the Out of Specification report.

8. If you wish to overlay graphs, click Overlays and choose the sample file(s) you wish to 
overlay with a graph of the current sample. Then be sure you edit the graph and choose 
Samples in the Overlay field.

9. Click Peaks to choose how peaks are detected.

10. From the Test drop-down list, choose the analysis for which you wish to have a report 
generated. 

• If you select Average, an average for all tests will be generated.
• If you select All, a separate report is generated for each test.

11. From the Reports to Generate list box, choose the reports you wish to have generated. A 
report is selected when it is preceded with a check mark. To select (or deselect) a report: 
highlight the report, then double-click or press Spacebar. 

12. Click Edit for selected reports to specify details; for example, x- and y-axis variables.

13. Click Save, then Close.

Preparing a Sample For Analysis

A sample must be dispersed properly before it can be analyzed. Refer to Appendix B, page 
B-1 for a discussion on sample dispersion and concentration. After the dispersed sample has 
been loaded into the reservoir, particle dispersion can be maintained using an ultrasonic probe 
(optional). 
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Performing an Analysis

There are four different ways in which an analysis (or analyses) may be performed:

• Sample Analysis: Used to perform up to eight analyses on a single sample.

• QuickStart Analysis: Used to perform a series of samples of the same type with the 
same analysis conditions; sample files are generated automatically.

• MasterTech Automatic: Used to analyze a series of samples of the same type with 
the same analysis conditions. Sample files are created automatically; samples are 
transferred from the MasterTech automatically. 

• MasterTech Schedule: Used to analyze a series of samples which are different and, 
consequently, require different analysis conditions. Samples files are user-specified; 
samples are transferred from the MasterTech automatically. 

Choose the method you wish to use and proceed accordingly.

Sample Analysis

Refer to Sample Analysis, page 6-4 for a detailed description of the fields on this dialog.

Perform the following steps to perform up to eight analyses on one sample.

1. Select Unit [n] > Sample Analysis; the Sample Analysis dialog  is displayed with all 
fields grayed. 

2. Click Browse and choose a file for your analysis; the Sample Analysis dialog containing 
the parameters of the selected file is displayed.
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3. Verify analysis conditions and report options; edit if needed.

4. Ensure that the sample material and analysis liquid are correct; if not, use the drop-down 
list(s) to select the correct one(s).

5. Click Next; the beam obscuration view of the Sample Analysis dialog is displayed.

6. While observing the beam concentration, slowly begin to add sample. Add enough 
sample to achieve the proper range for your material, using the following guidelines:

• If the beam obscuration is too high and you have chosen Autodilute, the concentration 
will be adjusted automatically until the correct beam obscuration is achieved. 

• If the beam obscuration is too low, continue to add sample.

7. Click Next when the proper obscuration is achieved to begin data collection.

If your DigiSizer is equipped with the low-volume sample handler, be sure the sample 
is deposited into the liquid and does not adhere to the sides of the reservoir.

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%
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QuickStart

Refer to QuickStart, page 6-10 for a detailed description of the fields on this dialog.

Perform the following steps if you wish to perform analyses on multiple samples using the 
same analysis conditions.  

1. Select Unit [n] > QuickStart; the QuickStart dialog is displayed.

2. Choose whether you wish to have the liquid level adjusted after each analysis before 
loading the next sample; if so, in which state.

• Full: when a maximum quantity of liquid is desired, a flow rate higher than 12 L/min is 
used, or if you anticipate problems with bubbles.

• Primed: for normal operation and when a limited amount of sample is available, the 
reservoir will be filled with just enough liquid for circulation to occur.

• Empty: for previously dispersed samples already at the proper concentration.

If you deselect this option, the system will leave the liquid level unchanged.

3. Select report output:

a. Enter the number of reports you wish to have generated (enabled when Printer is the 
destination).

b. Select a destination. If you choose File, enter a name in the File name field.
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4. If you wish to have an identification string for this series of samples different from the 
one specified in sample defaults, enter a new one in the Sample field. Be sure to include 
the $ symbol if you want the sample file number included as part of the identification.

5. In the File Management group box:

• Choose Prompt for files for each new sample; a dialog allowing you to select a file 
for every new sample is displayed. Analysis proceeds when you add the sample and 
click Next.

• Choose Autodetect each new sample; a file is created by the system using the file 
name sequence specified in Sample Defaults. The file will also use the same 
description unless you specified a different one in the previous step. Analysis proceeds 
each time a new sample is added to the reservoir, creating a sample file automatically.

6. After all analyses are performed click Cancel to exit QuickStart mode.
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MasterTech Automatic

This option is functional only if you have a MasterTech connected to your analyzer. 

Refer to MasterTech Automatic, page 6-15 for a detailed description of the fields on this 
dialog.

Perform the following steps to analyze a series of samples of the same type using the same 
analysis conditions; sample files are created automatically. 

1. Select Unit [n] > MasterTech Automatic; the MasterTech Automatic dialog is 
displayed.

2. In the Start with beaker field, enter the position number of the beaker containing the 
first sample to be analyzed.

3. Enter the stirrer time, stirrer speed, and probe time for sample resuspension.

4. Select report output:

a. Enter the number of reports you wish to have generated (enabled when Printer is the 
destination).

b. Select a destination. If you choose File, enter a name in the File name field (or accept 
the default).

Samples tend to settle in the beaker while waiting for analysis, especially if several 
samples are prepared ahead of time. this option allows you to redisperse samples 
before analysis. Coarse materials and less stable dispersions may require a higher 
speed as well as more stirring and probe time than finer samples.
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5. In the Sample field, enter an identification string for this series of samples. Be sure to 
include the $ symbol if you want the sample file number included as part of the 
identification. If you do not enter an identification string, the default identification string 
specified in Sample defaults will be used.

6. Click  to begin analyses; analyses of samples in consecutive beakers will continue as long 
as a beaker is present in the next beaker position. Be sure to remove used beakers after 
analysis.

You can also have the beaker number containing the sample included in the sample 
identification by entering # (number symbol) within the name you specify. For 
example, Garnet in beaker #.

If you wish to view the analyses in progress, select Analysis Results from the View 
drop-down list.
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MasterTech Schedule

This option is functional only if you have a MasterTech connected to your analyzer. 

This mode of operation is used to analyze a series of samples that are different in size and 
shape and, consequently, require different analysis conditions. You also can schedule back-
ground measurements between samples. 

Refer to MasterTech Schedule, page 6-18 for a detailed description of the fields on this 
dialog.

Perform the following steps to use this mode of operation.

1. Select Unit [n] > MasterTech Schedule; the MasterTech Schedule dialog is displayed.

2. Click Insert; the MasterTech Schedule Insert dialog is displayed.
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a. Select Sample analysis.

b. Enter the position number of the beaker containing the current sample.

c. Click Browse and choose the sample file you wish to use with the sample in this 
beaker position.

d. The values contained in the fields for Stirrer time, Stirrer speed, and Probe time are 
copied from the sample file you select. You may change them if you wish.

e. Click OK; the MasterTech Schedule dialog again is displayed. Note that the beaker 
information you just entered is shown in the list box.

3. Repeat step 2 for each beaker containing sample. 

4. Click Report Settings if you wish to have reports generated automatically after analysis.

a. Enter the number of reports you wish to have generated (enabled when Printer is the 
destination).

b. Select a destination. If you choose File, enter a name in the File name field (or accept 
the default).

c. Click OK to close the dialog.

5. Click Start to begin the analyses.

You can also insert a background measurement between analyses if desired.
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Listing File Statistics

You can generate a list of the following information on one or more files:

• File name
• Date the file was created (or edited)
• Time the file was created (or edited)
• File identification
• File status

Perform the following steps to generate a list:

1. Select File > List > [file type]; a dialog similar to the one shown below is displayed:

2. From the Files list box, choose the desired file(s). If you wish to include all files in the 
list, leave all files deselected. 

3. At the Destination field, click on the down arrow and choose a destination for the list 
output. If you choose File as the destination, enter a name in the File name field.

4. Click OK, a list for the requested file(s) is sent to the specified destination.
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Exporting a Sample Information File

Use the Export option to: 

• copy the particle distribution data (Particle size option) in a sample information file and 
export it as ASCII text.

• copy the intensity and background data (Intensity option), and export it as ASCII text.

If exported and saved as a file, these data can be imported into applications (such as spread-
sheets) accepting ASCII format. Refer to Appendix G, page G-1 for exporting format.

Perform the following steps to export a sample information file in ASCII format:

1. Select File > Export; the Export Sample File dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export by holding down Ctrl and 
clicking on the desired files. 

3. From the Settings group box:

a. Choose the export type; Particle Size generates particle distribution data and 
Intensity generates the light intensity vs. scattering angle data, as well as the 
background.

b. Choose a destination for your exported file. If you choose File as the destination, enter 
a name in the File name field (or accept the default).

4. Click OK, the requested file is exported and sent to the specified destination.
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Generating Reports

The following types of reports are available with the Saturn DigiSizer analysis program:

• Tabular and/or graphical
• Background
• Statistical process control

Refer to Chapter 7 for sample reports and ways in which to edit and change the appearance of 
your report. 

Tabular/Graphical Reports

Tabular and graphical reports are generated automatically (if requested) after an analysis. You 
can also generate reports manually if you simply wish to view a report, print additional copies, 
or change parameters and reprint.

Perform the following steps to generate reports manually.

1. Select Reports > Start Report; the Start Report dialog is displayed.

2. From the Files list box, click on the name of the file(s) for which you wish to have reports 
generated.

3. At the Destination field, click on the down arrow and choose a destination for report 
output. 

If you choose File as the destination, enter a name in the File name field (or accept the 
default). 
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4. Click OK; the Reports to Generate dialog is displayed if you have selected only one file 
from the Files window.

This dialog allows you to verify or edit report selections. It is not displayed if you have 
selected multiple files; the reports selected in the files will be generated.

5. Select the report(s) you wish to generate. A report is selected when it is preceded with a 
check mark. Reports may be selected (or deselected) by double-clicking (or pressing the 
Spacebar) on the desired report.

6. Click OK; the selected reports are generated and sent to the specified destination.

Check marks indicate 
selected reports.

If you select a Screen destination, there are many options for manipulating reports. 
Refer to Onscreen Reports, page 7-20 for information on these options.
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Background Reports

A report can be generated for the instrument’s background. This report generates a graph illus-
trating light intensity versus scattering angle when no sample is present. The header of this 
report also contains background statistics, such as the unit serial number, date the background 
was performed, etc.

You can also overlay the current background with backgrounds used with other analyses for 
reference. 

Perform the following steps to generate a background report. Refer to Background, page 7-6 
for detailed information on this option. 

1. Select Reports > Background; the Start Background Report dialog is displayed.

2. From the Instrument drop-down list, select the instrument on which you wish to have 
the background report generated. 

3. If you wish to compare the current background with backgrounds for a sample (or 
multiple samples), select Overlay Samples and then click Samples to select the file(s).

4. At the Destination field, click on the down arrow and choose a destination for report 
output. Since background reports are graphical data, they cannot be printed to a File. 

5. If you choose Printer for the destination, enter the number of reports you wish to have 
generated; you can print up to four copies.

6. Click OK; the background report is generated and sent to the specified destination.  
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Statistical Process Control Reports

Statistical process control (SPC) reports assist you in maintaining control of a manufacturing 
process. 

There are three types of SPC reports: Regression, Control Chart, and PSD History. Before you 
can generate SPC reports, you must specify the calculation parameters to be used. These selec-
tions determine what values are available for SPC reporting. For efficiency, it is best to choose 
only the variables you actually intend to use since all variables selected are computed for each 
sample file used in an SPC report. 

Specifying SPC Options

Refer to SPC Report Options, page 7-7 for a detailed description of the fields on this dialog.

Perform the following steps to specify calculation parameters:

1. Select Reports > SPC Report Options; the SPC Report Options dialog is displayed.

2. From the Test drop-down list, select the analysis on which you wish to report. If you 
select Average, an average of all analyses for the specified sample file is reported.

3. Select the types of statistics you wish to report.

4. Select the type of distribution you wish to apply.

5. Select the arithmetic statistics.

6. From the Statistics group box, select the statistics you wish to be included in SPC 
reporting.
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7. Click Sample to choose the sample parameters you wish to report.

8. Click Analysis to choose the analysis conditions you wish to report.

9. Click Sizes to specify the percentiles for the corresponding diameters.

10. Click Percentiles to specify the diameters for corresponding percentiles.

11. If peak statistics are desired, select the peaks you wish to include.   

12. Click OK to save SPC report options.

Generating a Regression Report

Refer to Regression Report, page 7-10 for a detailed description of the fields on this dialog.

Perform the following steps to generate a regression report.

1. Select Reports > Regression Report; the Regression Report Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

3. Select your X- and Y-axes variables. The variables displayed in these drop-down lists are 
the ones specified in SPC report options.

If your company logo exists as a bmp or emf file and you wish to have it display in the 
report header, select Show graphic. Click Browse to select the file.
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4. Deselect Autoscale if you do not wish to have data scaled automatically; then enter the 
desired ranges.

5. Select Tabular if you wish to have tabular, as well as graphical, data of the included 
samples generated.

6. Select Label to have the points on the plot correspond with the sample files from which 
they came.

7. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

8. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when 
a statistic you have selected is labeled N/A (not available) on the tabular report.

9. Select a destination; if you choose File, enter a name in the File name field (or accept the 
default). Remember, if you choose this option, only tabular reports are generated.

10. Click Report; the regression report is generated and sent to the specified destination.

You can click Save as Default if you wish to have the selected options become the 
defaults for Regression reports.
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Generating a Control Chart Report

Control chart reports can be generated to illustrate process variations. 

Refer to Control Chart, page 7-13 for a detailed description of the fields on this dialog.

Perform the following steps to generate a control chart.

1. Select Reports > Control Chart; the Control Chart Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

3. Choose whether you wish to have files listed in order by Time, File name, Date, 
Minutes, or Days.

4. Click Graph [n] to select Y-axis labels.

5. Select Tabular report if you wish to have tabular, as well as graphical, data generated.

6. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when 
a statistic you have selected is labeled N/A (not available) on the tabular report.

7. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

If your company logo exists as a bmp or emf file and you wish to have it display in the 
report header, select Show graphic. Click Browse to select the file.
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8. Select a destination; if you choose File, enter a name in the File name field (or accept the 
default). Remember, if you choose this option, only tabular reports are generated.

9. Click Summary Statistics to choose the type of statistics you wish to report.

10. Click Report; the control chart report is generated and sent to the specified destination.

You can click Save as Default if you wish to have the selected options become the 
defaults for Regression reports.
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Generating a PSD History Report

PSD History reports allow you to generate a sequence of particle size distributions on up to 
200 files.

Refer to PSD History, page 7-17 for a detailed description of the fields on this dialog.

Perform the following steps to generate a PSD History report:

1. Select Reports > PSD History; the PSD History Options dialog is displayed.

2. Select Show report title and enter the title you wish to appear at the top of the report (or 
accept the default). Deselect this option if you do not wish to have a report title.

3. Choose whether you wish to have the X-axis order by Time, File name, Date, Minutes, 
or Days.

4. Click Samples to choose the files you wish to have reported; you can choose up to 200 
files.

5. Choose the report destination and click Report; the report is generated to the specified 
destination.

Click this push button to 
save the current defini-
tions as the default.

If your company logo exists as a bmp or emf file and you wish to have it display in the 
report header, select Show graphic. Click Browse to select the file.
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Generating Overlays

Use the overlay function when you wish to compare graphically multiple graph options. Over-
lays may be generated in three ways:

• Multiple-Graph Overlay
Overlay two different types of plots from one sample 

• Multiple-Sample Overlay
Overlay up to eight plots of the same type with the current plot 

• Multiple-Test Overlay
Overlay the same plot of all tests in one sample file

Varying symbols are used to differentiate the graphical lines and reported in a legend at the top 
of the output. If color output is available, different colors are used instead.

It is much easier to generate overlays if you have predefined report options files created for 
specific overlay functions. For example, if you frequently compare Out of Specification 
graphs, define a report options file containing the desired options and assign an identification 
such as Out of Spec Overlays. Then you can use Replace to load the predefined file into the 
sample file. You do not have to save the file to have overlays generated, so the report options 
for your original sample file remain intact.

Multiple-Graph Overlay

This option enables you to overlay two graphs from the same sample file:

1. Select File > Open > Sample information. Then choose the desired sample file. If your 
window is presented in the Basic format, click Advanced.

2. Select the Report Options tab; the report options dialog is displayed.

3. Use one of the following methods:

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

Select which test you wish to use.

In the Reports to Generate list box, select the graph(s) you 
wish to overlay with other graph(s).

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

From the Overlay drop-down list, choose the type of graph 
you wish to overlay; then click OK.
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4. Select Reports > Start Report; the Start Report dialog is displayed. Your file should be 
highlighted and in the File name field.

5. Choose your print destination. 

6. Click OK; the Reports to Generate dialog is displayed, allowing you to change report 
selection if you wish.

7. Click OK; requested overlays are generated and sent to the specified destination.

Multiple-Sample Overlay

To overlay the same type of graph(s) from multiple samples:

1. Select File > Open > Sample information. Then choose the desired sample file. If your 
window is presented in the Basic format, click Advanced

2. Select the Report Options tab; the report options dialog is displayed.

3. Use one of the following methods:

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

From the Test drop-down list, select the test you wish to use.

The graph(s) you select will be overlaid with the same type 
of graph(s) of the same test number in the sample file(s) you 
choose for overlay.

In the Reports to Generate list, select the graph(s) you wish 
to overlay.

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

Ensure that Samples is selected in the Overlays field.

Click OK to display the Report Options dialog.
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4. Click Overlays; the Graph Overlay Samples dialog is displayed.

5. Click Browse; the Graph Overlay Sample Selection dialog is displayed.

6. Choose the file(s) you wish to use; then click OK. You may choose up to eight files in this 
manner.

7. Select Reports > Start Report; the Start Report dialog is displayed. Your file should be 
highlighted and in the File name field.

8. Choose your print destination. 

9. Click OK; the Reports to Generate dialog is displayed, allowing you to confirm or change 
report selection.

10. Click OK; requested overlays are generated and sent to the specified destination.

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.
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Multiple-Test Overlay

This options enables you to overlay the same type of graph for all tests from the same sample 
file:

1. Select File > Open > Sample Information. Then choose the desired sample file. If your 
window is presented in the Basic format, click Advanced.

2. Select the Report Options tab; the report options dialog is displayed.

3. Use one of the following methods:

4. Select Reports > Start Report; the Start Report dialog is displayed. Your file should be 
highlighted and in the File name field.

5. Choose your print destination. 

6. Click OK; the Reports to Generate dialog is displayed, allowing you to confirm or change 
report selection.

7. Click OK; requested overlays are generated and sent to the specified destination.

If... Then...

You are using a predefined 
Report Options file:

Click Replace and choose the report options file you wish to 
use.

You are defining report 
options:

In the Reports to Generate list box, select the graph(s) you 
wish to overlay.

Click Edit for each requested graph; a Graph Options dialog 
is displayed.

Ensure that Tests is selected in the Overlays field.

Click OK to return to the Report Options dialog.

You do not have to save these options to generate the overlays. If you do save, the 
reports options for your original sample file will be replaced with the new ones.
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4.  SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

• Installing the software, beginning on this page
• Using the Setup Program for Other Functions, page 4-8

You can also install the 5205 analysis program for offline data manipulation on a computer 
other than the one controlling the analyzer. This allows you to:

• create or edit sample and parameter files
• generate reports on completed sample files 

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy of the analysis program.

Installing the Software

Be sure you have completed the following tasks before installing the software for the first 
time.

• Configure the ethernet port the analyzer will use.

• Disable the firewall setting for the connection between your computer and analyzer.

• Connect the analyzer to the configured port and turn the analyzer on. 

Install the program as follows:

1. Turn on the analyzer and the liquid sample handler.

2. Insert the Saturn DigiSizer CD into the CD-ROM drive.

3. Select Start > Run from the Windows menu bar.

4. Enter the drive designator for the CD-ROM, followed by setup.  For example:   e:setup

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.

If installing multiple analyzers, connect the ethernet switch to the configured port and 
the analyzers to the ethernet switch (refer to Ethernet Switch, page 4-11); turn the 
analyzers on.
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5. Click OK; the Ethernet Introduction dialog is displayed. This screen outlines the steps 
that should be completed before installing the software.

If all of the steps have not been completed, click Cancel and perform the steps; then 
restart the installation program. Do not proceed with installation until these tasks have 
been completed.

6. Click OK; the New Installation dialog is displayed.

The Destination Folder group box displays the amount of current disk space required for 
the analysis program, and the directory into which the application will be installed. If you 
prefer a different directory for installation, click Browse to select the desired directory.
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7. Select the check box just below the Destination Folder group box to add an icon to your 
desktop; this enables quick access to the analysis program.

8. The DigiSizer icon is added to the Micromeritics folder by default. If you prefer a 
different folder, enter or select one from the drop-down list.

9. The Install this application for All Users check box enables you to allow or prohibit 
users other than the installer to access the application.

• Select the check box to allow access for all users logged onto Windows.
• Deselect the check box to allow access for only the user installing the application.

10. Click Next; the Analyzer Configuration dialog is displayed.

a. In the Step 1 group box: 

b. In the Step 2 group box, enter the serial number(s) for the analyzer(s) you are 
attaching to this computer.

If... Then...

you are installing the 
analysis program at initial 
installation:

select the number of analyzers you are installing.

you plan to use the 
analysis program for 
offline data reduction:

select 0

you are moving an 
analyzer from another 
computer to this one:

select 0 (Refer to Moving an Analyzer from One 
Computer to Another Computer, page 4-13.)
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11. Click Next; the Ethernet Ports dialog is displayed.

12. Choose one of the following:

13. Click Next; the calibration files are installed.

If you are installing two analyzers, the Calibration File Installation dialog instructing you 
how to proceed with installation of calibration files for the second analyzer is displayed. 
Read the instructions carefully; they are restated here.

a. Remove this setup CD.

b. Insert the CD containing the files for the analyzer serial number requested. 

IMPORTANT: To prevent the CD from AutoPlay, hold down the Shift key before 
you close the CD door. Do not release the Shift key until the CD light stops blinking. 

If .... Then ....

the port you configured 
is listed:

select the port and proceed to the next step.

the port you plan to use 
has been configured but 
is not listed:

Click Specify, the Specify Ethernet Port dialog is displayed.

Enter the remaining portion of the IP address in the enabled 
fields, then proceed to the next step.

If you selected 0 as the number of instruments to install, calibration files are not 
installed. the analysis program will install and the model management utility displayed 
for installation of models.
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c. When the CD lights ceases to blink, click Next. After the calibration files are installed, 
you will be prompted to reinsert the original setup CD.

14. Click Next; the Model Management dialog is displayed. Models are collections of data 
detailing how light is scattered by particles of differing sizes made of a given substance in 
the liquid chosen to disperse them. Models are used to translate the measured light-
scattering pattern into a particle size distribution.

You can also install models using the Model management command on the Options 
menu in the analysis program. Click Skip if you prefer to install the models at a later 
time.

Local disk Allows you to install models to your local drive or to remove 
models already installed on the local drive. 

If you choose to install the models on your local drive, keep 
in mind that each model uses 1.7 MB of disk space. 

Proceed to Step 15 for the Local disk option.

CD-ROM Allows you to access the models from the CD-ROM drive so 
that you do not have to use disk space on your local drive. 
Use the drop-down list to select the drive designator for the 
CD-ROM drive.

If you choose to use this option, be sure that the CD-ROM is 
in the drive when the analysis program is in use.

Proceed to Step 16 for the CD-ROM option.
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15. To install the models on your local drive:

a. Choose Local disk; this dialog is displayed.

b. Choose Install Micromeritics models from CD-ROM to the local disk. Ensure that 
the appropriate drive designator is displayed as the CD-ROM drive, then click OK; a 
dialog containing the current models is displayed.

c. Click Select all to install all models. Alternatively, you can click on the models you 
wish to install while holding down the Ctrl key. 

d. Click OK to copy the models to your local hard disk; each model uses approximately 
1.7 MB of disk space. After selected models are installed, a dialog confirming the 
number of models installed is displayed.

e. Click OK; the Install Complete dialog containing the Readme file is displayed.

f. Click Finish; a dialog informing you to restart Windows may display; if so, select OK 
to have the system restart Windows.
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16. To use the models from your CD-ROM drive:

a. Choose CD-ROM; ensure that the correct drive designator is displayed. Be sure to 
have your analysis program CD inserted in the CD-ROM drive when the analysis 
program is in use.

b. Click OK; the Install Complete dialog containing the Readme file is displayed.  

17. Click Finish to close the dialog.

18. Remove the program CD and store in a safe place. The original program CD contains the 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you maintain your original program CD in a secure location 
in the event calibration files need to be reinstalled.
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Using the Setup Program for Other Functions

After initial installation of the DigiSizer analysis program, the application setup program can 
be used to:

• install software upgrades, page 4-10
• add an analyzer, page 4-11
• move an analyzer from one computer to another computer, page 4-13
• change the analyzer setup, page 4-18
• remove an analyzer from the computer, page 4-17
• reinstall calibration files, page 4-20
• uninstall the analysis program, page 4-21

To start the application setup program:

1. Ensure that the analysis program is not operating and the analyzer is idle. 

2. Insert the CD into your CD-ROM drive.

3. Select Start from the Status bar, then Run from the start menu.

4. Enter the drive designator of the CD-ROM drive, followed by setup. For example:  
e:setup

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.

5. Click OK; the Setup Welcome screen showing the options available is displayed.

6. Select the operation you wish to perform. Procedures for performing each operation are 
in subsequent sections.

Options 
available for 
the DigiSizer 
program are 
enabled.
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After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower sec-
tion of the dialog.

7. After you have completed all desired operations, click Exit to close the Welcome screen.

8. Remove the CD and store in a secure location.

Indicates status 
of last operation 
performed.
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Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any sta-
tus files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer 

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. In the Setup dialog, choose the software option. Remember, only the applicable option 
displays; it will be one of the following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

2. Click Start file installation. The application installs the software and the Setup Welcome 
dialog is displayed.
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Adding an Analyzer

An ethernet switch is required when connecting two analyzers. After connecting the ethernet 
switch, continue with the software section.

Ethernet Switch

An Ethernet switch with a straight-through cable is required when installing multiple 
analyzers.

1. Connect the power cord of the Ethernet switch to an appropriate power outlet.

2. Disconnect the ethernet cable of the current analyzer from the computer; do not 
disconnect it from the analyzer.

3. Connect one end of the straight-through cable to the Ethernet switch and the other end to 
the computer.

4. Connect the ethernet cable of the current analyzer to a numbered port on the Ethernet 
switch (do not use the uplink port).

5. Connect one end of the Ethernet cable (for the analyzer you are adding) to the connector 
labeled Ethernet on the rear panel of the analyzer and the other end to a numbered port 
on the Ethernet switch. Repeat this step for each analyzer you are adding.

The finished configuration should look like the following illustration.  

6. Turn on the analyzer that was added. Also ensure that the computer and current analyzer 
are on.

Ethernet switch Be sure cables are not 
connected to the uplink port.
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Software

1. Insert the analysis program CD for the analyzer you are adding  into the CD-ROM drive.

2. Start the Setup program  (refer to Using the Setup Program for Other Functions, page 
4-8). 

3. Select Add an analyzer, then click Next; the Set up analyzer being added dialog is 
displayed.

4. Enter the serial number of the analyzer being added.

5. Click Next; the calibration files are installed and the Welcome screen is displayed.

You may see the Ethernet Introduction screen. This information is not applicable since 
you are connecting to an ethernet switch which is connected to a port that has been 
configured. Click OK to close the screen and proceed.
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Moving an Analyzer from One Computer to Another Computer

Use the instructions in this section to move a configured analyzer (along with its status, cali-
bration, and log file) from one computer (Source PC) to a different computer (Destination 
PC). This operation does not move sample or parameter files. Use a file management program 
such as Explorer or a backup/restore utility to move these types of files.

Moving a Configured Analyzer to a New Computer

This section provides steps for moving a configured analyzer to a computer that does not have 
an analyzer installed.

1. Install the analysis program on the destination computer (refer to Installing the 
Software, page 4-1). Be sure to select 0 as the number of instruments on the Analyzer 
Configuration screen; all related instrument information will be transferred in the Move 
operation.

2. Start the application setup program on the source computer (refer to Using the Setup 
Program for Other Functions, page 4-8).

3. Select Move an analyzer from one PC to another PC, then click Next; the Move 
analyzer operation dialog is displayed.

If the analysis program is already installed on the destination computer, begin with 
Step 2.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. From the drop-down list in the Step 1 group box, select the analyzer that is to be moved 
from this computer.

6. In the Step 2 group box, click Browse to select a location for storing the status, 
calibration, and log files associated with the source computer. If possible, the location 
should be a shared network drive. If this is not possible, select a local folder and then use 
a transfer utility to copy its contents from the Source PC to the Destination PC.

7. Click Next; the files are copied to the specified location and the setup Welcome screen is 
displayed.

8. Start the Setup program on the destination computer.

9. Select Move an analyzer from one PC to another PC; the Move analyzer operation 
dialog is displayed (shown on previous page).

Sample and parameter files are not copied and moved with the analyzer. Use  a file 
management program such as Explorer or a backup/restore utility to move these files.
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10. Select Destination PC, then click Next; the Ethernet Introduction screen is displayed. 
This screen outlines the steps that should be completed to configure the ethernet port to 
which the analyzer is connected to on the computer.

If these tasks have not been completed, click Cancel and complete them; then restart the 
setup program. Do not proceed until the ethernet port in the computer has been 
configured.

11. Click OK; the Move analyzer information dialog to this PC dialog is displayed.

12. In the Step 1 group box, enter the serial number of the unit you are moving to this 
computer.

13. In the Step 2 group box, click Browse to choose the location of the files that were stored 
previously from the Source computer.
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14. Click Next; the files are transferred and the Ethernet Ports dialog is displayed.

Select the desired ethernet port.

15. Click Next; the setup Welcome screen is displayed. 

16. Turn on the analyzer and start the analysis program.

Moving a Configured Analyzer to a Computer with an Existing Analyzer

This section provides steps for moving a configured analyzer to a computer that already has 
the analysis program and a configured analyzer installed, this being the second analyzer. When 
installing two analyzers on one computer, an ethernet switch is required. Refer to Ethernet 
Switch, page 4-11. 

1. Perform Steps 2 through 7 (steps for Source computer) of the procedure Moving an 
Analyzer from One Computer to Another Computer, page 4-13.

2. Disconnect the Ethernet cable of the analyzer from the Source computer (or Ethernet 
switch). Reconnect the cable to the Ethernet switch for the Destination computer. You 
must use a switch when attaching multiple analyzers. 

3. After ethernet connections have been established, return to page 4-14 and begin with Step 
8 (steps for Destination computer). You will not see the Ethernet Ports dialog (Step 13) 
since an ethernet port has already been assigned.

4. Turn on the computer, the liquid sample handlers and the analyzers, then start the analysis 
program. 
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Removing an Analyzer

You can remove an analyzer from the system as follows. When you do so, the system removes 
the calibration and status files from the computer.

1. Start the Setup program   (refer to Using the Setup Program for Other Functions, page 
4-8). 

2. Select Remove an analyzer, then click Next; the Remove an analyzer dialog is 
displayed.

3. From the drop-down list, choose the serial number of the analyzer you wish to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is displayed.

This operation removes the selected instrument from the list of attached instruments. 
It does not remove calibration and status files associated with the analyzer, nor does it 
remove sample and parameter data files.
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Changing the Analyzer Setup Configuration

This option allows you to change the ethernet port being used by the analyzer(s). For example 
if the current ethernet port malfunctions, you would use this option to move the analyzer to 
another ethernet port.

Be sure that the ethernet port you are switching to has been configured and the firewall setting 
between the computer and the analyzer is turned off. 

1. Start the Setup program  (refer to Using the Setup Program for Other Functions, page 
4-8).

2. Select Change analyzer setup, then click Next; the Ethernet Introduction screen is 
displayed. This screen outlines the steps that should be completed to configure the 
ethernet port to which the analyzer will be connected.

If these tasks have not been completed, click Cancel and complete them; then restart the 
setup program. Do not proceed until the ethernet port in the computer has been 
configured.
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3. Click OK; the Ethernet Ports dialog is displayed.

4. Choose one of the following:

5. Click Next; the change is completed and the Welcome screen is displayed

If .... Then ....

the port you plan to 
use is listed:

select the port and proceed to the next step.

the port you plan to 
use has been config-
ured but is not listed:

Click Specify, the Specify Ethernet Port dialog is 
displayed.

Enter the remaining portion of the IP address in the 
enabled fields, then proceed to the next step.
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Reinstalling Calibration Files

Calibration files specific to the analyzer are contained on the original program CD; they are 
not contained on an update CD. It is important that you store your original program CD in a 
safe location. CDs containing calibration files will always end with a suffix of 99. Update CDs 
end with a suffix of 00.

Reinstall calibration files as follows:

1. Using the CD containing the appropriate calibration files, start the Setup program  (refer 
to Using the Setup Program for Other Functions, page 4-8).

2. Select Re-install calibration files for an analyzer, then click Next: 

If .... Then ....

you have only one 
analyzer installed

the calibration files are installed and the Welcome screen 
is displayed.

you have multiple ana-
lyzers installed, a 
dialog enabling you to 
choose the desired 
analyzer is displayed.

select the appropriate analyzer, then click Next; the cali-
bration files are installed and the Welcome screen is 
displayed.
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Uninstalling the Analysis Program

You can remove the DigiSizer analysis program as follows. When you perform this operation, 
the application removes the analysis program, status files, analyzer setup files, and resulting 
empty directories. It does not remove data files.

1. Start the Setup program   (refer to Using the Setup Program for Other Functions, page 
4-8). 

2. Select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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Saturn DigiSizer II 5205 Description
5.  FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu commands. Detailed descriptions follow 
this section.

Open Enables you to open an existing sample or parameter file, or  
to create a new one. Page 5-3.

Save Saves the file in the active window. Page 5-38.

Save As Allows you to save the file in the active window under a 
different name. It also can be used to save a subset of the 
sample file as a parameter file. Page 5-38.

Save All Saves all open files. Page 5-39.

Close Closes the file in the active window. Page 5-39.

Close All Closes all open files. Page 5-39.
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Print Enables you to print the contents of a sample or parameter 
file.  Page 5-40.

List Generates statistics for a sample or parameter file. Page 5-42.

Export Exports a sample file in ASCII format. Page 5-44.

Exit Exits the analysis program.  Page 5-46.
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Open

Select Open to open an existing sample or parameter file, or to create a new one. 

The Open dialog is common to all file types. The title bar will display the type of file you are 
opening. The example shown here is a Sample Information File. 

Refer to Selecting Files, page 2-15 for a description of the options in the Selection Criteria 
group box.

File name For sample information files, this field contains the next 
sequenced file name generated by the system in the format 
specified in Sample Defaults. 

• To create a file: accept the default or enter an appropriate 
name and click OK. 

• To open a file: select the desired file from the Files win-
dow and click OK.

For parameter files, this field contains the wild card (*) and a 
default extension:

• To create a file: enter an appropriate name (up to eight 
characters) and click OK. 

• To open a file: select the desired file from the Files: win-
dow and click OK.

Title Bar
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Sample Information

Sample information files contain information used to control the analysis, as well as collected 
or manually entered data. You must assign a sample information file to every analysis. You 
can also edit an existing sample information file. A sample information is comprised of the 
following:

• sample identification
• analysis conditions
• material properties
• report options
• collected (when an analysis is complete) or entered data 

Portions of the sample file can also exist as standalone parameter files. These parameter files 
contain frequently used analysis conditions, material and dispersant properties, and report 
options which may be conveniently loaded into a new sample information file. They can also 
be edited if required.

Sample information files are presented in three formats:  

• Advanced 
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its 
associated dialog. 

• Basic 
Presents all parts of the sample information file as a single dialog. With this format, you 
can quickly create a sample information file using previously defined analysis 
conditions and report options files.

• Restricted
This format is identical to the Basic format except that you cannot switch to the 
Advanced format for editing and certain functions are disabled.

Select Options > Options Presentation to specify the format most suitable for your labora-
tory’s use.
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Basic

The Basic format displays all parts (parameters) of the sample information file on a single dia-
log. This format allows you to create a sample information file using predefined parameter 
files. It is quick, easy, and the most popular format among Saturn DigiSizer users. If you wish 
to view or edit specific parameters of the sample file, you can switch easily to the Advanced 
format by clicking Advanced.

Refer to Basic and Restricted Formats, page 3-12 for step-by-step instructions on creating a 
sample information file using the Basic format.

Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file 
description based on the format you specified in Sample 
Defaults. 

You can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters

Replace All Click this push button to replace all parameters of the current 
sample file with those from another one.
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Analysis Conditions Contains the name of the current Analysis Conditions file.

If this is a new file, this field contains the name of the file you 
specified as the default.

Click on the down arrow to choose a different file. This list 
contains previously defined parameter files; those included 
with the analysis program as well as any you may have 
created specifically for your laboratory. 

This list is disabled for files which have been used for an 
analysis (Complete status). 

Autodilute Enables monitoring of the sample’s concentration and adds 
liquid as needed to attain the appropriate concentration before 
analysis and data collection begin.

Number of tests Enter the number of analyses you wish to perform using this 
sample file; you can perform up to eight tests with one file.

Rinse Allows rinsing of the cell, the tubing, and the reservoir after 
each analysis. We recommend this option remain selected. If 
you deselect this option and rinses are not performed after 
analysis, inaccurate results may be obtained on subsequent 
analyses.

Sample Displays the type of sample material that was analyzed using 
the current file.

If this is a new file, this field contains the name of the 
material you specified as the default.

Click on the down arrow to choose a different sample 
material from the list.

Add sample materials to the list by switching to the 
Advanced format.
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Liquid Displays the dispersing liquid used in the analysis for the 
current file.

If this is a new file, this field contains the dispersing liquid 
you specified as the default.

Click on the down arrow to choose a different liquid from the 
list. 

Add dispersing liquids to this list by switching to the 
Advanced format.

Report Options Contains the name of the current Report Options file. 

If this is a new file, this field contains the Report Options file 
you specified as the default.

Click on the down arrow to choose a different file. This list 
contains previously defined parameter files; those included 
with the analysis program as well as any you may have 
created specifically for your laboratory. 

Reports to Generate Displays a list of available reports. The reports selected for 
the current Report Options file are preceded with a check 
mark (). 

Certain parameters of some reports can be edited by 
switching to the Advanced format.
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Advanced

The Advanced format displays the sample information file in a tabbed dialog. Each parameter  
is accessed by clicking its tab. You can also use Prev and Next to move through the dialogs. 
This format allows you to customize sample files.

Refer to Advanced Format, page 3-14 for step-by-step instructions on creating a sample 
information file using the Advanced format.

The prompts for the Sample, Operator, Submitter, and User Parameter fields may be cus-
tomized by selecting Options > Sample Defaults. Refer to Sample Defaults, page 8-6 for 
instructions on customizing these prompts.

Sample Contains the description of the current sample information 
file.

If this is a new file, this field contains the next sequenced file 
description based on the format specified in Sample Defaults 
(see Chapter 8). 

You can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters
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Operator
Submitter

Displays the Operator and Submitter names (if specified) of 
the current sample file.

If this is a new file, these fields contain the names specified in 
Sample Defaults.

You can enter a different name for either (or both) fields if 
desired.

Range: 40 characters

Bar code This field enables you to enter bar code information. If bar 
code information is not used, you can use this field to enter 
additional information about the sample; for example, you 
may wish to enter the lot number of your sample. This field 
can also be omitted in Sample Defaults if it is not needed.

This field will also accept data from a bar code reader.

Range: 40 characters

Type of Data Displays the type of data for the current sample file.

If this is a new file, choose whether you wish to have data 
collected automatically or whether you wish to enter data.

User Parameters These fields are used primarily for SPC (Statistical Process 
Control) reporting. However, they can be used for other data 
as well. You may wish to enter specific analysis conditions or 
sample criteria. These parameters print on the Options report. 
Select Options > Sample Defaults to specify the parameters 
you wish to report. The parameter(s) you specify replace the 
User Parameter label(s).

If SPC reporting is not desired, these fields can be omitted 
from the sample information file.

Comments Allows you to enter comments about the sample or its 
analysis conditions. Anything you enter in this window is 
printed in the header of the report.
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Restricted

A third format is provided to control access to some portions of the sample information file. 
The Restricted format displays in the same manner as the Basic presentation format.

The fields on this dialog are identical to the ones on the Basic Information dialog except that 
this dialog does not contain an Advanced push button allowing you to switch to the Advanced 
format. This format is also password-protected, preventing the operator from making changes 
to file parameters. Refer to Restricted, page 8-4 for additional information on the Restricted 
format.

Restricted presentation is ideal for laboratories in which standard analysis procedures are 
established by a lab manager, while one or more lab technicians actually perform the analyses. 
The lab manager can create independent parameters files containing standard sets of operating 
conditions, then the operator(s) can use Restricted mode for daily operations, selecting the 
standard parameter files from the drop-down lists.

Add Log Entry Allows you to enter comments about the sample or its 
analysis conditions. Anything you enter using the dialog 
displayed by this push button appears in the Instrument Log 
Report; it does not display in the report header.

Replace All Click this push button to replace all parameters of the current 
sample file with those from another one.

This format displays in 
the same manner as 
the Basic format; how-
ever, you cannot switch 
to the Advanced format 
for editing.
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Analysis Conditions

The Analysis Conditions dialog allows you to specify analysis conditions for your sample. 
You can create an Analysis Conditions file as an independent parameter file or include it as 
part of the sample information file. The dialog shown here is for creating a standalone file.

Analysis Conditions Contains the description of the current Analysis Conditions 
file.

If this is a new file, this field contains the name you specified 
as the default.

You can enter a new description or add to the existing one if 
desired. Be sure to use an intuitive name (perhaps one that 
characterizes the analysis conditions) so that it can be easily 
recognized when needed.

Range: 40 alphanumeric characters

Replace Allows you to replace the values in the current analysis 
conditions file with those from an existing file. A dialog is 
displayed so that you may select the desired file. Click OK; 
the values are copied into the new file automatically.
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Flow rate group box Displays the flow rate conditions for the current sample file.

If this is a new file, use the options in this group box to 
specify flow rate requirements.

Set flow rate Select this option to enter a flow rate or have the flow rate 
calculated automatically. 

Select Enter; the Flow rate field is enabled so that you can 
enter a specific flow rate.

Select Auto calculate; the Maximum particle size field is 
enabled so that you can enter the estimated maximum particle 
size of your sample. This enables you to set a flow rate large 
enough so that no sampling error (due to a slow flow rate) is 
introduced.

If you deselect this option, the previous flow rate (typically, 
from the previous analysis) is used.

Redispersion group box Displays redispersion parameters for the current sample file.

If this is a new file, use the options in this group box to 
specify redispersion parameters.

Ultrasonic probe Select this option if you are using an ultrasonic probe. 

In the Intensity field, enter the percent of intensity at which 
to have the ultrasonic probe operate. In the Time field, 
specify how long the sample is to be agitated before each 
analysis. Or you can select On during test to have the probe 
operate during analysis.

Coarse materials and less stable dispersions may require more agitation than finer 
materials.

Circulate before 
data collection

Circulates the analysis liquid through the system after you 
have added the sample. Enables the Circulation time field so 
that you can enter how long the sample circulates before 
analysis and data collection begin.

Redisperse before 
each test

Redisperses the sample just before each test (analysis) is 
performed. You can perform up to eight tests with one 
sample file.
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Obscuration Displays details of the beam obscuration criteria.

Minimum
Maximum

These fields allow you to specify a recommended range for 
the beam obscuration. The range you specify will be used on 
the obscuration bar graph during sample loading. Refer to 
Appendix B, page B-1 for guidelines on appropriate 
obscuration levels for various particle sizes.

Autodilute to Allows monitoring of the sample’s concentration and adds 
liquid as needed to attain the appropriate concentration before 
analysis and data collection begin.

Data Collection Specify the beam angle at which to stop data collection. 

• Lower beam angles produce shorter analysis times.

• Lower beam angles can be used for samples that do not 
contain small particles.

• Higher beam angles allow smaller particles to be detected.

Generally, the default of 45º is suitable for most samples 
unless a significant quantity of the material has particle size 
less than 0.3 micrometers; if this is the case, 65º is 
recommended.

Number of tests Enabled when the current file has not been used for its 
maximum number of analyses. Enter the number of tests 
(analyses) you wish to perform using this sample file; you 
can perform up to eight tests with one file.

Rinse after analysis Deselect this option if you wish to examine the reports before 
proceeding with, perhaps, further tests on the file or further 
dispersion. If this is the case, however, you should perform a 
rinse using the option on the Unit [n] menu or select a sample 
file and enable the Rinse after analysis option to prepare for 
the next analysis.

Select this option to rinse the cell, the tubing, and the reser-
voir after each analysis. 
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Autorinse Rinses the system until a beam obscuration of 0.1 or less is 
attained. 

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message. 

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed. 

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. If less than 1.0, it is assumed to 
be due to the difference in liquids and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. 

Rinse cycles  Allows you to specify an exact number of rinses to perform.

MasterTech Treatment Displays the Mastertech Treatment dialog so that you can 
specify the stirrer time, stirrer speed, and probe time for the 
MasterTech.

Samples tend to settle in the beakers while waiting for sample 
analysis, especially if they are prepared in advance (as in 
most cases when using a MasterTech). The options in this 
dialog allow you to program the MasterTech stirrer and probe 
to redisperse the sample prior to analysis.

This option is applicable only if a MasterTech is being used 
in the analyses.
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Material Properties

This dialog allows you to specify the properties of the sample material being analyzed and the 
dispersing liquid in which it is dispersed. A Material Properties file can be created as an inde-
pendent parameter file or included as part of the sample information file.

Material Properties Contains the description of the current Material Properties 
file.

If this is a new file, this field contains the description you 
specified as the default. 

You can enter a new description or add to the existing one. 
Be sure to use an intuitive name (one that characterizes the 
material properties) so that it can be easily recognized when 
needed.

Range: 40 alphanumeric characters

Replace Allows you to replace the values in the current analysis 
conditions file with those from an existing file. A dialog is 
displayed so that you may select the desired file. Click OK; 
the values are copied into the new file automatically.
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Sample Material Displays a list of available sample materials. After you select 
a sample material from the list, its description and properties 
are displayed.

Description Displays the sample material you select from the list. This 
field is also used to add sample materials to the list.

Refractive Index Displays the real and imaginary portions of the refractive 
index for the selected material.

Density Displays the density of the selected material.

Add Enables you to add sample materials to the list

• In the Description field, enter the name of the sample 
material you wish to add.

• In the Density field, enter the density of the material you 
are adding. 

• In the Refractive Index fields, enter the real (Re) and 
imaginary (Im) portions of the refractive index.

• Click Add. 

Density and refractive index values can be obtained from a laboratory handbook.

Add This push button is also used to change density and/or 
refractive index values for a sample material.

• Select (highlight) the sample material you wish to edit.

• Enter the new value(s) in the appropriate field(s).

• Move the mouse pointer to another field; note that Add 
changes to Change. 

• Click Change; the values are changed.

Delete Deletes the selected sample material from the list.
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Analysis Liquid Displays a list of available analysis (dispersing) liquids. After 
you select a liquid from this list, its description and properties 
are displayed.

Description Displays the analysis liquid you select from the list. This field 
also is used to enter the name of analysis liquids you wish to 
add to the list.

Refractive Index Displays the refractive index (real portion) of the selected 
analysis liquid.

Viscosity Displays the viscosity of the selected analysis liquid.

Density Displays the density of the selected analysis liquid.

Add Enables you to add analysis liquids to the list.

Analysis liquids are added in the same manner as sample 
materials.

Delete Deletes the selected analysis liquid.

Scattering Model Displays the refractive indices for the sample material (real 
and imaginary) and analysis liquid, as well as  the model 
chosen by the system to be the closest match.

Options Use this push button to select a different model or to generate 
a new one; the Scattering Model Advanced Options dialog is 
displayed.
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Options

(continued)

You can choose a different model from the Available Models 
list, as well as specify the type of smoothing desired. 

Low should be used when high resolution is desired, and 
your sample material consists of near-perfect spheres with 
accurately known refractive indices.

Medium is the default and typically is appropriate for most 
materials.

High should be used for (1) materials in which an accurate 
refractive index is unknown, or (2) materials that differ 
greatly from the Mie scattering patterns (nonhomogeneous 
materials or materials that have a large aspect ratio in particle 
shape).

If a suitable model is unavailable, you can click Generate to 
create a new model. When you generate a new model, its 
progress is displayed across the lower portion of the dialog. 
Generation times vary, depending on computer speed. Typi-
cally for a 333 megahertz computer, generating a new model 
takes approximately 20 minutes. 

Truncate data at scattering angle
Choose this option to truncate the intensity data used in fit-
ting the model; data will be truncated at the angle specified in 
the adjacent field.

Minimum signal fraction
This field allows you to restrict intensity data used in fitting 
the model based on a percentage due to sample scattering 
rather than background.

Apply Changes
Enabled when the changes requested in this dialog are to a 
file that has been used in a completed analysis. You must 
select this push button to apply the  changes in fitting the 
model to the data  from all tests used with the file.

OK
Enabled when the changes you requested in this dialog are to 
a file that has not been used in an analysis. Clicking this push 
button saves the changes.
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Report Options

This dialog allows you to specify report options for a new file or to edit an existing one. A 
report options file can be created as an independent parameter file or included as part of the 
sample information file.

Report options Contains the description of the current Report Options file. 
You may change the description if you wish.

If this is a new file, this field contains the description you 
specified as the default.

You can enter a new description or add to the existing one if 
desired. Be sure to use an intuitive name (one that character-
izes the report options used) so that it can be located easily 
when needed.

Range: 50 alphanumeric characters

Replace Allows you to replace the values in the current analysis 
conditions file with those from an existing file. A dialog is 
displayed so that you may select the desired file. Click OK; 
the values are copied into the new file automatically.
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Show report title Enables you to enter a title for your report.

If this is a new file, the title you specified as the default is 
displayed.

You can accept the default title or enter a new one. You can 
enter up to 50 alphanumeric characters.

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo.

Click Browse to choose the graphic, then use the Height and 
Width fields to specify a size. This image can be edited from 
the report window.

Reference Displays the Reference Sample dialog so that you can specify 
a sample file with which to compare analysis results of the 
current sample; produces a Difference of Reference report.

• Click Browse to display the Reference Sample File Selec-
tion dialog.

• Choose the file you wish to use for the difference in refer-
ence calculation, then click OK.

• Use Clear to clear the field of its entry.
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Specification Displays the Specification Samples dialog so that you can 
specify the sample files to be used for the boundaries of the 
coarse and fine specifications; produces an Out of 
Specification report. Then you can quickly determine if the 
results of the current sample are within the specified 
boundaries.

• Click Browse to the right of each field to display the Spec-
ification Sample File dialog box containing a list of sample 
files from which to choose.

• Choose a file, then click OK.

• Use Clear to clear the field of its entry.

Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files containing the data you wish to 
overlay onto a selected plot.

Click Browse to the right of the sample number field; choose 
the desired file, then OK. 

You can select up to eight files. Refer to Generating 
Overlays, page 3-41 for step-by-step instructions on 
generating overlays.
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Peaks Displays the Peak Detection Settings dialog, allowing you to 
choose how peaks are detected.

Auto Select this option to have peaks detected automatically. 
When you select this option, the Minimum distribution to 
report and Minimum valley depth to separate peaks fields 
are enabled, allowing you to specify a threshold for the peak 
size.

The valley depth option enables you to specify a threshold 
for resolving multiple peaks. Valley depth is calculated as:

where a = the smaller peak
b = lowest point between the two peaks

If the depth is greater than the value you enter as the 
minimum, the two peaks are treated as separate; otherwise, 
they are treated as one peak.

a b–
a

------------ 100%

a b
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Manual This option enables you to define the peaks by Diameter or 
Volume. Use the table to enter the minimum and maximum 
values for each peak to be detected.

Test Use this drop-down list to specify which test (analysis) you 
wish to have a report generated for.

Reports to Generate Contains a list of available reports. 

Select reports by double-clicking on the desired report(s). 
Alternatively, you can highlight the desired report and press 
the Spacebar. A report is selected when it is preceded with a 
check mark (). Refer to Report Examples, page 7-28 for 
examples of some of the reports generated by the analysis 
program. 

Reports are deselected in the same manner. Most reports can 
be edited by highlighting the desired report and clicking Edit. 

You can also generate Statistical Process Control (SPC) 
reports using the options on the Reports menu.

Edit Allows you to edit values of the selected report.

This push button is disabled for the following reports; they 
cannot be edited:

• Rosin Rammler
• Log Probability
• Sample Log
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Combined Report

Select the Combined Report to edit; the Combined Report Options dialog is displayed.

The list of reports for the Combined Report is almost identical (the Combined report, of 
course, is not included in this list) to the list of reports generated in the normal manner. The 
difference is that the reports generated from the selections on this dialog contain no page 
breaks or headings. And, unless too many are selected, all reports display on one page.
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Tabular Reports

Select a table to edit; a dialog similar to this one is displayed.

The Standard Class Size Table and the Standard Sieve Table are fixed and, therefore, do not 
contain a table nor push buttons. 

• The Standard Class Size Table is fixed based on 40 classes per decade (refer to Appendix F, 
for data reduction information). 

• The Standard Sieve Table is fixed based on the sieves you specify (refer to Sieve Table, 
page 8-11).

Table Enter the values at which you wish the data to be reported (or 
accept the defaults).

A table is not included on the dialogs for the Standard Class 
Size Table and the Standard Sieve Table.

Insert Inserts a point above the selected point.

Use Ctrl   to add points at the beginning of the table and Ctrl 
 to add points at the end of the table.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

The title bar displays 
the name of the table 
being edited.

These components do 
not display if you are 
editing the Standard 
Class Size Table or the 
Standard Sieve Table.
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Delete Deletes the selected point.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

Clear Clears all but the one required point from the table.

This push button is not included on the dialogs for the 
Standard Class Size Table and the Standard Sieve Table.

Column [n] These options enable you to choose the type of data to 
display in your table. Click the corresponding Edit push 
button to choose and edit the variable.

Sort Order Choose whether you wish to have points collected in an 
ascending or descending order.

Truncate table at 
distribution limits

Select this option to have the table shortened to the limits of 
the distribution.
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Graphical Reports

There are 10 generic graphs included in the analysis software. These graphs can be tailored in 
many configurations using the graph options dialog displayed when you click Edit.

Data Plot
Difference from Reference
Out of Specification

From this group, choose the type of plot desired.

If you select Difference from Reference or Out of 
Specification, be sure to click the related push button on the 
Report Options dialog to choose the file(s).

Points
Curve
Histogram
Curve and Points

Enables you to choose the manner in which to have data 
plotted. 

X-Variable Enables you to choose the x-axis variable.

Y-Variable Enables you to choose the y-axis variable and the manner in 
which it is to be plotted; make a selection from each column.

The title bar displays 
the name of the graph 
being edited.
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Overlay Click on the down arrow to display the types of overlays 
available.

Samples Overlays the current curve with the same type of curve from 
multiple sample files. Click Overlays on the Report Options 
dialog to choose the sample file(s) containing the desired 
curves.

Tests Overlays the same type of curve from all tests performed 
with this file.

Plot Overlays a different variable with the selected variable (the 
one you are currently editing). Use the Edit button to specify 
details.

Edit Enabled when you choose Plot as the type of overlay 
allowing you to choose the overlay variable and specify 
details for the variable; the Overlay Settings dialog is 
displayed.

X Axis
Y Axis

Allows you to choose between a Linear or Logarithmic scale 
as well as autoscale options.
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Background Graph

Select Background to edit; the Background Options dialog is displayed.

Autoscale Select this option to have the X- and/or Y-axis scaled 
automatically. Both axes begin at zero; the highest values 
collected during analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges are 
displayed in the information bar when the field is selected.

No Overlays  Reports the background of this sample analysis only.

Overlay Samples Enables you to overlay the background of this sample 
analysis with the background(s) of other analyses. Click 
Overlays on the Report Options dialog to choose the sample 
file(s).

Overlay Current 
Background

Enables you to overlay the background of this sample 
analysis with the current stored background of the analyzer.
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Goodness of Fit Graph

Select Goodness of Fit Graph to edit; the Goodness of Fit Options dialog is displayed.

Rosin Rammler

The Rosin Rammler report depicts the collected data as applied to the Rosin Rammler1 
theory; this report cannot be edited.

Overlay Model Fit Overlays the collected intensity data of this sample with the 
model fit.

Overlay Tests Enables you to overlay the collected intensity data for all 
analyses (tests) used with this sample file.

Overlay Samples Enables you to overlay the collected intensity data of this 
sample with that of another sample (or multiple samples). 
Click Overlays on the Report Options dialog to choose the 
sample file(s).

X-Axis Enables you to specify the X-axis variable.

1 Rosin, P. and Rammler, E., J. Inst. Fuel, 7, 20 (1933)
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Log Probability Report

The Log Probability Report provides a comparison of the collected data to that of a log-
normal distribution; this report cannot be edited.

Summary Report

Select the Summary Report to edit; the Summary Report Options dialog is displayed.

The Summary Report provides a condensed listing of analysis statistics and data results.

Statistics 
Type/Distribution

Choose the type of statistics and distribution you wish to 
report.

Arithmetic Statistics Choose the arithmetic statistics you wish to include in the 
report.

Statistics Select the variables you wish to include in the report.

Sample Choose the sample parameters you wish to include in the 
report.
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Analysis Select the analysis parameters you wish to include in the 
report.

Reports Choose the type of distribution(s) you wish to report.

Percentiles Displays the Summary Percentiles dialog.

This dialog allows you to report the particle diameter (or 
radius) corresponding to each specified coarser (or finer) 
percentile. You can enter up to 10 values in any order. If you 
enter zero (0.00), a blank line is shown on the report.

Sizes Displays the Summary Sizes dialog.

This dialog allows you to report the cumulative percent (or 
fraction) coarse (or finer) for each specified diameter 
(volume). You can enter up to 10 values in any order. If you 
enter zero (0.00), a blank line is shown on the report.
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Sample Log Report

The Sample Log report provides the following statistics:

• manual control operations performed during analysis
• information entered using  on the sample file editor
• warnings and/or errors that occurred during analysis

Peaks Displays the Summary Peaks dialog.

This dialog enables you to specify the types of data to 
display in the columns of the peak table. Column 1 is fixed 
and cannot be edited.
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Collected/Entered Data

This dialog displays only when your option presentation is selected as Advanced. Depending 
on the type of data selected on the Sample Information screen, this dialog may display as Col-
lected Data or Entered Data.

Collected Data

Table Displays the data points collected for the current test. If this is 
a new file, the table will contain invalid data. 

Test Displays the current test for this sample file. If you wish to 
view data for another test, click on the down arrow to select 
the desired test. If this is a new file, this field is disabled.

Delete test Allows you to delete the test in the Test field if desired. This 
push button is disabled if this is a new file.

Merge with external 
data

Select this option to merge data collected by manual methods 
with the data collected from the current test. 
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External Data Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter the 
data you wish to have merged.

Insert Inserts a row so that you can enter pertinent data. 

Delete Deletes the selected row.

Clear Clears the entire table of all but the one required entry.

This type of table displays if you 
choose Sieve size for the size type.

These push buttons are disabled for the Sieve table. Sieve sizes are specified by 
selecting Options > Data presentation > Sieve table.

Size Type Allows you to choose the type of data you wish to merge.

Particle size allows you to enter the particle diameter as well 
as the cumulative percent for the sample. 

Sieve size allows you to enter the percent passed through 
each specified sieve.

Distribution type Specify the type of external data you plan to merge.
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Autoscale percent of 
total sample

When this option is selected, the overlapping regions of the 
collected data and the merged data are used to rescale the col-
lected data so that the regions match.

When this option is deselected, the percentages you enter for 
the merged data are used and the nonoverlapping portion of 
the collected data is scaled to be the percent passing through 
the smallest sieve.

Full scale mass percent Specify the weight percent of the sample actually analyzed by 
the Saturn analyzer versus the percent that is manually 
analyzed. The data are scaled accordingly.

Use this option if you analyzed part of the sample by another 
method but you do not wish to merge those results with the 
reports for the current test.

This field is disabled if Merge with external data is 
selected.

Distribution Type Enables you to choose the manner in which data are 
presented.
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Entered Data

You cannot enter data if the analysis program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.

Table Enter pertinent data.

Insert
Delete
Clear

The functions for these push buttons are the same as 
explained in the previous section.

Size Type Allows you to specify the type of size data.

Particle size allows you to enter the particle diameter as well 
as the cumulative percent for the sample. 

Sieve size allows you to enter the percent passed through 
each specified sieve.

Distribution Type Specify the type of data you wish to enter.

This type of table displays if you 
choose Sieve size for the size type.
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Save

Save enables you to save any changes you have made to the file in the active window. The file 
is saved under its current name.

Save As

Save As enables you to:

• save a sample or parameter file in the active window under a different name. This 
option is useful for making a duplicate copy of a file that you can modify as desired 
without changing the original one. The original file remains open when you use this 
function, so be sure to open the new file before making any changes.

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select Analysis Conditions from the Save As menu to cre-
ate a standalone parameter file of the analysis conditions portion of the active sample 
file.

When you select Save As, a dialog similar to the one shown below is displayed.

The status list 
is not shown 
for parameter 
files.
5-38                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Save All
Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

Close

Close enables you to close the file in the active window. You will be prompted to save before 
closing if the file contains changes that have not been saved.

Close All

Close All enables you to close all open files under their current names. You will be prompted 
to save before closing for each file containing changes that have not been saved.

File name Choose one of the following options:

• Enter a name of up to eight characters for the new file.

• Select a file from the Files list box. If you select an exist-
ing file as the new name, the data contained in that file are 
overwritten with the new data.

Status
Date Range
Files
Directories

Refer to Selecting Files, page 2-15 for an explanation of 
these items.

Status does not display for parameter files.
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Print

Print enables you to print the entire contents of a sample or parameter file. For example, if 
you choose to print the contents of an analysis conditions file, you will receive the parameters 
used for all analysis conditions associated with the file. The print dialog is common to all file 
types. The title bar will display the type of file you are printing.

File name The name of the file you select from the Files: list box is 
copied to this field.

Status
Date Range
Files
Directories

Refer to Selecting Files, page 2-15 for an explanation of 
these items.

Status does not display for parameter files.

Copies Enabled when Printer is selected as the print destination. 
You may print up to four copies.

The title bar displays 
the type of file you are 
printing.

Status list does not dis-
play for parameter files.
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Destination Contains a drop-down list of available print destinations.

If you select Screen or Printer, the requested file is sent to 
that specified destination

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text editor 
or other text file manipulation tool. You also must enter a 
name in the File name field.

File name Enabled when you select File as the destination. A default 
name is displayed in the field; a new one may be entered if 
desired.
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List

List enables you to generate a listing of the following information on a selected sample or 
parameter file:

• File name
• Date the file was created (or edited)
• Time the file was created (or edited)
• File identification
• File status

The List dialog is common to all file types. The title bar displays the type of file on which you 
have requested a list.

File name If you select only one file from the Files list, the name is 
copied to this field. If multiple files are selected, the last one 
selected displays in this field.

You can list statistics for multiple files by holding down Ctrl 
while making your selections. If no files are selected, a list is 
generated for all files listed in the Files window.

Status
Date Range
Files
Directories

Refer to Selecting Files, page 2-15 for an explanation of 
these items.

Status does not display for parameter files.

The title bar displays the 
type of file on which you 
are generating statistics.

Status list does not dis-
play for parameter files.
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Copies Enabled when Printer is selected. You may print up to four 
copies.

Destination Contains a drop-down list of available print destination.

Choices: Screen, Printer, File

File name Enabled when you select File as the destination. A default 
name is displayed in the field; a new one may be entered if 
desired.
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Export

Export allows you to copy the particle size distribution data or the intensity data in a sample 
information file and reformat it in ASCII format. The ASCII data can then be imported into 
other applications (such as spreadsheets) accepting ASCII format. The data are exported in a 
comma-delimited format. Refer to Appendix H, page H-1 for the exporting format. You may 
select multiple files by holding down Ctrl and clicking the left mouse button once on each file.

File name Contains the name of the file you select to export.

Status
Date Range
Files
Directories

Refer to Selecting Files, page 2-15 for an explanation of 
these items.

Export Type Drop-down list containing the types of data export available. 

Choose Particle Size to generate particle distribution data.

Choose Intensity to generate the light intensity vs. scattering 
angle data, as well as the background.

Copies Enabled when Printer is selected; you may print up to four 
copies.
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Destination Contains a drop-down list of the available print destinations.

Choices: Screen, Printer, File

File name Enabled when you select File as the destination. A default 
name is displayed in the field; a new one may be entered if 
desired.
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Exit

Exit enables you to exit the Saturn DigiSizer analysis program. Even if an analysis is in prog-
ress, it will continue until completion; analysis data are collected and stored in the analyzer’s 
memory.

• If a window containing a modified file is open, you are given the opportunity to save the 
modifications before exiting.

• If deconvolution (calculations) is in progress, the following message is displayed:

You cannot exit the DigiSizer program while a critical operation is in progress. Click 
OK to close the dialog, wait a few minutes, and try again.

• If an analysis is in progress, the following message is displayed:

Yes exits the analysis program
No allows the analysis program to remain active and the analysis to finish.

• If a report window is open, the following message is displayed.

Yes closes the report window and the analysis program.
No leaves the analysis program active and the report window open.

2458- An analyzer is performing a critical operation. Wait a few 
moments before exiting the application.

OK

2459- An instrument is busy. A delay in restarting this application 
could result in loss of new data. Continue with program exit?

Yes                               No

Although data are stored in the analyzer when you exit the program during analysis, 
they are not saved in the file until the program is restarted. At that time the data are 
saved automatically. If a power failure occurs in the interim and you do not have an 
Uninterruptible Power Supply (UPS) installed, loss of data will result.

If the MasterTech is being used, the current analysis continues until it is finished; 
subsequent analyses are postponed and resumed when the analysis program is 
restarted.

A report is currently printing. Exiting the application now 
will cancel the report. Continue with termination?

Yes                  No
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6.  UNIT MENU

The Unit menu contains the options for the operations which can be performed with the Saturn 
DigiSizer. The main menu will contain a Unit menu for each attached analyzer. For example, if 
you have two attached analyzers, the main menu contains two Unit menus. For convenience 
and quick recognition, the status displays associated with each unit are displayed in different 
colors. The unit number and the serial number also are displayed in the title bar of the opera-
tional windows. This feature is especially helpful when you have more than one analyzer 
attached to the same computer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 
later in this chapter.

This menu does not appear on the menu bar if the analysis program is being used for 
offline data manipulation.

Sample Analysis Use this mode of operation to perform single sample 
analyses. This option is disabled if analyses are being 
performed in another mode. Page 6-4.
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QuickStart Analysis Use this mode of operation to perform successive sample 
analyses.  Page 6-10.

MasterTech Automatic Use this mode of operation to analyze a series of samples of 
the same type with the same analysis conditions. Sample files 
are created automatically. Enabled only if a MasterTech is 
installed. Page 6-15.

MasterTech Schedule Use this mode of operation to analyze a series of samples 
which may be different in size and shape and, consequently, 
require different analysis conditions. Enabled only if a 
MasterTech is installed. Page 6-18.

Background Allows you to perform a background measurement.
 Page 6-22.

Load from MasterTech Allows you to load a sample from the MasterTech into the 
analyzer. Page 6-25.

Rinse Allows you to perform a rinse operation on the DigiSizer, 
MasterTech, or the MasterTech and the DigiSizer. Page 6-26.

Drain Allows you to drain liquid from the Saturn DigiSizer system. 
Page 6-31.

Initialize MasterTech Allows you to start the MasterTech or realign the MasterTech 
turntable. Page 6-31.

Enable Manual Control Allows you to control the system manually. Page 6-32.

Show Instrument 
Schematic

Displays a schematic of the analyzer. Page 6-40.

Show Results Allows you to have results displayed as data are collected 
when performing multiple analyses. Page 6-41.

Show Status Displays the status window of the operation in progress. 
Page 6-41.
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Show Instrument Log Displays a log of recent analyses, calibrations, and error 
messages. Page 6-42.

Unit Configuration Displays the configuration of the analyzer. Page 6-44.

Calibration Enables you to perform calibration functions. This option is 
enabled only with the direction of a Micromeritics service 
representative. Page 6-46

Service Test Enables you to perform certain troubleshooting procedures. 
This option is enabled only with the direction of a 
Micromeritics service representative. Page 6-46
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Sample Analysis

Use this mode of operation to perform up to eight tests (analyses) on a single sample. When 
you select this option from the Unit menu, the Sample Analysis dialog is displayed with all 
fields disabled (greyed out) and the Unit [n] Start Analysis dialog positioned on top. This 
allows you to select an existing sample file for your analysis or to create a new one. 

After a sample file has been designated, the Sample Analysis dialog is displayed. The fields 
now contain the values for the selected file or, if creating a new file, the specified defaults. Use 
the Sample Analysis dialog to edit sample parameters. 

View Allows you to view one of the following in the current 
window:

• the current operation 

• the instrument schematic (refer to Show Instrument Sche-
matic, page 6-40 for additional information)

• the instrument log (refer to Show Instrument Log, page 
6-42 for additional information)

• two selected report pages from the most recently analyzed 
sample

Browse Displays the Open Sample Information dialog allowing you 
to select a different sample file for your analysis.
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Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file 
description based on the format you specified in Sample 
defaults. 

You can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters

Analysis Conditions Contains the name of the Analysis Conditions file for the 
current sample file. 

If this is a new file, this field contains the Analysis 
Conditions file you specified as the default.

The drop-down list contains a list of predefined analysis 
conditions files, some of which were included with the 
analysis program.

• Click on the down arrow to choose a different file.

• This list is disabled if the file you selected has been used in 
an analysis.

Autodilute Allows monitoring of the sample’s concentration and adds 
liquid as needed until the appropriate concentration is 
attained before analysis and data collection begin.

Number of tests Enter the number of analyses you wish to perform using this 
sample file; you can perform up to eight tests with each file.

Rinse after analysis Allows rinsing of the cell, the tubing, and the reservoir after 
each analysis. We recommend this option remain selected. If 
you deselect this option and rinses are not performed after 
analysis, inaccurate results may be obtained on subsequent 
analyses.
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Material Properties
Sample
Liquid

Displays the type of sample and dispersing liquid associated 
with the analysis conditions file you selected from the 
Analysis Conditions drop-down list. 

If this is a new file, these fields display the specified defaults.

Click on the down arrow(s) to choose a different Particle 
(sample) or dispersing liquid.

If your sample material or dispersing liquid is not included in 
the list, you will have to cancel the current operation and 
open the sample information file in the Advanced format to 
add it (see Material Properties, page 5-15).

Report Options Contains the name of the Report Options file for the current 
sample file. 

If this is a new file, this field contains the Report Options file 
you specified as the default.

The drop-down list contains a list of predefined report 
options files, some of which were included with the analysis 
program.

Click on the down arrow to choose a different file.

Reports to Generate Displays a list of available reports. To select a report: 
Double-click on the desired report, or highlight the report and 
press the Spacebar. Selected reports are preceded with a 
check mark (). Reports are deselected in the same manner.

Report after analysis Displays the Report Settings dialog so that you can specify 
report output requirements.

Select the option presented on this dialog to have reports 
generated automatically after each analysis. 
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Select Next on this window to save selections and advance to the next view of the Sample 
Analysis dialog.

This view of the window shows beam obscuration of the sample as it is being loaded. Add 
only enough sample to achieve the proper range for your material, using the following 
guidelines:

Number of Reports Enter the number of reports you wish to have printed. You 
can print up to four copies when Printer is selected as the 
destination.

Destination This drop-down list presents four print destinations:

Choices: Screen, Printer, File

File name Enabled when File is selected as the destination, allowing 
you to enter a name (or accept the default).

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%
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These push buttons are also used to adjust the beam obscuration to the appropriate range for 
your sample as it is being added to the reservoir:

• If the beam obscuration is too high (indicating high concentration), use Adjust level to 
full or Adjust level to primed to add liquid. Do not try to adjust a high obscuration if 
you have chosen Autodilute. The Saturn DigiSizer system will adjust the concentration 
automatically until the correct beam obscuration is achieved.

• If the beam obscuration is too low (indicating low concentration), continue to add 
sample. If the reservoir is too full, you can use any of these push buttons to adjust the 
liquid level to allow room for added sample.

When the concentration is in the recommended range, select Next to begin data collection. A 
status view of the Sample Analysis window is then displayed.

This view of the window displays:

• the identification of the sample file
• an estimated time remaining on the analysis
• the current test number
• the current beam angle

A more specific status of the sample is shown in the status area at the bottom of the window. 
After each test requested of the sample file is complete, data reduction for the test begins; 
simultaneously, the next test begins. 

The next view of the window contains the results of the current test. 

Adjust level to full Allows you to fill the reservoir with analysis liquid. 

Adjust level to primed Allows you to add enough analysis liquid to reach a primed 
state.

Adjust level to empty Empties the reservoir of analysis liquid.

Refer to Appendix B, page B-1 for additional information on sample dispersion and 
sample concentration.
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The results window contains two panes. Each pane has a drop-down list (positioned just above 
the pane) containing the report options specified in the sample file.

In these panes, you can:

• Show results 
Select a report from the drop-down list to display its results in the pane. Scroll bars are 
provided in panes where tables are displayed so that you can scroll through the data.

• Resize the pane
Point to the center vertical border (separating the panes); when the cursor turns into a 
four-way arrow, drag the border in the direction desired.

• Edit tables and graphs
Right-click in the graph (or table) to display a list of editing options. These options are 
explained in detail in Shortcut Menus, page 7-23.
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QuickStart

Use this mode of operation to analyze a series of samples of the same type which contain the 
same analysis conditions. You can request to have sample files created automatically or you 
can choose a sample file for each sample. When you select this option from the Unit menu, the 
QuickStart dialog is displayed.

Set liquid level 
between analyses

Allows you to adjust the liquid level in the reservoir before 
the sample is loaded.

Choices: Adjust to full level, Adjust to primed level, 
 Adjust to empty level

Adjust to full level fills the reservoir with the dispersing 
liquid. Choose this level for undispersed, powdered samples; 
if a maximum amount of liquid is desired; or if bubble 
problems are anticipated.

Adjust to primed level fills the reservoir with just enough 
dispersant to enable circulation. Choose this level for highly 
concentrated samples.

Adjust to empty level empties the reservoir of all dispersant, 
allowing you to pour a previously dispersed sample into the 
reservoir. Choose this level for samples already at the proper 
concentration.
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Report after analysis Allows you to have a report(s) generated automatically after 
each analysis.

Copies Enter the number of reports you wish to have printed. You 
can print up to four copies when Printer is selected as the 
destination.

Destination This drop-down list presents four print destinations:

Choices: Screen, Printer, File

File name Enabled when File is selected as the destination, allowing 
you to enter a name (or accept the default).

Sample Contains the default identification string specified in sample 
defaults; you can enter a new name if desired. Be sure to 
include the $ symbol if you wish to have the sample file 
number included as part of the description.

File management Presents two choices for creating file names:

Prompt for files for each new sample: the analyzer pauses 
before each analysis so that you can choose a sample file.

Autodetect each new sample: new files are created 
sequentially and automatically for each analysis. Numbering 
sequence is based on the specified default. The description 
sequence is also based on the default unless you specify a 
different string in the Sample field on this dialog.

If you use this method, be sure that Rinse after analysis is 
selected in Sample defaults. Otherwise, the previous sample 
will not be rinsed from the reservoir; however, the system 
will detect its presence and analyze it repeatedly.
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Select Next; a window indicating Adjusting liquid level is displayed. You can suspend or 
skip this procedure by selecting the respective push button. After the liquid has been adjusted, 
one of two screens is displayed (depending on which file management method you choose):

• If you choose Prompt for files for each new sample, this view of the QuickStart dialog 
is displayed before each analysis. 

Filename Displays the next sequenced file number as specified in 
sample defaults. Click Browse to select a different file.

Browse Displays a dialog so that you may select the sample file you 
wish to use with this analysis. If you do not choose a new file, 
specified defaults for all parameters will be used.

Sample ID Displays the description of the file you choose for the 
analysis. You can edit the description if desired.

Background Enables you to perform a background before proceeding with 
analysis. The background is performed using the analysis 
liquid and the flow rate specified in the sample defaults. 
When the background has finished, a report is generated (if 
selected on previous screen) and the current window is again 
displayed.
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After all selections have been made, begin adding your sample to the reservoir. Observe 
the beam obscuration of the sample as it is being added. When the concentration is in 
the recommended range for the type of sample you are analyzing (refer to the following 
guidelines), select Next to begin data collection. 

The beam obscuration range can also be manually entered using the Maximum and 
Minimum fields on the Analysis conditions dialog.

After all analyses have finished, click Cancel to close the dialog.

Adjust level to full
Adjust level to primed
Adjust level to empty

These push buttons allow you to adjust the beam obscuration 
to the appropriate range for your sample as it is being added 
to the reservoir:

• If the beam obscuration is too high (indicating high con-
centration), use Adjust level to full or Adjust level to 

primed to add liquid. Do not try to adjust a high obscura-
tion if you have chosen Autodilute. The Saturn DigiSizer 
system will adjust the concentration automatically until the 
correct beam obscuration is achieved.

• If the beam obscuration is too low (indicating low concen-
tration), continue to add sample. If the reservoir is too full, 
you can use any of these push buttons to adjust the liquid 
level to allow room for added sample.

Sample Type
(micrometers) Beam Obscuration

Less than 0.1 4%

0.1 to 1 5% to 10%

1 to 10 10% to 20% 

10 to 100 20% to 30%

100 to 1000 30% to 45%
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• If you choose Autodetect each new sample, this view of the QuickStart dialog is 
displayed:

After you add your sample to the reservoir, its presence is detected and the remainder of 
the analysis proceeds automatically. The obscuration must exceed the minimum recom-
mended obscuration on the Analysis conditions window for the analysis to start 
automatically. If you wish to use a lower obscuration, load the sample and click Skip to 
start the analysis. After the current sample is analyzed, this window is again displayed 
prompting you to add the next sample.

A Background push button is also provided on this dialog, allowing you to perform a 
background measurement between analyses. 

After all analyses have finished, click Cancel to close the dialog.

Regardless of which file management method you choose, a status view of the Sample Analy-
sis window is then displayed. This view of the window displays:

• the identification of the sample file
• an estimated time remaining on the analysis
• the current test number
• the location of the beam angle

A more specific status of the sample is shown in the status area at the bottom of the window. 
After each test requested of this sample file is complete, data reduction for the test begins; 
simultaneously, the next test begins. After all tests and rinses (if requested) are finished, the 
previous window is displayed.

Use these push buttons 
to adjust the sample 
concentration.
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MasterTech Automatic

Use this mode of operation to analyze a series of samples of the same type which contains the 
same analysis conditions; sample files are created automatically. When you select this option 
from the Unit menu, the MasterTech Automatic  dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Start with beaker Enter the position number of the beaker containing the first 
sample to be analyzed.

This field is disabled if an analysis is in progress.

Sample resuspension This group box is used to enter resuspension parameters. 

Samples tend to settle in the beaker while waiting for 
analysis, especially if samples are prepared ahead of time, as 
in most cases when using a MasterTech. The options in this 
group box allow you to program the MasterTech stirrer and 
probe to redisperse the sample before analysis.

All fields in this group box are disabled if an analysis is in 
progress.
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Stirrer time Enter the number of seconds you wish to have the stirrer 
operate during resuspension.

Stirrer speed Choose the stirrer speed. 

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time Enter how long to have the ultrasonic probe operate during 
resuspension.

Report Settings This group box is used to designate report output.

These options are disabled if analyses are in progress.

Report after analysis Select to have a report generated automatically after each 
analysis.

Number of Reports Enter the number of reports you wish to have printed. You 
can print up to four copies when you select Printer as the 
destination.

Destination This drop-down list presents four print destinations:

Choices: Screen, Printer, File

File name Enabled when File is selected as the destination; enter a name 
(or accept the default).

Sample Contains the default identification string specified in sample 
defaults; you can enter a new name if desired. Be sure to 
include the $ symbol if you wish to have the sample file 
number included as part of the description.

You can also include the beaker number containing the 
sample in the sample identification by entering the number 
symbol (#) within the name you specify. For example, 
Sample in beaker #.

Start Begins the analysis. This push button changes to  after 
analysis begins which (if clicked) will stop the analysis.
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This window contains separate status windows for the DigiSizer and the MasterTech. Each 
status window contains its own Skip and Suspend push buttons allowing you to perform 
either or both of these actions on the DigiSizer, the MasterTech, or both. Also displayed just 
above the status window for the analyzer is the progress of the analysis.

Cancel Displays a dialog allowing you to choose which operation(s) 
you wish to cancel. Disabled options indicate that an 
operation of that type is not in progress and, therefore, cannot 
be canceled.

Cancel the MasterTech preparation cancels the  sample 
currently being prepared by the MasterTech as well as all 
subsequent samples. It does not cancel any analysis that may 
be in progress.

Cancel the MasterTech load operation cancels the loading 
of the next sample as well as all subsequent samples. It does 
not cancel any analysis that may be in progress.

Cancel the analysis cancels the current analysis only; you 
may continue with other analyses if desired.

Close Closes the dialog. This push button is disabled if an 
automatic operation is in progress.
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MasterTech Schedule

Use this mode of operation to: 

• Analyze a series of samples which may be different in size and shape and, consequently, 
require different analysis conditions

• Analyze samples and measure a background alternately

When you select this option from the Unit menu, the MasterTech Schedule is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Insert Displays the MasterTech Schedule Insert dialog so that you 
can select the sample files you wish to use for scheduled 
analyses.
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If you have a sample file selected in the Sample File window, 
the new file is inserted before the selected file; otherwise it is 
inserted at the end of the list.

Background 
measurement

Inserts a background measurement.

Select the liquid you wish to use from the Liquid drop-down 
list. Then enter a value in the Flow rate field; typically, 6 is 
sufficient. 

Sample analysis Allows you to schedule a sample analysis.

Beaker number
Enter the beaker number containing the sample.

Sample file
Displays the description of the selected sample file. Click 
Browse  to choose the sample file.

Stirrer time
Enter the number of seconds to have the stirrer operate during 
resuspension.

Stirrer speed 
Choose the stirrer speed.

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time
Enter how long you wish to have the ultrasonic probe operate 
during resuspension. 
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Edit Displays the MasterTech Schedule Edit dialog so that you 
can edit the sample file or dispersion conditions. 

This dialog is identical to the MasterTech Schedule Insert 
dialog explained on page 6-19. 

Delete Removes the selected item from the list. This push button is 
disabled if nothing is selected.

Clear Removes all of the files listed in the window. The files do not 
have to be selected.

Report Settings Allows you to choose report output options. When you click 
on this push button, the Report Settings dialog is displayed.

Report After 
Analysis

Select to have a report generated automatically after each 
analysis.

Number of 
Reports

Enter the number of reports you wish to have printed. You 
can print up to four copies when you select Printer as the 
destination.

Destination This drop-down list presents four print destinations:

Choices: Screen, Printer, File

File name Enabled when File is selected as the destination; enter a name 
(or accept the default).
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This window contains separate status windows for the DigiSizer and the MasterTech. Each 
window contains its own Skip and Suspend push buttons allowing you to perform either or 
both of these actions on the DigiSizer, the MasterTech, or both. Also displayed just above the 
status window for the analyzer is the progress of the analysis.

Cancel Displays a dialog allowing you to choose which operation(s) 
you wish to cancel. Disabled options indicate that an 
operation of that type is not in progress and, therefore, cannot 
be canceled.

Cancel the MasterTech preparation cancels the  sample 
currently being prepared by the MasterTech as well as all 
subsequent samples. It does not cancel any analysis that may 
be in progress.

Cancel the MasterTech load operation cancels the loading 
of the next sample as well as all subsequent samples. It does 
not cancel any analysis that may be in progress.

Cancel the analysis cancels the current analysis only; other 
scheduled operations will continue.

Close Closes the dialog. This push button is disabled if an 
automatic operation is in progress.
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Background

Before you can perform an analysis, you must have a background measurement for data col-
lection. It is not necessary to measure a background for each analysis. Micromeritics 
recommends that you perform a background measurement at the change of each shift or if you 
change dispersing agents. You may perform up to eight measurements; however, you can save 
and use only the last one. Refer to Appendix H, page H-1 for a discussion and illustrations on 
background quality.

When you select Unit > Background, the Background Measurement dialog is displayed. 

Current background data Displays the following information for the last background 
measured for this unit:

• the analysis liquid and its refractive index
• the date and time of the last background

Analysis liquid Displays a list of analysis liquids. Select the liquid you wish 
to use for the measurement; its properties are displayed 
automatically in the fields to the right of the list. You can also 
add new liquids to the list using the Add push button 
(described below).

Description Displays the name of the selected analysis liquid. This field is 
also used to add new liquids to the list.

Refractive Index
Viscosity
Density

Display the properties of the selected analysis liquid. These 
fields are also used to enter properties of an analysis liquid 
that you wish to add to the list.
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Select Next on this dialog to display the next window for the Background Measurement. This 
view allows you to enter the flow rate for the measurement and specify report output options.

Add Adds a new analysis liquid to the list. 

Enter the name of the liquid you wish to add in the 
Description field, its properties in the Refractive Index, 
Viscosity, and Density fields; then click Add. 

Delete Deletes the selected analysis liquid from the list.

Analysis Liquid Displays the liquid being used for the background 
measurement.

Set flow rate Select to enter the flow rate; typically, 6 liters per minute is 
sufficient.

Flow rate Enter the desired flow rate; disabled if Set flow rate is not 
selected.

Report after 
measurement

Select to have a report generated automatically after each 
measurement.

Copies Enter the number of reports you wish to have printed. You 
can print up to four copies when you select Printer as the 
destination.
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Click Next to begin the background measurement; a status view of the Background Measure-
ment window is then displayed. This view of the window displays:

• the analysis liquid being used for the background measurement
• an estimated time remaining on the measurement
• the current beam angle

The status window at the bottom of the dialog shows a more specific status. After the back-
ground measurement is finished, the completed background measurement is displayed.

Destination This drop-down list presents four print destinations:

Choices: Screen, Printer, File

Graphical data cannot be generated to a File. If you wish to 
have a printout of the background graph, print to the screen 
and then copy as a metafile.

File name Not applicable to background measurements.

Repeat Select to perform another measurement. This push button 
becomes disabled after eight measurements. Refer to 
Appendix H, page H-1 for information on determining a 
suitable background.

Done Saves the last measured background and closes the dialog.
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Load from MasterTech

This option allows you to manually redisperse a sample then transfer it to the DigiSizer for 
analysis.  The MasterTech Load dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

Beaker number Enter the position number of the beaker containing the 
sample you wish to load.

Range: 1 to 18

Stirrer time Enter the number of seconds to have the stirrer operate during 
resuspension.

Stirrer speed Choose the stirrer speed. 

Coarse materials and less-stable dispersions may require 
more high-speed stirring time than finer materials.

Probe time Enter how long you wish to have the ultrasonic probe operate 
during resuspension. 

Coarse materials and less-stable dispersions may require 
more stirring time than finer materials.

Start Begins the load operation; a message is displayed indicating 
a load operation is in progress. After the sample has been 
loaded, the dialog closes.

Cancel Cancels the load operation and closes the dialog.
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Rinse

A rinse operation should be performed to rinse away any contaminants from the analysis cell, 
reservoir, and tubing which may have remained from a previous analysis.

When you select Unit [n] > Rinse, three choices are available:

• DigiSizer - rinses the analysis cell, reservoir, and tubing of the DigiSizer.

• MasterTech - rinses the MasterTech tubing. Disabled if a MasterTech is not connected 
to the DigiSizer.

• MasterTech Then DigiSizer - rinses the MasterTech tubing, then the analysis cell, 
reservoir, and tubing of the DigiSizer. Disabled if a MasterTech is not connected to the 
DigiSizer.

DigiSizer

This option is disabled if analyses are in progress.

Rinse Cycles Select Autorinse to have the system determine how many 
rinses to perform in order to reach a beam obscuration of 0.1 
or less. 

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message. (Appendix A 
lists actions for the displayed error message.)

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed. (Appen-
dix A lists actions for the displayed error message.)
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Rinse Cycles

(continued)

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. (Appendix A lists actions for 
the displayed error message.) If the beam obscuration is 
less than 1.0, it is assumed to be due to the difference in 
liquids and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. (Appendix A lists actions for the displayed 
error message.)

Select Rinses to specify an exact number of rinses to 
perform.

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.

Cancel Cancels the rinse operation and closes the dialog.
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MasterTech

This option is functional only if you have a MasterTech connected to your analyzer.

Beaker number Enter the position number of the beaker you wish to rinse 
into. Be sure the beaker contains a small amount 
(approximately 10 mL) of liquid; otherwise, its presence may 
not be detected by the MasterTech. 

Range: 1 to 18

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.
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MasterTech Then DigiSizer

Select MasterTech then DigiSizer; the MasterTech Then DigiSizer Rinse dialog is displayed.

This option is functional only if you have a MasterTech connected to your analyzer.

MasterTech Group Box Enter the position number of the beaker you wish to rinse 
into. Be sure the beaker contains a small amount 
(approximately 10 mL) of liquid; otherwise, its presence may 
not be detected by the MasterTech. 

DigiSizer Group Box Select Autorinse to have the system determine how many 
rinses to perform in order to reach a beam obscuration of 0.1 
or less.

If your analysis and rinse liquids are the same, rinsing 
stops when:

• No significant decrease in beam obscuration is attained 
twice in a row, displaying an error message.

• The system has performed 10 rinses and was unable to 
attain 0.1 or less; an error message is displayed.
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DigiSizer Group Box

(continued)

If your analysis and rinse liquids are different, rinsing 
stops when:

• Successive rinses show no significant decrease in beam 
obscuration. If the beam obscuration is greater than 1.0, an 
error message is displayed. If the beam obscuration is less 
than 1.0, it is assumed to be due to the difference in liquids 
and operation continues.

• The system has performed 10 rinses and was unable to 
attain a beam obscuration of less than 0.1, displaying an 
error message. 

Select Rinses to specify an exact number of rinses to 
perform.

Start Begins the rinse operation; a message is displayed indicating 
a rinse operation is in progress. When rinsing is complete, the 
dialog closes.

Cancel Cancels the rinse operation and closes the dialog.
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Drain

Select this option to drain the Saturn DigiSizer system of all liquid. This operation must be 
performed before the sample cell can be removed; otherwise, the sample compartment will be 
flooded with liquid. This operation also moves the rotation arm out of the way so that the sam-
ple cell is accessed easily.

Initialize MasterTech

Select this option to align the MasterTech tray or if you wish to perform manual operations 
with the MasterTech. When the MasterTech is initialized, the tray is aligned so that beaker #1 
is in the starting position.

Start Begins the draining process; when all liquid has been 
drained from the system, the dialog closes automatically.

Start Begins initialization; when initialization is complete, the 
dialog closes automatically.
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Enable Manual Control

Select this option to control your system manually. If the instrument schematic is not dis-
played, select Show Instrument Schematic. This illustration shows a schematic of the 
DigiSizer with the standard liquid sample handler installed. 

When you enable manual control, the symbols for valves and pumps change color on the 
screen to indicate manual operation. 

*The analysis pump displays as light green when operating at high speed, and dark green when 
   operating at low speed.

Use the mouse pointer or the Tab key to select schematic components.  A component is 
selected when it is surrounded by a dotted line.

Each component that can be manually controlled has a shortcut menu displaying the opera-
tions available for that particular component. These menus may be accessed by right-clicking 
on the desired component, or by using the shortcut keys, Shift + F9.

You can turn pumps on and off, as well as open and close valves by using one of the following 
methods:

• access the shortcut menu and select the appropriate action
• double-click on the pump (or valve) symbol
• select the pump (or valve) symbol and press the Spacebar

• Valves: Closed = Yellow Open = Green
• Pumps: Off = Yellow On = Green *

Displayed when a MasterTech is installed.

Displayed when 
an ultrasonic 
probe is 
installed.
6-32                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Enable Manual Control
Circulating pump Pumps the sample and dispersing liquid through the analysis 
system. The direction of the flow of liquid is fixed as 
indicated by the arrow just above the pump.

Colors: Green = On
Yellow = Off

Actions: On, Off, Set Speed

The speed at which the pump is operating is displayed to the 
left of the pump symbol. To specify a different speed, select 
Set speed; the Pump Speed Setting dialog is displayed:

Rinse pump Pumps the rinse liquid into the reservoir. The direction flow 
of the liquid is fixed as indicated by the arrow just above the 
pump.

Colors: Green = On
Yellow = Off

Actions: On, Off

If your DigiSizer has the Low-volume liquid sample handler 
installed, the rinse pump does not display. The Low-volume 
liquid sample handler uses the analysis liquid for the rinsing 
operation.

Analysis liquid pump Pumps analysis liquid into the reservoir.

Colors: Green (light) = On at high speed
Green (dark) = On at low speed
Yellow = Off

Actions: High, Low, Off

On Off

On Off

On Off
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Waste Valve When open, allows the sample and analysis liquid to be 
flushed from the system.

Colors: Green = Open
Yellow = Closed

Actions: Open, Close

Liquid level sensor Detects the liquid level of the associated component. Two 
sensors are located on the reservoir, one for the primed level 
and one for the full level. One sensor is located on the Waste 
valve.

Colors: Blue = Liquid sensed
Gray = No liquid sensed

Actions: None available; display component only

Reservoir Holds the dispersed sample. 

The temperature of the dispersion liquid is displayed to the 
left of the reservoir.

The reservoir has two liquid level sensors; one for the primed 
level and one for the full level.

Open Closed

Sensors

Standard Reservoir

Low-Volume Reservoir

Sensors

Dispersion Liquid 
Temperature
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Ultrasonic 
Probe

Typically, an optional ultrasonic probe is installed to 
maintain sample dispersion. The percentage of power being 
generated is shown to the left of the probe.

Colors: Green = On
Yellow = Off

Actions: Probe On, Probe Off, Set Probe Intensity

Colors are not displayed and actions are unavailable if an 
ultrasonic probe is not installed.

Select Set probe intensity to edit the ultrasonic power; the 
Ultrasonic Intensity Setting dialog is displayed.

Laser assembly The exposure parameters, drive current, pulse time, and 
number of pulses are displayed to the left of the laser 
assembly. The light dose for the photodiode is shown directly 
below the photodiode.

Colors: Laser Assembly
Yellow = Manual control enabled
Green = Exposure in process
Red = Laser is on

Photodiode
Grey = Idle
Blue = Exposure in process

Actions: Filter In, Filter Out, Expose, 
Stop Exposure, Display

Error conditions associated with the laser assembly are 
displayed on the schematic in red with yellow text. Appendix 
A provides causes and actions for these error messages.

The filter controls the light coming from the laser. Select 
Filter in to have the laser intensity absorbed by a factor of 
approximately 7,200.

The probe is displayed in this 
position when using the stan-
dard sample handler.

The probe is displayed in this 
position when using the low-
volume sample handler.

Filter in position

Filter out of position

Photodiode
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Laser assembly

(continued)

Select Expose to specify detector exposure values; the 
Detector Expose dialog is displayed.

Continuous scan allows successive exposures to be taken 
using the same conditions.

Stop Exposure stops the continuous scan as well as any 
exposure that may be in progress.

Display displays the Detector Display dialog allowing you to 
select a format in which to view an image of the raw data.

Choose Image to view the data in a bitmap format and 3D 
plot to view the data in a 3-dimensional format. If you choose 
both options, two windows are opened. After you click OK, a 
Display window is shown. All subsequent exposures will be 
shown in the windows.

Each time an exposure is taken, it is displayed in the window 
as long as the window remains open. This window contains 
six push buttons:

Snap
Makes a duplicate copy of the entire window and its contents. 
The duplicate copy does not contain a  push button and does 
not get updated with future images.

Print
Prints the contents of the window to the specified printer.

Copy
Copies the contents of the window to the clipboard.
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Laser assembly

(continued)

Save
Saves the image to an IMG file for future retrieval.

Load
Loads a previously saved image (IMG file) into the window.

Close
Closes the display window.

Rotation arm The arm position is displayed in degrees and steps  above the 
component image.

Colors: None

Actions: Move, Set Reference Angle

Select Move to change the arm position; the Rotation Move 
dialog is displayed.

Angle Move to moves the arm to the specified beam angle.

Steps Move moves the arm the specified number of steps 
from the current position. There are approximately 78,507 
steps per degree.

Select Set Reference Angle to specify the current position of 
the rotation arm; the Reference Angle dialog is displayed.
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CCD and beam 
photodiode

The light dose of the last exposure is displayed directly above 
the component image.

Colors: Grey = No exposure in process
Blue = Exposure in process

Actions: None available; display component only

Error messages are displayed in red with yellow text. Refer to 
Appendix A for causes and actions.

MasterTech pump Displayed only when a MasterTech is installed. Flow 
direction is indicated by the direction of the arrows between 
the rollers and the one above the pump.

Colors: Green = On
Yellow = Off

Actions: On, Off, Flow Direction Rinse,
Flow Direction Load

Flow Direction Rinse pumps the rinse liquid to the 
MasterTech to rinse the MasterTech tubing of any sample 
which may have remained from a previous analysis.

Flow Direction Load sends the sample to the Saturn 
DigiSizer analyzer for analysis.

MasterTech arm Displayed when a beaker is in position.

Colors: Arm
Yellow = manual control enabled

Probe
Green = On
Black = Off

Stirrer
Black = Off
Green = On, low speed
Blue = On, high speed

Load Rinse
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MasterTech arm

(continued)

Actions: Move Arm Up, Move Arm Down
Ultrasonic On, Ultrasonic Off
Stirrer on, Stirrer off
Stirrer Speed Fast, Stirrer Speed Slow
Move to Beaker
Initialize
Self Test

Move to Beaker allows you to specify the position of the 
beaker to which you wish to move the arm.

Initialize aligns the MasterTech tray so that Beaker #1 is in 
the starting position.

Self Test verifies that all components of the MasterTech are 
working properly.
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Show Instrument Schematic

Select this option to display a schematic of the Saturn DigiSizer. Refer to the previous section 
for an explanation of the components displayed on the instrument schematic.

Displayed when 
an ultrasonic 
probe is installed.

Displayed when a MasterTech is installed

Displayed when 
an ultrasonic 
probe is installed.

Schematic of Saturn DigiSizer with the Standard liquid sample handler 
installed.

Schematic of Saturn DigiSizer with the Low-volume liquid sample handler 
installed.
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Even when manual control is not enabled, you still can determine the state of the valves and 
pumps by color.

If you wish to change the state of a valve or pump, you must enable manual control.

Show Results

Choose this option to have results displayed as data are collected for multiple analyses.

Show Status

A status window is shown across the bottom of all operational dialogs. The Show Status 
option enables you to show only the status window of the operational dialog. If you have a 
MasterTech installed, its status is also included.

You may wish to use this option if:

• You have an automatic operation in progress and you decide to edit a sample file, for 
example. This way, you can monitor the status of your operation while performing 
another task.

• You have two units attached to your computer. You can select Show Status on each 
unit menu and have the status for all units displayed at one time.

• Valves: Closed = White Open = Green
• Pumps: Off = White On = Green *

If you have two instruments attached to your computer, the status bar for each 
instrument is displayed in a different color.

Displays when a MasterTech 
is attached to the analyzer.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. By default, this infor-
mation is logged for a 7-day period for analyses and a 30-day period for messages and 
calibrations. You may change the time for which this information is retained in the Unit sec-
tion of the WIN5205.INI file.

You can choose what you wish to display in the window by selecting only the desired item(s). 
For example, select only the Calibration check box to display only calibration information.

Analysis
Calibration
Messages

These options allow you to choose which entries are 
displayed in the window.

Add Log Entry Enables you to make an entry in the instrument log that 
cannot be recorded automatically through the application 
software. For example, you may change the port filter. The 
field adjacent to the push button allows you to enter the 
operation; the push button is enabled when you make an 
entry in the field, allowing you to add the entry.

Report Allows you to generate the log contents to a specified 
destination; the Log Report Settings dialog is displayed.
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Report

(continued)

Use the Start Date field to specify the date at which to start 
the printout. You can specify a date using one of the follow-
ing methods:

• Highlight the field (or press F2) to clear the field and type 
in the desired date.

• Double-click in the field (or press F4) to display a calendar 
to choose a date.

• Press F3 to insert the current date.

Enter the number of copies desired in the Copies field; you 
may print up to four. This field is disabled if you are printing 
to a File or to the Screen.

Choose the report destination from the drop-down list in the 
Destination field. 

If you choose File, the File name field is enabled, allowing 
you to enter a name for the printed file (or you may accept the 
default).
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Unit Configuration

Select this option to display the software/hardware configurations for the Saturn DigiSizer 
system. When you select Unit Configuration from the Unit menu, the Unit Configuration dia-
log is displayed.

Software Versions Displays the software versions being used by the analyzer.

Calibration Displays calibration dates. 

Configuration Displays the analyzer’s serial number and the IP address.

Board ID Displays the Board ID dialog so that you can view the 
statistics of the board contained in the requested slot of the 
computer.
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Change Displays the Unit IP Setup dialog, 

This dialog shows the IP address and Subnet mask that were 
assigned during installation. Do not edit these fields unless 
directed by a Micromeritics service representative.

Sample Handling Unit Displays the type of sampling unit being used, its serial 
number, software versions, and installed options. This group 
box also lets you know if your analysis liquid and dispersing 
liquid are the same or different.

Config Displays the LSHU configuration options dialog so that you 
can specify whether the rinse and analysis liquids are to be 
the same or different.

The options on this dialog enable you to specify when the 
rinse and analysis liquids are to be different, and the 
minimum liquid level for analysis. Typically, Automatic by 
Flow rate is sufficient for most analyses. This choice runs at 
a primed level for flow rates up to 12 L/minute.  

Auto Sampler Displays the type of autosampler being used (if any) and its 
software versions.
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Calibration

These calibrations, like the service tests, are enabled and performed only with the assistance of 
a trained Micromeritics service representative.

Service Test

Various service tests are included in the Saturn DigiSizer operating program. These tests can 
be enabled and performed only with the assistance of a trained Micromeritics service represen-
tative. These tests are designed to provide your service representative with instrument 
readouts, as well as to assist him in troubleshooting potential problems and, perhaps, eliminat-
ing unnecessary repair services. This service strategy allows you to conduct expert tests in less 
time than it would take to be trained in servicing the instrument properly.
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7.  REPORTS MENU

The Reports menu contains options which allow you to initiate and close reports for:

• Sample analyses
• Background information
• Statistical process control
• Historical particle size distribution

This chapter describes the options contained on the Reports menu, the type of reports avail-
able, and examples of some of the reports available.

Description

Listed below are brief descriptions of the options contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis. Page 7-3.

Close Reports Closes all open report window(s). Page 7-5.

Open Report Enables you to open a report that was saved from the report 
window. Page 7-5.

Background Initiates a report on the current background for the selected 
unit. Page 7-6.
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SPC Report Options Allows you to specify the sample data to be included in SPC 
reports.  Page 7-7.

Regression Report Allows you to generate a regression report. Page 7-10.

Control Chart Allows you to generate a control chart report. Page 7-13.

PSD History Allows you to generate a particle size distribution history 
report. Page 7-17.
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Start Report

Select this option to generate a report on a sample analysis; the Start Report dialog is 
displayed.

File name Displays the name of the file you select from the list. If you 
select multiple files, the last one selected is displayed. If you 
have a sample file open, its name defaults to this field.

• For multiple files, the reports specified in each sample file 
are printed to the output destination. 

• For a single file, the Selected Reports dialog containing the 
available reports is displayed. 

Check marks indicate 
a report is selected.
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File name

(continued)

This dialog allows you to confirm or edit the selection of the 
reports you wish to generate.

Select (or deselect) reports by double-clicking on the desired 
report (reports are selected when they are preceded with a 
check mark). Alternatively, you can highlight the report and 
press the Spacebar. 

Status This drop-down list determines the type of sample files 
displayed in the Files list.

Choices: All, Analyzing, Complete, Entered

Refer to Table 2-2. File Status and Description, page 2-16 
for a definition of the status types.

Date Range Use this push button to specify a range of dates in which to 
display sample files. Refer to Selecting Files, page 2-16 for a 
description of this push button.

Copies Enabled when the Printer destination is chosen, allowing  
you to print up to four copies of the selected reports.

Destination Displays a drop-down list of output destinations.

Choices: File, Printer, Screen

If you select Printer, requested reports are printed to the 
selected printer.

If you select Screen, many options are available for report 
manipulation. Refer to Onscreen Reports, page 7-20 for 
manipulation methods of onscreen reports.

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text editor 
or other text file manipulation tool. Graphical data cannot be 
generated to a File. 

File name Enabled when you select File as the destination, enabling you 
to enter a name, or you may accept the default.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select close on each report window. This option is unavailable if reports are being generated.

Open Report

This option enables you to open a report that was saved from the Report window; the Report 
window opens with an Open dialog positioned on top. 

After you navigate to the desired directory, select your file, and click Open, your report is dis-
played in the Report window.

Files list box Displays a list of the available sample files for the choice 
shown in the Status field and within the specified range of 
dates.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above 
the Directories list window. 

Report window
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Background

This option allows you to generate a report on an instrument’s background measurement. 
When you select Reports > Background, the Start Background Report dialog is displayed.

Instrument Displays a drop-down list of the attached instruments, 
allowing you to choose the instrument on which to have a 
background report generated.

Background date 
and time

Displays the date and time the current background was 
performed on the selected instrument.

Overlay Samples Choose this option to overlay the background for a sample 
(or multiple samples) with the current background. Click 
Samples to choose the desired file(s).

Copies Enabled when the Printer destination is chosen, allowing  
you to print up to four copies of the selected report.

Destination Displays a drop-down list of output destinations.

Choices: Screen, Printer, File

If you choose File, the File name field is enabled so that you 
can enter a name (or you can accept the default name).
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SPC Report Options

This option enables you to select the data that are to be reported in Regression and Control 
Chart reports. For efficiency, it is best to select only the variables you actually intend to use. 
All variables selected must be computed for each sample file used in an SPC report. These 
archived values are used in all future reports unless you have selected Recalculate archived 
SPC results on the individual report dialog.

When you select SPC Report Options, the SPC Report Options dialog is displayed.

Test This drop-down list contains analysis choices for  SPC 
calculations.

Last reports statistics for the last analysis performed.

First reports statistics for the first analysis performed.

Average reports an average based on all tests  in the 
selected sample file(s).

Statistics Type Allows you to choose the type of statistics for which the 
SPC variables are to be calculated.

Distribution Type Allows you to choose the type of distribution data for 
which the SPC variables are to be calculated.
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Arithmetic Statistics Allows you to choose the type of arithmetic statistics for 
which the SPC variables are to be calculated.

Statistics Displays a list of the variables available for SPC report-
ing; you may choose as many as you wish.

Sample Displays the Sample SPC Options dialog, allowing you 
to select the sample parameters you wish to have 
reported.

Specific parameters can be designated for the fields 
labeled Parameter [n]. Refer to Sample Defaults, page 
8-8 for additional information.

Analysis Displays the SPC Analysis Conditions Options dialog, 
allowing you to select the analysis conditions you wish to 
have reported.
7-8                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 SPC Report Options
Sizes Displays the SPC Size Options dialog, allowing you to 
specify up to 10 sizes and 3 distribution types at which 
the cumulative percent finer (or coarser, depending on 
the selection for data presentation) is to be reported.

Percentiles Displays the SPC Percentile Options dialog, allowing 
you to specify the percentiles and distribution types for 
which the cumulative percent finer (or coarser, depend-
ing on the selection for data presentation) is to be 
reported.

Peaks Allows you to choose the peaks to include in SPC calcu-
lations; you can include up to 10 peaks. 
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Regression Report

Select this option to generate a regression report. The regression report is used to determine 
the interdependency between two variables. Up to three dependent variables (Y-axis) may be 
plotted against a single independent variable (X-axis). The degree of correlation between the 
variables also is reported. The graphs for the regression report are scaled so that all three fit on 
a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Range: 40 characters. 

If you deselect this option, a report title will not be shown.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced meta-
file (emf).

Click Browse to choose the file; use the Height and Width 
fields to specify a size. This image can be edited in the report 
window (when printed to the screen), or removed if desired.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. Click 
on the down arrow to display a list of variables. The variables 
in this list are the ones you specified in SPC report options.

With this option, you may plot the regression of up to three 
Y-axis variables against the X-axis variable. The X-axis 
specifies the independent variable for the regression, while 
the Y-axes provide the dependent variables.

Axis Range Allows you to specify the beginning and ending values for 
the X- and Y-axis ranges. Data collected outside these ranges 
are not included in the plot. These fields are disabled if you 
choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled 
automatically. When scaled automatically, both axes begin at 
zero. The analysis program uses the highest values collected 
during analysis as the ending points.

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Label data Allows you to label the points on the plot to correspond with 
the values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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Samples

(continued)

Select Use all files in this Dir. to include all files from the 
selected directory in the Regression report.

• Select the file and click Add to move a file from the Files 
list to the Selected Files list. Alternatively, you can simply 
double-click on the desired file(s). You can select multiple 
files by holding down Ctrl while making your selections.

• You can choose up to 200 sample files. 

• Use Delete to delete a selected file from the Selected Files 
list and move it back to the Files: list.

• Use the Status drop-down list and/or Dates to limit the 
files displayed in the Files list.

Save as default Saves the current definition of the report as the default.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report; however, it will 
lengthen the time required to generate the report.

Copies Enabled when the Printer  destination is chosen. This option 
allows you to print up to four copies of the selected reports.

Destination Contains destination options for report output.

Choices: File, Printer, Screen

If you choose File, enter a name in the File name field. 
Remember, only tabular data can be generated to a file.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic. 

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Range: 40 characters. 

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced meta-
file (emf).

Click Browse to choose the file; use the Height and Width 
fields to specify a size. This image can be edited in the report 
window (when printed to the screen), or removed if desired.
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X-axis Order By Enables you to choose the order in which X-axis statistics 
are placed. You can have them placed by Time, File name, 
Date, Minutes, or Days.

Time places the files on the graph at numerical points in the 
order of the date/time the files are analyzed.

File name places the files on the graph at numerical points 
in alphanumeric order.

Date places the files on the graph at points representing the 
actual date/time the files are analyzed.

Minutes places the files on the graph at points representing 
the minutes that have elapsed from the first file placed on the 
list, which is the earliest-analyzed file.

Days places the files on the graph at points representing the 
number of days that have elapsed from the first file placed 
on the list, which is the earliest-analyzed file.

Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected on 
the SPC Report Options dialog. The variable you choose will 
be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If you 
wish to specify a range, deselect this option and enter ranges 
in the From and To fields.
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Center Line Displays placement options for the variable’s optional value. 
Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation () or at specified positions (Entered).

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values recomputed. 
This ensures that any changes made to the SPC Report 
Options are included in the new report. It also lengthens the 
time required to generate the report.

Samples Displays the Control Chart Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report. 

This dialog functions in the same manner as the Regression 
Report Sample Selection dialog (refer to Regression Report, 
page 7-10). 
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Summary Statistics Allows you to select the statistics to display in the report.

Coefficient of Variation is the Standard Deviation
divided by the Mean.

Confidence Interval of the mean value (shown on the same 
line below the graph on the report). When you select this 
option, the Confidence Level field is enabled allowing you 
to enter the percentage.

Select Number of Samples to have the number of samples 
analyzed included in the report.

Save as default Saves the current definition of the report as the default.

Copies Enabled when the Printer is chosen. This option allows you 
to print up to four copies of the selected reports.

Destination Contains destination options for report output.

Choices: File, Printer, Screen

If you choose File, enter a name in the File name field. 
Remember, only tabular data can be generated to a file.

Report Generates the report.
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PSD History

This option enables you to report a sequence of full particle size distribution graphs.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title.

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced meta-
file (emf).

Click Browse to choose the file; use the Height and Width 
fields to specify a size. This image can be edited in the report 
window (when printed to the screen), or removed if desired.

X-xis Order By Enables you to choose the order in which X-axis statistics are 
placed. You can have them placed by Time, File name, 
Date, Minutes, or Days. Refer to page 7-14 for explanation 
of these options.
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Samples Displays the PSD History Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report. 

This dialog functions in the same manner as the Regression 
Report Sample Selection dialog (refer to Regression Report, 
page 7-10).

Save as default Saves the current definition of the report as the default.

Copies Enabled when the Printer  destination is chosen. This option 
allows you to print up to four copies of the selected reports.

Destination Contains destination options for report output.

Choices: File, Printer, Screen

If you choose File, enter a name in the File name field. 
Remember, only tabular data can be generated to a file.

Report Generates the report.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as date and 
time of analysis, analysis conditions, background data, and so forth.

Headers also contain notes of any changes to the sample file which occur after analysis.

• Summary report headers contain the same type of information displayed in tabular and 
graphical reports with the exception of notes.

• SPC report headers display the current date as well as the range of dates of the samples 
you select to have reported. 

Software version of DigiSizer used for analysis. Analyzer serial number.

Current version 
of DigiSizer 
software.
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Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• shortcut menus
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.

Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.

Tabs display for each type of report you choose to generate.

List of reports 
requested.

Options on 
Tool bar.

Displays 
graphical 
(or tabular) 
data.

Header
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Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed. 

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog. 

For convenience in selecting reports to print, push buttons are 
provided beneath the report window. Or, you can make your 
selection by clicking on the desired reports.  

Current
selects the report displayed in the report window.

Shown
selects only the shown reports; any unlighted reports indicate 
they are hidden. You can still select hidden reports from this 
window to print.

All
selects all reports, including those that may have been 
hidden.

Clear
clears all selections.
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Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific 
reports to save, use the Save as push button.

Save as Allows you to save all or specified reports from the currently 
open file. The push buttons displayed on this dialog perform 
in the same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you 
to reopen the file using the Open push button on the Report 
window tool bar.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can edit report 
defaults.

Fonts Contains a list of report elements for which the font can be 
edited. Simply highlight the desired element and click Edit; a 
font dialog is displayed so that you can specify the desired 
font and attributes.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

For Tabular Reports

Graph border 
line thickness

Enables you to specify a thickness for the border of the graph.

Load Loads the last saved defaults.

Save Saves the changes as the defaults. If you do not click Save, 
the changes will apply to the current report set only. The next 
reports will revert to the defaults.

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not click 
Save, the changes apply to the current report only.

Close Closes the report window.

Resize column Displays a dialog so that you can specify the width  of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.
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Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of all columns, enabling you to select the one 
you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attributes 
for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font attributes 
for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.
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For Graphs

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after having zoomed in.

Redraw Sets axis boundaries to its original view. You can also use 
this function to remove cross-hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been hidden.

Hide curve Allows you to hide (remove) unwanted curves.

Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.
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Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can 
be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve 
group box

Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram
group box 

Allows you to specify the type of fill as well as the color if 
Histogram is chosen as the style for collected data.

Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and drag 
the mouse cursor (drawing a box) across the area you wish to view; then release the button. 
The enlarged area immediately fills the graph area. You can return to the normal view by 
right-clicking on the graph and selecting Autoscale. 

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing you 
to paste it into other applications accepting Windows 
metafiles. 

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

You can remove cross-hair lines and return to the normal view by right-clicking on the graph 
and selecting Autoscale, or clicking out of the graph area.

Report Examples

This section contains examples of the types of reports available using the Saturn DigiSizer 
analysis program.

X-axis position

Y-axis positionPoint of Coordination
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Combined Report

The Combined report is a combination of all reports you select on the Combined Report 
options dialog. Reports are shown consecutively with no page breaks or headings.
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Particle Size Table
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Volume Percent Table
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Cumulative Volume Percent vs. Particle Diameter
7-32                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Report Examples
Incremental Volume Percent vs. Particle Diameter
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Difference from Reference
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Out of Specification
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Background Report
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Goodness of Fit
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Summary

The Summary report allows you to choose the type of statistics to report; this one shows geo-
metric statistics for volume distribution and peaks.
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8.  OPTIONS MENU

The Options menu contains commands that allow you to:

• Specify basic, restricted, or advanced mode
• Specify and edit sample file defaults
• Specify data presentation modes
• Change your parameter files directory

Description

Listed below are brief descriptions of the Options menu options. Detailed descriptions are 
found in subsequent sections.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 8-2.

Option Presentation Allows you to display the sample file dialog in the Basic, 
Advanced, or Restricted format. Page 8-3.

Sample Defaults Allows you to specify defaults for the parameters contained 
in the sample information file. Page 8-6.

Data Presentation Allows you to choose the way in which data are presented on 
the screen and in printed reports. Page 8-11.

Parameter Files Directory Allows you to specify a location for the parameter files when 
using the Basic mode. Page 8-12.
520-42805-01 (Rev H) - Nov 2018                                             8-1 



Service Test Mode Saturn DigiSizer II 5205
Service Test Mode

Various service tests are included in the Saturn DigiSizer operating program. These tests can 
be performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog box prompting you to enter a 
password is displayed. This password is coded to change on a regular basis and, therefore, is 
known only by your service representative. You will not be able to perform these tests without 
their guidance. After Service Test Mode has been activated, the tests can be accessed from the 
Unit menu.
8-2                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Option Presentation
Option Presentation

The sample editing dialogs for the Saturn DigiSizer analysis program may be presented in 
three modes: Restricted, Basic, or Advanced. Each format displays sample information and 
menu options differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog similar 
to that of an index card file.

• Basic: displays all parameters of the sample file in a single dialog. 

• Restricted: displays in the same manner as the Basic format, except that some options 
are disabled.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens its associated dialog.

The Advanced format is used to create customized sample files and edit values in parameter 
files. You can also switch to the Basic format, if desired, by clicking Basic. Refer to 
Advanced, page 5-8 for a detailed description of this dialog.

Tabs allow quick access to parameters.
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Basic

The Basic format presents the sample information file and its parameter files as a single dia-
log. 

The Basic format is used to create sample information files using previously defined parame-
ter files. You can easily switch to the Advanced format, if desired, by clicking Advanced. 
Refer to Basic, page 5-5 for a detailed description of this dialog.

Restricted

The Restricted format is identical to the Basic format, except that certain menu options are 
disabled, and you cannot switch to the Advanced format. 

This format is password-protected and is typically used in laboratories where analysis condi-
tions must remain constant, for example, in the pharmaceutical industry.

This push button does 
not display when using 
the Restricted format.
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When you select Restricted, a dialog requesting a password is displayed:

Any password (up to 31 characters) can be used to enable the Restricted format. The same 
password, however, must be used to exit the Restricted format. For example, if you enter 
“password” to enable the Restricted format, then you must use “password” to exit. If you for-
get the password, open the system INI file and navigate to the Private section. The current 
password will be shown immediately following “OptionPresentationPassword.” Make a note 
of the password, exit the INI file, and enter the password where requested. Do not attempt to 
delete the password in the INI file.
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Sample Defaults

This option allows you to specify default parameters for sample information files. 

Sample defaults are the values you see in the sample information editors when you create a 
new sample file. For efficiency, it is best to specify defaults for materials you most commonly 
analyze. You can always edit the values in the sample file when it is created. Sample defaults 
can be created using the Basic or Advanced format.

Advanced

The Advanced Sample Defaults dialog resembles a set of index cards. The values you specify 
in the parameter portions of the sample file (Analysis Conditions, Material Properties, and 
Report Options) are saved as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, then click Yes to create the file, and the 
defaults you specify display for all parameters.

• Select File > Open > Analysis Conditions, name and create the file, and the defaults 
you specify in the Analysis Conditions portion of the Advanced Sample Defaults 
dialog display in the fields

The DigiSizer Sample Defaults dialog is displayed in this manner for the Advanced format.
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Sequence Number: Specify a default sequence for the sample file name. The 
number you specify is incrementally sequenced each time 
you create a sample file. It is the number that appears in the 
File name field when you select File > Open > Sample 
information.

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Use up to eight characters.

• Do not use characters such as * or ?. 

Sample Allows you to enter an additional identification that provides 
more information than the sample file name alone. 

In the field on the left, you can edit the prompt for Sample. 
For example, you may prefer to use Test or Material. The 
maximum number of characters is 20.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, such as 
dashes.

• Maximum number of characters is 42, plus the $ symbol.

• Include the automatically generated file number as part of 
the identification by using the $ symbol  where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
sample identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

The sample identification for the second sample informa-
tion file would be:

Lab #25 - 000-002, and so on
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Operator
Submitter
Bar code

These fields enable you to enter defaults for the operator, 
submitter, and bar code information. 

The fields on the left can be edited to display a different label 
if desired.

The fields on the right allow you to specify default names or 
titles, and bar code information.

• Maximum number of characters for the fields on the left 
is 20.

• Maximum number of characters for the fields on the right 
is 42.

• Select Omit adjacent to any field you wish to omit from 
displaying on the sample information dialog.

User Parameters 
Group Box

The fields in this group box are used specifically for SPC 
(Statistical Process Control) reporting. They are used to 
specify characteristics of either the sample or its 
manufacturing process.

For example, you may wish to report the relationship of the 
motor speed of a grinder used in the manufacturing process to 
the median diameter of the sample. In the parameter field on 
the left, enter Motor speed. In the field on the right, enter a 
default value (this value may be edited if desired in the 
sample information file). Once specified, these parameters 
display in the SPC Sample Options dialog (accessed through 
the SPC Calculations dialog).

Omit this item entirely from the sample information file by 
selecting Omit.
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Basic

The DigiSizer Sample Defaults dialog is displayed in this manner for the Basic format.

Sequence Number Allows you to specify a default sequence for the sample file 
number. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open > 
Sample Information.

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Use up to eight characters.

• Do not use characters such as * or ?.

Sample Allows you to enter an additional identification that provides 
more information than the sample file name alone. 

In the field on the left, you can edit the prompt for Sample. 
For example, you may prefer to use Test or Material. The 
maximum number of characters is 20.
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Sample

(continued)

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, such as 
dashes.

• Maximum number of characters is 42, plus the $ symbol.

• Include the automatically generated file number as part of 
the identification by using the $ symbol  where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
sample identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

The sample identification for the second sample informa-
tion file would be:

Lab #25 - 000-002, and so on.

Analysis Conditions 
group box

This group box contains a drop-down list containing 
predefined analysis conditions files. 

Also included in this group box are the Autodilute, Number 
of Tests, and Rinse options. Refer to Analysis Conditions, 
page 5-11 for additional information on these options.

Material properties 
group box

This group box contains two drop-down lists, one for Sample 
and one for Liquid. Samples and liquids can be added to the 
lists by switching to the Advanced format and using the 
Material Properties dialog.

Report Options 
group box

This group box contains a drop-down list of predefined report 
options files.

Also included in this group box is a list of available reports.

Save Saves the specified defaults.
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Data Presentation

The options on the Data presentation drop-down menu allow you to specify how you wish tab-
ular and graphical data to display on screen and in printed reports. 

Size in diameter/radius
Invert size axis
Cumulative coarser/finer
Percent/Fraction

Provides options for displaying data on the screen and in 
printed reports. Selected options are preceded with a check 
mark. 

Sieve Table Displays the Sieve Table dialog so that you can specify 
default sieve sizes when presenting sieve data.

A sieve size is selected when it is preceded by a check mark. 

Make your selections by double-clicking on the desired 
sieves, or highlight the sieve and press the Spacebar.

Indicates selected 
sieves.
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Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions, Report 
options, and Material properties files displayed in the drop-down lists on the Basic Sample 
Information dialog. The current directory is displayed above the drives/directory window. 

The directory specified here is the one you should use when creating parameter files to be 
included in the drop-down lists on the Basic and Restricted sample information dialogs. It is 
where the software goes to obtain the files for the drop-down lists. 

The default directory is params and includes several parameter files supplied with the analy-
sis program. If you specify a different directory, these files will not be included in the drop-
down lists unless you copy (or move) them to the new directory. You should also be sure to 
save newly created parameter files to the changed directory.  

If you wish to continue to use the params directory for parameter files, it will display as the 
default when saving parameter files.

Current Parameter 
Files directory
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9.  TROUBLESHOOTING AND MAINTENANCE

The Saturn DigiSizer system has been designed to provide efficient, continuous service and 
requires very little maintenance. The few maintenance procedures recommended are simple, 
easy to perform, and require no tools. If any service beyond the scope presented in this chapter 
is required, you should contact your local trained service representative. You should never at 
any time attempt to remove any panels from the analyzer. 

Troubleshooting

Most common operational problems are caused by improperly installed tubing, or a dirty sam-
ple cell. Always check these things first when expected analysis results are not obtained. Most 
operational problems are indicated by an error message on the monitor screen. Appendix A 
provides solutions for these message (see Unnumbered Messages, page A-32). Listed below 
are some troubleshooting tips when operational problems occur.

Table 9-1. Common Operational Problems

Problem Action

No power to the analyzer Ensure that the power cord is firmly plugged into the 
analyzer and the receptacle.

Ensure that the ON/OFF switch is in the ON position.

Ensure that the power source is energized.

Check the fuse located in the power entrance located on the 
rear panel of the analyzer; replace if necessary. (Refer to 
Replacing Fuses, page 9-11.)

Ensure that the line voltage is correct for the analyzer’s 
configuration. 

Make sure the Linear circuit breaker has not tripped. If the 
breaker has tripped (indicator button is extended), turn off 
the analyzer and wait for a few minutes. Reset the breaker 
and turn on the analyzer. 
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Problem Action

No communication between the 
analyzer and the computer

Ensure that the ethernet cable is firmly seated at the analyzer 
and computer ethernet ports.

Time-out message during rinse 
or drain operation

Make sure the Analysis and/or Rinse containers contain 
liquid; if not; refill and resume operation.

Check the rinse/analysis tubing to see if it is primed (fluid 
inside the tubing). If no fluid is present, inspect the tubing 
for a cut or worn spot; replace the tubing if necessary (refer 
to Replacing the Tubing, page 9-9).

Make sure a sample cell is installed. If a sample cell is not 
installed, the sample cell compartment will be filled with 
liquid. Remove the rubber mat from the sample cell 
compartment. Thoroughly dry the inside of the compartment 
and the mat. Replace the mat and install the sample cell 
(refer to Step 11 of Cleaning the Optics, page 9-4).

Check the tubing connections to the sample cell to make sure 
they are secure. If leaking, cancel the current operation. 
Thoroughly dry the inside of the sample compartment and 
tighten the tubing connections, then resume operation.

Check the pumps and solenoid valves for proper operation. 
Access the instrument schematic and enable manual control. 
Turn the analysis and rinse pumps on to ensure that liquid is 
being pumped into the reservoir. Call your local 
Micromeritics representative if liquid does not pump into the 
reservoir properly.
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Problem Action

—————————— MASTERTECH —————————

No power to the MasterTech Ensure that the power cable is plugged securely into the 
power source.

Ensure that the ON/OFF switch is in the ON position.

Check the fuse located in the power entrance located on the 
rear panel of the MasterTech; replace if necessary. (Refer to 
Appendix J, page I-3 for instructions on installing fuses.)

Stirrer will not work. Ensure that the stirrer is properly connected.

Turntable will not move. Press the arm AUTO/LOAD switch on the front panel to 
place it in the AUTO position.

MasterTech pump will not run. Ensure that the pump AUTO/OFF switch on the front panel 
is in the AUTO position.

Tubing may be bunched up in the pump; pull the tubing taut.

Ultrasonic probe will not 
work.

Check the BNC connector cable to ensure that it is properly 
connected.

Ultrasonic agitation 
diminished.

Check the probe tip; replace if necessary. See Replacing the 
Ultrasonic Probe Tip, page 9-12 for more information.

MasterTech will not initiate 
commands from the computer.

Check the cable connection from the MasterTech to the 
computer to ensure that it is properly connected.

Pump leaks or is not operating 
efficiently.

Tubing is leaking or clogged; replace tubing.
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Cleaning the Analyzer

A clean cloth, dampened with isopropyl alcohol (IPA), a mild detergent or a 3% hydrogen per-
oxide solution may be used to clean the outside casing of the analyzer and liquid sample 
handler. It it not necessary to remove any control knobs or screws while cleaning. If you have 
a MasterTech installed on your Saturn DigiSizer, it may be cleaned in the same manner.

Cleaning the Optics

The accessible optics of the DigiSizer 5205 consist of three components: the sample cell, the 
detector lens, and the collimator lens. It is important that these components be kept clean.

Sample Cell and Detector Lens

The sample cell should be cleaned as needed based on changes in background intensity (refer 
to Appendix H, Page H-1 for a discussion on background quality). You will need the follow-
ing items to clean the sample cell (included in the accessories kit):

• Lens cleaner 
• Lens paper
• Soft absorbent (non-scratching) foam swab 

1. Select Unit [n] > Drain to drain the system of all liquid and to move the rotation arm out 
of the way, allowing easy access to the sample cell assembly. The dialog will close when 
draining is complete.

2. Open the front panel of the DigiSizer analyzer and remove the cover of the analysis 
compartment.

3. Loosen the two knurled nuts on the top bracket of the sample cell holder; then pull up on 
the bracket to allow removal of the sample cell.

4. Rotate the cell out of its holder by pulling the right-hand side of the cell assembly toward 
the front of the analyzer. The left side will remain against the vertical support.

The sample cell is coated with an anti-reflective substance. Be careful not to scratch 
or abrade this coating. Also avoid touching the front and back surfaces of the sample 
cell to prevent fingerprints.
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5. Grasp the sample cell by its side edges and place on a sheet of lens paper while 
performing the next two steps.

6. Using your fingertip, check the o-rings in the upper and lower bracket of the sample cell 
holder to ensure that they are clean (no grit is present) and properly seated. If the o-rings 
appear dirty, wipe them with a sheet of lens paper dampened with lens cleaner. 

7. Using a flashlight or other type of illumination, examine the detector lens (located at the 
back of the analysis compartment). If particles or smudges are evident, gently clean the 
lens surface with a sheet of lens paper dampened with lens cleaner. Then, using a dry 
sheet of lens paper, gently wipe the surface dry.

8. Holding the sample cell by its side edges, blow or gently brush away any debris from the 
surface of the sample cell.

9. Using a sheet of lens paper dampened with lens cleaner, clean the upper and lower edges 
of the cell. Then, using a foam swab dampened with lens cleaner, clean the outside and 
inside of the cell. 

10. Using a dry sheet of lens paper, gently and completely wipe dry the outside of the cell; 
DO NOT dry the inside of the cell.

Knurled Nuts

The detector lens is coated with an anti-reflective substance. Be careful not to scratch 
or abrade this coating. Also avoid touching the front and back surfaces of the sample 
cell to prevent fingerprints.

Always hold the sample cell by the side edges. Fingerprints on the front and back 
surfaces of the cell can alter analysis results.
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11. Reinstall the cell:

a. Orient the cell so that the groove is on the left side and the extended flange is on the 
front of the right side.

b. Slide the grooved (left side) of the cell onto the left vertical bar.

c. Rotate the sample cell toward the right vertical bar; ensure that the cell is seated 
properly between the two vertical bars.

d. Slide the top bracket of the sample cell holder down; tighten the knurled nuts. You 
should see a black oval on the bottom of the cell where the o-ring makes a seal.

12. Perform a quick leak-check to ensure proper installation of the cell:

a. Select Unit [n]  > Rinse > DigiSizer.

b. Choose the Rinses option, specify 1, and then click Start.

c. Observe the sample cell. If no leaks occur, proceed to Step 13. If leaks occur, click  
Cancel, then Yes to stop the rinsing function.

d. Close the front panel (you do not have to reattach the cover of the sample analysis 
compartment); then select Unit [n]  > Drain to drain the system.  

e. After draining is complete, turn off the analyzer, then close the analysis program.

f. Open the front panel and remove the rubber mat from the analysis compartment. 

g. Wipe dry the area around the sample cell, the mat, and the analysis compartment; 
replace the mat.

h. Make sure the cell is seated properly and the knurled nuts are secure.

i. Turn on the analyzer and start the analysis program.

j. Repeat steps a, b, and c (and the remainder if necessary).

13. Replace the sample cell compartment cover and close the front panel.

Right vertical barLeft vertical bar

External flange

Top View of Sample Cell Seated Against Left and Right Vertical Bars
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Collimator Lens

The collimator lens should not require cleaning unless the Saturn DigiSizer is being exposed 
to an environment where high levels of dust are present. If this is the case, you should occa-
sionally inspect the collimator lens and the analysis compartment to ensure their cleanliness. 
You should always keep the analysis compartment and the analyzer’s front cover closed 
except during cleaning to minimize dust build-up.

You will need the following items to clean the collimator lens:

• Small mirror
• Lens paper

1. Select Unit [n]  > Drain to drain the system of all liquid and to move the rotation arm up. 
The dialog will close when draining is complete.

2. Open the front panel of the DigiSizer analyzer and remove the cover of the analysis 
compartment.

3. Wipe or brush the inside of the analysis compartment if needed.

4. Use the mirror to locate the collimator lens (on the underside of the rotation arm).

5. Using a sheet of dry lens paper, gently wipe the surface of the lens. Be careful not to 
touch the lens with your fingertips. Do not use compressed air to blow away particles 
from the detector lens. This merely resuspends the particles, allowing them to resettle on 
the optics.

6. Replace the sample cell compartment cover and close the front panel.
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Cleaning the Sample Reservoir

Rinsing after analysis generally will keep the reservoir in a clean state. Occasionally, however, 
particles may accumulate on the surface of the reservoir where rinsing may not sufficiently 
remove them. If the reservoir appears dirty or feels gritty to the touch, clean it as follows:

1. Select Unit [n] > Drain to empty the reservoir of all liquid.

2. Using a clean, soft cloth, wipe the inside of the reservoir. If necessary, use a soft brush to 
remove any stubborn particles.

3. Perform a rinse operation to rinse the reservoir; this operation also fills the reservoir to 
the primed level.
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Replacing the Tubing

Tubing may occasionally become worn or damaged in some way and require replacing. 

Liquid Sample Handler

The types of tubing connected to the liquid sample handler are identified as follows:

• Rinse tubing* 0.64-cm (1/4-in.) diameter
• Analysis tubing 0.64-cm (1/4-in.) diameter
• Overflow tubing 1.27-cm (1/2-in.) diameter
• Drain tubing 0.79-cm (5/16-in.) diameter

*The Low-volume unit uses the same liquid for analysis and rinsing. Therefore, 
Rinse tubing is not installed. Ignore all references to the rinse tubing in this 
procedure if you have the Low-volume unit.

The tubing on the liquid sample handler should be replaced as needed. Refer to Chapter 10 for 
part numbers and ordering information. All tubing is removed and replaced in the same man-
ner. The rinse and analysis tubing are the same type tubing. The drain tubing is the same color 
and very close to the same size as the rinse and analysis tubing; be sure that you are replacing 
the damaged tubing with the correct tubing.

1. Slide the damaged tubing off the connector on the front panel of the liquid sample 
handler. 

2. Remove the other end from its liquid container. If you are removing the analysis or rinse 
liquid tubing, be sure to remove the weights; place aside for installation on the 
replacement tubing. 

3. Slide one end of the replacement tubing onto its appropriate connector on the front panel.

4. Insert the other end of the tubing into its appropriate liquid container. Be sure to reinstall 
the weights if replacing the analysis or rinse tubing.

Analysis Tubing Rinse Tubing

Overflow TubingDrain Tubing
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Replacing the Air Filter

The air filter should be replaced every 30 days (more often in environments with increased 
levels of dust).

1. Remove the filter by inserting a pointed object, such as a flat-head screwdriver, into the 
center portion of the retaining cover; then pop off the cover.

2. Discard the old filter and replace with a new one from your accessories kit.

3. Replace the retainer cover.

A supply of air filters is provided in the accessories shipped with your instrument. 
Refer to Ordering Information, page10-1  when reordering is required.

Insert screw driver here.
9-10                                                    520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Replacing Fuses
Replacing Fuses

If a fuse has blown, the analyzer power indicator will not illuminate.

The fuses are located in the power-selector module on the lower, right side of the rear panel of 
the analyzer.

Replace the fuse(s) as follows:

1. Turn off the analyzer and disconnect the power cord from its power source.

2. Insert the tip of a small pocket screwdriver (or pointed object) into the left side of the 
power module located on the rear panel of the AquaPrep.

3. Gently lift up until the cover lifts up approximately 1/4 inch, then swing the cover to the 
left; the cover is hinged and cannot be removed.

4. Remove the fuse block (you may have to use needle-nose pliers to grasp the fuse block).

5. Remove the blown fuse and replace with a new one. Be sure to use the appropriate fuse 
for the input power source.

The power cord should be disconnected from the analyzer when replacing fuses. 
Failure to do so could result in electrical shock.

The fuses used in the analyzer must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the unit.
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6. Position the fuse block so that the side containing the fuses is facing the power module 
and

7. Close the cover to the power entry module; ensure that the indicator pin is in the correct 
position.

8. Plug the power cord back into its power source; turn on the analyzer.

Replacing the Ultrasonic Probe Tip

After extended periods of use, the tip of the ultrasonic probe on the MasterTech may become 
pitted, causing diminished agitation. If this occurs, replace the tip as described below.

1. Remove the damaged tip from the probe using two 9/16 in. wrenches.

2. Attach the new probe tip to the probe body. Use the wrenches to tighten securely.

Power Source Fuse

100-120 VAC 1.6 Amp, slow blow

200-240 VAC 1.25 Amp, 5x20 mm, slow blow (requires two)

Refer to Chapter 10, Ordering Information, to determine the correct part to be used 
with your probe assembly.

Never hold the probe by the tip; doing so may cause damage to the probe.
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10.  ORDERING INFORMATION

Components and accessories for the Saturn DigiSizer system can be ordered by one of the fol-
lowing methods:

• contact our Customer Service Department at 770/662-3636
• access our web site at www.micromeritics.com
• contact your local sales representative

When ordering, please use the information provided below.

Part Number Description

052-00052-00 MasterTech 052, for automatic sample preparation. Redisperses up to 18 
samples and transfers them to the DigiSizer for analysis.

055-00000-00 AquaPrep, for preparing water to be used with the DigiSizer 

004-32065-01 Lens paper, pkg. of 50

004-38600-00 Lens cleaner

004-35152-00 Foam swab, pkg. of 50

004-27015-00 Air filter (rear panel), package of 10

520-42805-00 Operator’s manual

003-51207-00 Fuse, 5 x 20 mm, Slow-Blow, 1.6 Amp  (100 - 115 VAC)

003-51197-00 Fuse, 5 x 20 mm, Slow-Blow, 1.25 Amp  (220 - 240 VAC)

520-34900-00 Sample cell, packed in protective case; includes lens papers for handling 
the cell

004-25575-01 O-ring, for sample cell, Viton®

520-32802-00 Gasket (spacer), light blocking, for tubing orifices on liquid sample 
handler

004-16841-00 Reference material, Garnet, 5.30 m

520-32803-04 Tubing, flexible, for lower sample cell port (standard liquid sample 
handler)

520-32803-05 Tubing, flexible, for upper sample cell port (standard liquid sample 
handler)

520-32804-07 Tubing, flexible, for lower sample cell port (low-volume liquid sample 
handler)

520-32804-04 Tubing, flexible, for upper sample cell port (low-volume liquid sample 
handler)
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Part Number Description

—————— MASTERTECH ACCESSORIES ——————

004-54134-00 Wrench, 9/16 in., ignition open end

003-51131-00 Fuse, 3AG,  Slow-Blow, 2 Amp 

003-51197-00 Fuse, 5 x 20 mm, Slow-Blow, 1.25 Amp

051-14811-00 Evaporation cover

051-14814-00 Turntable assembly

051-32901-00 Tubing set, Tygon

051-58605-02 Ultrasonic probe tip, 1/8 in.

051-61702-01 Beaker, molded, 125 mL, w/o spout, PE

052-58605-02 Ultrasonic probe tip, 1/4 in.

052-54600-00 Key, Tubing loading
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A.  ERROR MESSAGES

Two types of error messages may be encountered while operating the Saturn DigiSizer 
program:

• Numbered error messages: displayed during operational procedures
• Unnumbered error messages: displayed on the instrument schematic

If the Action response for either type of message instructs you to contact your service repre-
sentative, record the error message and make backup copies (if appropriate) of any files 
involved in the operation.

Numbered Messages

2400 Series

2430- Error accessing file (file name), error code = (number). 

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause A: Media may be damaged.

Action A: Clean the media drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Run diagnostics on your computer.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause D: The name specified contains one or more invalid characters.

Action D: Enter a valid filename; do not use characters such as * or ?.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) — Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to diskette, delete 
them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several Saturn DigiSizer files (sample information, analysis condi-
tions, material properties, or report options) have been added to this 
directory by some function other than the Saturn DigiSizer program.

Action: Select Yes to update the directory information with data from each 
new file. This operation may take a minute. 

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter.
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2437- File (file name) does not exist.

2438-  Disk drive (letter): is inaccessible.

2439-  Could not register file.

2440-  Subset not found.

2441-  Seek within file failed.

2442-  Had header in subset file.

2443-  Subset owner denied access.

2444-  Not a valid file format.

2445-  Subset wrote the wrong amount of data.

2446-  Error reading data.

2447-  Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

2449-  This field does not contain a valid file specification.

Cause: You entered an invalid file name.

Action: Enter the name of an existing file or select a file name from the list box.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the media in the disk drive is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your Windows doc-
umentation and reenter the name.
520-42805-01 (Rev H) - Nov 2018                                          A-3 



Appendix A Saturn DigiSizer II 5205
2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. Continue with program Exit? (Yes, No)

2460- Fatal Communications error on (Unit n - S/N: nnnn)

2461- No active instruments. Application will stop.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be exited.

Action: Wait a short time and attempt to exit the application again.

Cause: You attempted to exit the application while an analysis is in progress. 
While this is possible, the data collected while the application is inac-
tive will not be permanently recorded until the application is restarted. 
A power failure to the instrument could cause some data to be lost.

Action: If you are not concerned with the potential for loss of data should a 
power failure occur, select Yes to continue; otherwise select No.

Cause: There was a fatal error in the communications between the application 
and the analyzer. All displays for that analyzer will be closed.

Action: Ensure that the ethernet cable is securely connected at the computer 
and analyzer ports. Exit the analysis program and then restart it. If this 
error persists, contact your service representative.

Cause: At least one instrument must be active for the application to operate. 
The initialization of all of the instruments configured with the Setup 
program has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the instrument’s failure to initialize. See the instructions for that 
message. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the instrument has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the instrument, contact your 
service representative.
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2468- The instrument contains an unknown software version. Do you want to reset 
it?

2469- The instrument software did not initialize properly on Unit n - S/N: nnnn.

2470-  Unable to read instrument software file for Unit n - S/N: nnnn.

2477- Unit n - S/N: nnnn did not properly initialize.

2486-  Could not construct (name) report type. Program will terminate.

Cause: The application has discovered a different version of software operat-
ing in the instrument. 

Action: If there is no chance that an instrument other than the Saturn DigiSizer 
is connected to the computer, select Yes to reset the instrument and 
download the proper software. Otherwise, select No to leave the instru-
ment unchanged.

Cause: The Saturn DigiSizer software failed to execute properly.

Action: Reinstall the software, then restart it. If the problem persists, contact 
your service representative.

Cause: The application tried to read the instrument software file to download it 
to the instrument. It was unable to do so. 

Action: Reinstall the Saturn DigiSizer software, then restart it.

Cause: The software was unable to initialize this instrument; this is usually 
caused by one of the conditions listed in the error messages above.

Action: Correct the problem as described above, then restart the application.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2487-  Could not start report generator. Error code (number). Program will terminate.

2488-  File (file name) cannot be opened for editing. It is already in use.

2489-  File (file name) cannot be opened for writing. It is already in use.

2490-  No ‘.INI’ file present. Application will terminate.

2492-  This field’s entry is INVALID.

2493-  An entry is REQUIRED for this field.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is already open for editing.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Uninstall the application, then reinstall to create the control file 
required by the analyzer.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.
A-6                                                   520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Appendix A
2494-  Value is out of the valid range.

2495-  Value is out of the valid range. Enter a value between (value) and (value).

2496-  Invalid number.

2497-  This field contains an invalid character.

2498-  The requested change to the Sample’s status is invalid at this time.

2499-  Sequence number must contain at least 3 digits.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

Cause: No more sample information files can be created using the currently 
specified file sequence number.

Action: Select Options > Sample Defaults from the Main menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device. Use the Control Panel > Printers 
option to specify a default printer.
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2507-  Error opening file (name) for printing. Error code: (number).

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name):  (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.
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2511- Print job (name) has been canceled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming controller failed.

2524- CRC check failed on programming controller.

2525- Unknown error programming controller.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the DigiSizer analysis program.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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2526- Controller download was not successful.

2527- Controller CRC error on boot block.

2528- Controller DRAM error.

2529- Controller Com1: error.

2530- Controller Com2: error.

2531- Controller debug port error.

2532- The instrument contains an unknown software version. Do you want to reset 
it?

2533- Mass initialization failed.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer and liq-
uid sample handler. Then turn on the liquid sample handler first, the 
analyzer second, and restart the Saturn DigiSizer application. If the 
problem persists, contact your local Micomeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The application has discovered a different version of software operat-
ing in the instrument. 

Action: If there is no chance that an instrument other than the Saturn DigiSizer 
is connected to the computer, select Yes to reset the instrument and 
download the proper software. Otherwise, select No to leave the instru-
ment unchanged.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.
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4200 Series

4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # [n])

4201- No reports selected.

4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator to have full rights granted.

Cause B: An internal error occurred while read control information was being 
read from a disk file.

Action B: The disk on which the application is installed may have failed. Contact 
your Micromeritics service representative and report the code number 
given in the message.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and reinitiate 
the report.

Cause: The sample file you selected for reporting does not contain any valid 
data.

Action: If the sample is still analyzing, wait until enough data are collected to 
allow reporting. If the sample file has a Complete status, an error or 
operator intervention stopped the analysis before sufficient data were 
collected. The analysis may be deleted from the file.

Cause: You requested a tabular report with Difference from reference 
selected as one of the columns. This quantity cannot be computed 
because the reference file is invalid.

Action: Select a reference file containing valid data.
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4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

4207- No valid data is available for this report. No report produced.

4208- An overlay file is not valid. It was not included in the report.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
coarse specification file is invalid.

Action: Select a file containing valid data.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
finer specification file is invalid.

Action: Select a file containing valid data.

Cause: You requested a tabular report with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one col-
umn of the table.

Cause: You selected a test in the sample file that does not contain valid data.

Action A: If the sample is still analyzing, wait until enough data are collected to 
allow reporting. 

Action B: Choose another test on which to report. If the sample file has a Com-
plete status, an error or operator intervention stopped the analysis 
before sufficient data were collected. The analysis may be deleted from 
the file.

Cause: You selected a sample file for overly that contains invalid data.

Action: On the Report Options dialog, click Overlays and remove the file and 
choose one containing valid data.
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4209- The reference file is not valid. The report was not produced.

4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

Cause: You selected the Difference from Reference report; it cannot be com-
puted because the reference file is invalid.

Action: You selected a file for reference that contains invalid data; choose a 
different file.

Cause: You selected the Out of Specification report; it cannot be computed 
because the coarse specification file is invalid.

Action: You selected a file that contains invalid data; choose a different file.

Cause: You selected the Out of Specification report; it cannot be computed 
because the finer specification file is invalid.

Action: You selected a file that contains invalid data; choose a different file.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and reinitiate 
the report.

Cause: You clicked Delete on the Collected Data dialog to delete a test.

Action: Click Yes to remove the indicated test from the sample file; click No to 
allow the test to remain in the file.
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4214- The reference file is not valid. The overlay was not produced.

4215- Coarser specification file is not valid. The overlay was not produced.

4216- Finer specification file is not valid. The overlay was not produced.

4217- No table entries are within the distribution limits.

4218- In order to use (option) you must select a Statistics Type or Arithmetic Statis-
tics Type.

4219- In order to display summary statistics, you must select a Distribution Type.

Cause: The reference file specified in the current file does not exist.

Action: On the Report Options dialog, click Reference and choose a different 
file.

Cause: The file specified for the coarser specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: The file specified for the finer specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: Truncate to distribution limits is selected on the report editor, but 
table entries are not within the range of the collected data.

Action: Edit the table entries, or deselect Truncate to distribution on the 
report editor.

Cause: You requested a Summary report, but did not select a Statistics Type.

Action: Edit the Summary report and select at least one Statistics Type.

Cause: You requested a Summary report but did not select a Distribution 
Type.
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Action: Edit the Summary report and select a Distribution Type.
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6000 Series

6003- New data reduction options are currently being applied to the test data. Do you 
wish to cancel the reprocessing?

6004- All of the test data will be converted to the new data reduction options. Do you 
wish to continue?

6005- Model generation is already in progress. Only one generation is allowed at a 
time.

6006- Application of new data reduction options to <file name> is complete.

6007- A new model generation cannot be started. One is already in progress.

Cause: You have requested to cancel the reprocessing of the intensity data.

Action: Select Yes to cancel the reprocessing. Select No to continue the repro-
cessing.

Cause: You requested Scattering Model Advanced Options to be applied to 
collected data.

Action: Select Yes to convert the data to the new data reduction options, and 
No to stop the reprocessing.

Cause: You requested that a new scattering model be generated, but one is cur-
rently being generated.

Action: Wait for the current model to complete its generation process and then 
try again.

Cause: You requested Scattering Model Advanced Options to be applied to 
collected data and the process is now complete.

Action: None required; notification message only.

Cause: You requested  that a new scattering model be generated, but one is 
currently being generated.

Action: Wait for the current model to complete its generation process and then 
try again.
520-42805-01 (Rev H) - Nov 2018                                          A-17 



Appendix A Saturn DigiSizer II 5205
6008- Error loading the model generation task. Error code: <number>

6009- An error occurred while converting <file name> to a new model. All further pro-
cessing aborted.

6010- An unusual condition occurred while converting <file name> to a 
new model. Processing will continue.

6014- Sample (file name) has an invalid status and cannot be used for this analysis.

6015- The liquid selected for the analysis in sample (file name) does not match the 
background.

Cause: An error occurred while generating the model, probably due to a prob-
lem with the background generation application.

Action: Reinstall the software and try again.

Cause A: You chose a sample file that has no tests remaining for analysis. 

Action A: Choose a sample file with a status of No Analysis or Complete (with 
less than eight tests). Eight tests can be performed using one sample 
file. 

Cause B: You chose a sample file that is currently in an analyzing or calculations 
state.

Action B: Watch the status window and proceed when the status window indi-
cates analysis and/or calculations are complete.

Cause: You attempted to begin an analysis, but the analysis liquid specified in 
the sample file did not match that of the current background.

Action A: Measure a new background with the proper liquid and continue with 
analysis.

Action B: Choose a sample file that matches the dispersing liquid of the current 
sample and background.
A-18                                                   520-42805-01 (Rev H) - Nov 2018



Saturn DigiSizer II 5205 Appendix A
6016- Warning, the instrument is not calibrated.

6017- Error accessing the sample information file <name>.

6018- File <file name> already has all its tests filled.

6020- File <file name> cannot be analyzed. It is currently being edited.

Cause: You attempted to begin an analysis, but the instrument is not fully cal-
ibrated.

Action A: Exit the analysis program and turn off the analyzer. Turn the analyzer 
back on and restart the analysis program. Select Unit [n > Unit con-
figuration to verify that calibrations are installed (calibration items 
will contain dates). If no information displays for the calibration items, 
go to Action B. 

Action B: Run the setup application and reinstall the calibration files. 

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: You tried to insert a new test using a sample file which already con-
tains eight tests.

Action: A single sample file can have a maximum of eight tests. If additional 
tests are required on this sample, you must create another sample file.

Cause: You selected a file that was still open in an editing window for anal-
ysis.

Action: Finish the changes to the sample file, then save and close the editing 
window.
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6021- An analysis cannot be performed on <file name>. It is open for editing and con-
tains errors.

6022- The edit session for <file name> must be saved before the analysis. Save 
changes and continue with the analysis?

 6023- An error occurred while loading the scattering models. Data reduction cannot 
be performed.

6024- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6025- Unable to find optical model <file name>.

Cause: You selected a file that is currently being edited. Editing cannot be fin-
ished because the sample contains entry fields with errors.

Action: Correct the errors and finish editing the sample file. Then save, close 
the editing window, and try opening the file again.

Cause: You selected a file for analysis that is currently being edited. The 
changes to this file must be saved before it can be used in an analysis.

Action: Click Yes to save the changes and proceed with the analysis. Click No 
if you wish to review the changes before you save them.

Cause: The application was unable to load the scattering models properly.

Action: Exit the application and reinstall the software.

Cause: One of the automatic analysis modes is active. Sample defaults cannot 
be edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause: The model used by the sample could not be loaded.

Action: Select the Options push button on the Materials Properties dialog and 
make sure the selected model exists.
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6026- The angles of the optical <file name> do not match the collected data.

6027- The size classes of the optical model <file name> do not match the standard 
size classes.

6028- Cannot read the deconvolution results.

6029- Cannot execute the deconvolution application.

6042- Unable to download CCD characterization data.

6043- Unable to download calibration data.

6045- CCD characterization data not found.

6046- Calibration data not found.

Cause A: An error occurred during deconvolution of the model, probably due to 
a problem with the background calculation application.

Action A: Reinstall the software and try again.

Cause B: A model file generated for the DigiSizer 5200 was used with the 
DigiSizer 5205 application.

Action B: Remove DigiSizer 5200 model files from the model directory and 
install or calculate models for the DigiSizer 5205 application.

Cause A: A communications error occurred between the computer and the 
instrument during initialization. 

Action A: Exit analysis program and turn off the analyzer. Ensure that the ether-
net cable is securely connected to the computer and the analyzer. Turn 
on the analyzer and restart the program. 

Contact your Micromeritics service representative if the problem per-
sists.

Cause B: System components were not turned on in the proper order.

Action B: Refer to Turning on the System in Chapter 2 for the correct sequence.

Cause: The calibration file for this analyzer could not be found.

Action: Insert the CD containing your analysis program and reinstall the cali-
bration file.
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6054- Unknown error downloading CCD characterization data.

6056- Unable to establish the TCP connection with the instrument.

6058- Unrecognized sample handler.

Cause A: A communications error occurred between the computer and the 
instrument during initialization. 

Action A: Exit analysis program and turn off the analyzer. Ensure that the ether-
net cable is securely connected to the computer and the analyzer. Turn 
on the analyzer and restart the program.

Cause B: The calibration file for this analyzer could not be found.

Action B: Insert the CD containing your analysis program and reinstall the cali-
bration file.

Action C: If Actions A and B do not correct the problem, contact your 
Micromeritics service representative.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer and liq-
uid sample handler. Then turn on the liquid sample handler first, the 
analyzer second, and restart the Saturn DigiSizer application. If the 
problem persists, contact your local Micomeritics representative.

Cause: A communications problem between the analyzer and liquid sample 
handler has occurred.

Action A: Check the cable connection between the analyzer and the liquid sample 
handler.

Action B: Exit the Saturn DigiSizer application; turn off the analyzer and liquid 
sample handler. Then turn on the liquid sample handler first, the ana-
lyzer second, and restart the Saturn DigiSizer application. If the prob-
lem persists, contact your local Micomeritics representative.
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6060- Invalid laser parameters

6069- Detector: Laser interlock disabled.

6070-  Detector: DAC timeout (type: X)

6071-  Detector: Exposure timeout (status: X, delay: X sec)

6072-  Detector: ADC busy (type: X, status: X)

6073-  Detector: ADC out of range (type: X, LD: X, BT: X)

6074-  Detector: Timeout on waiting for pixel buffer.

6075-  Detector: Pixel buffer X is not ready.

6076-  Detector: Filter move timeout (type: X, status: X )

6077-  Detector: Filter move failed (type: X, status: X )

6078-  Detector: CCD temperature out of range (A/D: X)

6079-  Detector: CCD setpoint out of range (A/D: X)

6080-  Detector: Laser temperature out of range (A/D: X)

6081-  Detector: Laser setpoint out of range (A/D: X)

6082-  Detector: Detector temperature out of range (A/D: X)

6084-  Rotator: Rotation timeout (steps = X, status = X, X)

6085-  Rotator: Output timeout (status = X).

6086- Rotator: Interlock disabled.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The analyzer’s front panel is not closed properly.

Action: Be sure the front panel is closed completely. If problem persists, con-
tact your local Micromeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: The analyzer’s front panel is not closed properly.

Action: Be sure the front panel is closed completely. If problem persists, con-
tact your local Micromeritics representative.
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6087-  Rotator: Position unknown.

6088-  Rotator: Command error (status = X).

6089-  Rotator: Position error (status = X).

6090- LSHU: Error sending message.

6091- LSHU: Error receiving message.

6092- LSHU: Error parsing message (options=X, state=X)

6093- LSHU: Error circulating pump thermal overload.

6094- LSHU: Error 24 Volt line is not available.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: A communications problem between the analyzer and liquid sample 
handler has occurred.

Action A: Check the cable connection between the analyzer and the liquid sample 
handler.

Action B.: Exit the Saturn DigiSizer application; turn off the analyzer and liquid 
sample handler. Then turn on the liquid sample handler first, the ana-
lyzer second, and restart the Saturn DigiSizer application. If the prob-
lem persists, contact your local Micomeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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6095- MasterTech: Not responding.

6096- MasterTech: Error moving arm (expected X, actual X)

6097- MasterTech: Stirrer on/off error (expected X, actual X)

6098- MasterTech: Stirrer speed error (expected X, actual X)

6099- MasterTech: Pump on/off error (expectedX, actual X)

6100- MasterTech: Pump direction error (expected X, actual X)

6101- MasterTech: Ultrasonic on/off error (expected X, actual X)

6102- MasterTech: Error moving turntable (expected X, actual X)

6103- MasterTech: Error querying

6104-  MasterTech: Error getting status

6105- Detector operation: Error light dose offset out of range (X).

6106- Detector operation: Error beam transmittance offset out of range (X).

6107- Detector operation: Error light dose integrating offset out of range (X)

6108- Detector operation: Error beam transmittance integrating offset out of 
Range (X).

6109- Detector operation: Error light dose offset calibration failed (X,X).

6110- Detector operation: Error light close integrating offset calibration failed (X, X).

Cause: A communications problem between the analyzer and the MasterTech 
has occurred, or the MasterTech has malfunctioned.

Action A: Check the cable connection between the analyzer and the MasterTech.

Action B: Exit the Saturn DigiSizer application, and turn off the analyzer, the liq-
uid sample handler, and the MasterTech. Then turn on the MasterTech 
first, the liquid sample handler second, and the analyzer third. Restart 
the Saturn DigiSizer application. if the problem persists, contact your 
local Micromeritics representative.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.
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6111- Detector operation: Error, unable to calculate beam center (X).

6112- Detector operation: Beam angle adjusted (X).

6113- Detector operation: Error, unable to select optic axis.

6114- Detector operation: Error, unable to locate optic axis (X,X).

Cause: Excessive vibration is preventing repeatable beam center alignment.

Action A: Position the liquid sample handler so that only the soft foam rings sur-
rounding the cell tubing are in contact with the analyzer, creating a 
light, tight seal. Metal-to-metal contact causes excessive vibration of 
the analyzer.

Action B: Minimize external sources of vibration. If problem persists, contact 
your local Micromeritics service representative.

Cause: Realignment of the beam center caused a rotator angle adjustment.

Action: None required.

Cause: Too many CCD pixels near the focused laser beam have been tempo-
rarily marked as defective.

Action: Exit the analysis program and turn off the analyzer. Wait approxi-
mately one minute; turn on the analyzer and restart the program.

If the problem persists, contact your Micromeritics service representa-
tive.

Cause: Excessive vibration is preventing repeatable beam center alignment.

Action A: Position the liquid sample handler so that only the soft foam rings sur-
rounding the cell tubing are in contact with the analyzer, creating a 
light, tight seal. Metal-to-metal contact causes excessive vibration of 
the analyzer.

Action B: Minimize external sources of vibration. If problem persists, contact 
your local Micromeritics service representative.
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6115- Detector operation: Error finding rotation lower limit switch.

6116- Error, timeout on draining reservoir.

6117- Error, timeout on filling reservoir. Make sure there is liquid present and resume 
the analysis.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause A: Drain tubing may be obstructed

Action A: Ensure that the drain tubing is unobstructed and the outlet end is not 
submerged in the waste liquid. 

Cause B: A drain valve or level sensor malfunction has occurred.

Action B: Access the instrument schematic and enable manual control. Open and 
close the drain valve several times. Then rinse the system. If the prob-
lem persists, contact your local Micromeritics service representative.

Cause A: The analysis or rinse liquid inlet tubing is out of liquid.

Action A: Check the analysis and rinse liquid tubes to ensure that they are both 
submerged and have adequate supplies of liquid.

Cause B: The analysis or rinse pump is unable to prime itself.

Action B: Raise the liquid container above the liquid sample handler and resume 
operation. After the liquid has started to pump, place the container 
back in its normal position.

Cause C: A hardware malfunction has occurred.

Action C: Contact your local Micromeritics service representative.
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6118- Error, fill stabilization failed after X tries.

6119- Error, rinse failed after [n] tries. Current obscuration [n]. Required obscuration 
[n].

6120- Error, ultrasonic probe is out of liquid.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause A: The cell and liquid sample handler are clean, but the beam transmit-
tance has changed since the last background measurement.

Action A: Perform a background analysis.

Cause B: The liquid sample handler and/or sample cell are dirty and cannot be 
cleaned by rinsing.

Action B: Use a surfactant that will effectively remove the contamination and 
perform a rinse, or manually clean the sample cell and the liquid sam-
ple handler.

Cause C: The rinse liquid differs in transmittance from the liquid used in the cur-
rent background measurement.

Action C: Perform as many rinses as is necessary to clean the system. Do not use 
the Autorinse function with a liquid which differs substantially in 
transmittance from the last background analysis liquid. Always per-
form a background measurement with the current analysis liquid 
before analyzing samples.

Cause: Ultrasonic probing was requested when the liquid level was not at least 
primed.

Action: Fill the liquid sample handler with liquid before turning on the probe.
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6121- Error, Maximum number of overrange pixels was exceeded (X, X).

6125- The instrument <serial number> is not calibrated.

6128- Invalid deconvolution results.

6129- Sample (file name) already contains eight tests and cannot be used for an 
analysis.

6130- No data available in file <file name> for reporting.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics representative.

Cause: You started the application program, but no calibration files were 
found for the attached instrument.

Action: Run the Setup program and reinstall the calibration files.

Cause: The deconvolution was unable to create a valid particle size distribu-
tion from the collected intensity data.

Action A: Make sure enough sample was used in the analysis to provide good 
intensity data.

Action B: Measure a background to ensure that this information is still valid.

Cause: The analysis could not be started because the sample file contains the 
maximum eight tests allowed. The sample file has been removed from 
the schedule and replaced with an empty entry.

Action: Remove the empty entry. If desired, click Insert to create a replace-
ment entry and choose or create a new sample file. Click Start to 
restart the MasterTech schedule.

Cause: You requested that a report be generated on a sample containing no 
particle size data.

Action: Wait for the completion of at least one test, and then try again.
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6132- Warning, the default sample file does not request a rinse after analysis.

6133- Configured serial number does not match instrument.

6135- Detector Operation: Warning, beam center drive current adjusted from [nn.nn] 
to [nn.nn].

6136- Detector Operation: Error, beam center too large.

6137- Detector Operation: Error, beam center underrange.

Cause: You selected the QuickStart Autodetect mode of analysis, but the 
default sample file does not specify a rinse after analysis. This may 
result in repeated analyses of the same physical sample.

Action: Unless you plan to repeat the analysis on the same sample, cancel the 
QuickStart window. Access Sample defaults from the Options menu 
and specify to rinse after analysis. Then restart the QuickStart mode.

Cause: The instrument serial number specified for this unit during installation 
does not match the serial number recorded in the attached instrument. 

Action: Attach the correct instrument, or run the Setup program and install the 
calibration files for the correct instrument serial number. The instru-
ment serial number is located on the back panel of the analyzer.

Cause: Operating characteristics of the laser have changed since the last focus 
calibration.

Action: A new focus calibration is recommended. The analyzer will continue to 
function properly. Contact your local service representative.

Cause A: There is an obstruction or dirt in the optical path.

Action A: Remove the obstruction or clean the dirty lens or cell. Refer to Clean-
ing the Optics in Chapter 9 for instructions on cleaning the optics.

Cause B: A problem has developed in the laser or detector system.

Action B: Contact your local Micromeritics service representative.
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6138- Detector Operation: Error, beam center overrange.

6139- Detector: Temperature in calibration mode, temperature control disabled.

6140- Detector Operation: Error, temperature not in calibration mode.

6141- Detector Operation: Error, temperature calibration out of range (A/D: nnnn).

Cause: A problem has developed in the laser or detector system.

Action: Contact your local Micromeritics service representative.

Cause: A temperature calibration was performed on your analyzer and a prob-
lem has occurred.

Action: Contact your Micromeritics service representative.
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Unnumbered Messages

These messages display on the instrument schematic as yellow text on a red background in 
the area of their associated component.

Liquid Sample Handler

24Volt Failure
Thermal Overload

Laser

Filter Error: Sensors on
Filter Error: Sensors off

Laser disabled

Laser temperature invalid

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The front panel of the analyzer is open.

Action: Ensure that the front panel is completely closed before beginning an 
operation. If the message remains on the screen after closing the front 
panel, contact your local Micromeritics service representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.
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Laser temperature out of band

Laser thermal overload
Temperature control disabled

Test switch on

Rotation Arm

Rotator thermal overload

Cause: Instrument initialization is in progress.

Action: None required; the message will disappear after initialization is com-
plete. If the message should remain displayed on the screen after 
approximately 10 minutes, contact your local Micromeritics service 
representative.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: A manufacturing test switch was accidentally left turned on.

Action: None required; the message will disappear when the laser is activated.

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.
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Charge-Coupled Device (CCD)

CCD temperature invalid

CCD temperature out of band

Cause: An electronic failure has occurred.

Action: Contact your local Micromeritics service representative.

Cause: Analyzer initialization is in progress.

Action: None required; the message will disappear after initialization is com-
plete. If the message should remain displayed on the screen after 
approximately 10 minutes, contact your local Micromeritics service 
representative.
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B.  SAMPLE DISPERSION AND CONCENTRATION

Sample dispersion and concentration plays a vital part in obtaining accurate and reliable 
results. This appendix provides a discussion on dispersion techniques and sample concentra-
tion in relation to obtaining an appropriate beam obscuration for your sample.

Sample Dispersion 

Sample materials should be well dispersed in a liquid of known density and viscosity and the 
difference between the powder and liquid densities be accurately known. Viscosity and den-
sity data for some common liquids are given in Appendix D. Handbook values for other 
liquids are usually sufficiently accurate, so the latter requirement means that only the powder 
density must be determined if it is unknown and if composition information does not permit 
calculation from handbook values. For this, one of Micromeritics’ pycnometers is recom-
mended. 

The liquid should be one in which the powder can be completely dispersed (separated into 
unattached particles) for accurate size results to be obtained. Obviously, the liquid should be 
nontoxic, readily available, and one in which the sample is insoluble. Complete insolubility 
may be difficult to achieve in some instances. Solubility problems may be minimized by 
allowing the liquid to stand in contact with the particle material prior to using the liquid for the 
test sample. This cannot completely eliminate problems, however, because particle solubility 
is a function of particle size. Small particles are more soluble than large ones; in a dispersion 
of different sizes, the smallest particles tend to go into solution while precipitation occurs on 
the larger particles. 

There are no established rules or laws by which complete particle dispersion can be assured. 
Only guidelines can be offered. Some powders disperse easily in any of several liquids and 
remain so while others require careful attention to conditions in order to achieve dispersion 
and are prone to reagglomerate if conditions shift a small amount. A few can be dispersed only 
after extended treatments.

Agitation, resulting in the application of strong shear forces, aids dispersion. The more rigor-
ous the agitation — perhaps carried out in a high-speed blender, homogenizer, or an ultrasonic 
device — the better generally is the dispersion. Stirring a suspension while subjecting it to 
ultrasonic dispersion generally achieves the best dispersion because this ensures that all por-
tions of the mix are brought into the zones of greatest energy. For a few friable materials, such 
agitation can result in comminution of the particles for which measurements are desired. This 
is not likely to be the case with solid particles, particularly when the particles are under 50 to 
100 mm in diameter.

Air bubbles cause misleading results if trapped in the liquid during agitation. Care should be 
taken to avoid bubble entrapment, especially when the liquid is highly viscous. The Saturn 
DigiSizer performs bubble elimination routines and checks to verify their effectiveness, but 
the best agitation procedure is one that does not introduce them in the first place.
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Chemical wetting or dispersing agents also generally aid dispersion. A great variety of such 
products are marketed. Appendices C and E list some of the more useful dispersing aids, as 
well as sources for some of these materials. These agents have been found useful for particle 
dispersion in Micromeritics’ Materials Analysis Laboratory but are not the only agents avail-
able. 

Some commercial surfactants are intended for use in specific pH ranges and in particular non-
aqueous solutions. Slight solution composition differences may alter the effectiveness of any 
agent. The chemical supplier should be contacted about this type of problem. Sometimes 
merely shifting the pH of an aqueous dispersion will yield great improvements in the degree of 
dispersion. Metal oxides and metals that are likely to have oxide layers on their surface ordi-
narily are most easily dispersed in mildly alkaline media. Metal powders with any likelihood 
of grease on them should always be degreased prior to a dispersion attempt. Noble metal pow-
ders usually need a wetting agent for good dispersion. Dispersions involving hydrocarbon 
liquids that are immiscible with water are often difficult to make unless the powder is quite 
dry. Sometimes moisture picked up from the air is more than enough to cause difficulties.

Some powders flocculate upon standing a few moments after having been dispersed. Floccula-
tion, of course, prevents accurate particle size analysis, and better dispersion and stabilization 
techniques must be sought.

As a general guide, the best dispersing technique (includes agent and procedure) is the one 
producing consistently the finest distribution of sizes. We make this assertion because of the 
high reproducibility of the DigiSizer when presented identical samples. If the sample prepara-
tion technique is deficient in freeing particles one from another or if, though unlikely, it is 
producing particle fracture, this will be evidenced by an inconsistency of results.

The rheological behavior of high concentrations of fine powder in a liquid gives a good pre-
liminary indication of the suitability of both the liquid medium and the dispersing agent. Some 
powders containing as much as 50 percent liquid act as if they were almost a solid mass, but a 
few tenths of a percent of wetting agent can cause the mass to take on the consistency of soup. 
This reaction is indicative of a very good agent. The effect will not often be so dramatic, but 
working the mass with a spatula will give a good indication of the efficacy of an agent.

A test for the optimum quantity of a dispersing agent is conducted by measuring the sediment 
volume from a slurry of about 5 weight percent concentration. The slurry and agent must be 
mixed and allowed to stand in a sedimentation tube undisturbed by either mechanical vibra-
tions or thermal currents. The minimum sediment volume indicates the best agent 
concentration level. If several dispersing agents are compared at the same time, the minimum 
sediment volume is also a measure of the best dispersing agent.
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Sample Concentration

After you choose a sample file and click Next, a window showing the beam obscuration based 
on your sample’s concentration is displayed.

While observing the beam obscuration and concentration, gradually add your sample to the 
reservoir. Use the following guidelines for your sample concentration:

If your beam obscuration level is too high, the Adjust push buttons on the right side of the dia-
log can be used to add more liquid. If the Autodilute function is being used, concentration 
adjustment will be made automatically.

If your beam obscuration level is too low, simply add more sample. If the reservoir is too full, 
again you can use the Adjust push buttons to adjust the liquid level.

Listed below are some guidelines for sample concentration in relation to attaining an appropri-
ate beam obscuration for various sized particles.

Expected Mean Particle Diameter
(micromerters)

Recommended Beam Obscuration
(%)

Less than 0.1 4

0.1 to 1 5 to 10

1 to 10 10 to 20

10 to 100 20 to 30

100 to 1000 30 to 45
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Small Particles and Multiple Scattering 

Analysis of small particles (<1 micrometer diameter) is subject to errors caused by multiple 
scattering, that is light scattered by one particle striking another particle and being scattered 
again. This effect increases as sample concentration increases, and causes the particle size to 
appear smaller than it is. 

To test for this:

1. Perform an analysis in the recommended beam obscuration range. Run two or more tests 
to ensure the results are repeatable, indicating that the dispersion is stable.

2. Dilute the sample to a lower beam obscuration, for instance 2% below the first beam 
obscuration. This is accomplished by clicking Adjust level to primed and observing the 
reduction in beam obscuration. Repeat as needed until the desired beam obscuration is 
achieved.

3. Perform another analysis of two or more tests and compare the results to the earlier tests. 
If the lower beam obscuration produces a significantly larger mean particle size, then 
significant multiple scattering may have occurred with the original concentration. Repeat 
these steps to determine the obscuration at which there is no significant multiple 
scattering. 

Note that analyzing with beam obscuration of less than 5% is not recommended, since there 
may not be enough scattered light for an accurate measurement. Running a background analy-
sis shortly before introducing sample may improve results from a low beam obscuration 
analysis.

Medium Size Particles

For particles in the range of 1 to 100 micrometers diameter, it is ideal to use a high enough 
sample concentration that the Goodness of Fit Report shows the measured intensities level out 
at smaller scattering angles before decreasing as scattering angle increases. This clearly 
defines the maximum particle size present. This can be important in detecting dispersion prob-
lems indicated by the apparent presence of larger than expected sizes.

Large Particles

For particles greater than 100 micrometers in diameter, relatively few particles are required to 
achieve a given beam obscuration. For this reason using a higher sample concentration can 
improve repeatability by increasing the number of particles, thus improving the sampling sta-
tistics and presenting a more representative sample of the material.
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C.  CHEMICAL AIDS FOR PARTICLE DISPERSION

Data extracted from McCutcheon’s Detergents and Emulsifiers, McCutcheon Division, MC Publishing 
Co., Glen Rock, NJ, 1980.

Name Type Active Ingredient

Aerosol 22 Anionic Tetrasodium N-(1,2-dicarboxyet hyl)-N-
octadecysulfosuccinanate, 35%

Aerosol OT Anionic Dioctyl ester of sodium sulfosuccinic acid, 70%

Atlas G-3300 Anionic Amine salt of alkylaryl sulfonate

Calcium Chloride Cationic CaCl2

Calgon Anionic Sodium hexametaphosphate, unadjusted

Calgon T Anionic Part of sodium replaced by other cations, predominantly zinc

Cobaltous Chloride Cationic CoCl2

Cobalt Citrate Anionic Co3(C6H5O7)2

Daxad 23 Anionic Sodium salts of polymerized substituted benzoid alkyl sulfonic 
acid (alkyl, long chain), 84.5%

Daxad 30 Anionic Sodium salt of polymerized carboxylic acid, 25%

FC-134 Cationic Fluorochemical surfactant

FC-161 Anionic Fluorochemical surfactant

FC-170 Nonionic Fluorochemical surfactant

Igepal CO-530 Nonionic Nonylphenoxypoly (ethyleneoxy) ethanol, 100%

Oleic Acid Anionic CH3(CH2)7CH=CH(CH2)7COOH

Renex 648 Nonionic Ethoxylated nonylphenol, 100%

Sodium Silicate Anionic Na2SiO3

Triton X-100 Nonionic Octyl phenoxy polyethoxy ethanol, 100%

Tamol SN Anionic Sodium salt of condensed naphthalene sulfonic acid, 100%

TSPP Anionic Tetrasodiumpyrophosphate, Na4P2O7

Twitchell Base 8240 Anionic Sodium salt of low molecular weight, sulfonated oil, parafin oil, 
water, and diethylene glycol

Tween 20 Nonionic Polyoxyethylene Sorbitan monolaureate (polysorbate 20), 100%

Zonyl S-13 Anionic Fluoroalkyl phosphate

Zonyl A Nonionic Ethylene oxide-ester condensate
520-42805-01 (Rev H) - Nov 2018                                             C-1 



 



Saturn DigiSizer II 5205 Appendix D
D.  LIQUID DENSITY AND VISCOSITY DATA

Listed below are density and viscosity of pure liquids and solutions (aqueous, by weight) as 
functions of temperature at atmospheric pressure.  

Liquid or Solution Temperature 
(ºC)

Density
 (g/cm3)

Viscosity 
(mPas)

Ethanol (absolute) 25
30
35

0.7851
0.7808
0.7764

 1.096
 1.003
 0.914

Ethylene Glycol 25
32
40

1.1100
1.1051
1.0995

 16.10
 12.18

9.13

Glycerol (10%) 25
30
35

1.0206
1.0192
1.0178

 1.1530
 1.0240
 0.9150

Glycerol (20%) 25
30
36

1.0452
1.0436
1.0400

 1.5430
 1.3590
 1.1743

Glycerol (40%) 25
30
35

1.0970
1.0948
1.0926

 3.1860
 2.7280
 2.3400

Glycerol (50%) 25
30
35

1.1238
1.1211
1.1182

 5.041
 4.247
 3.540

Hexane (n) 25
30
35

0.6550
0.6504
0.6459

 0.3046
 0.2900
 0.2828

Isopropanol 30
32
35

0.7769
0.7752
0.7728

 1.7800
 1.6800
 1.5400

Sucrose (20%) 20
30
40

1.0810
1.0777
1.0737

 1.945
 1.493
 1.184

Sucrose (30%) 20
30
40

1.1270
1.1232
1.1189

 3.187
 2.373
 1.833

Sucrose (40%) 20
30
40

1.1765
1.1721
1.1676

 6.167
 4.375
 3.241

Sucrose (50%) 20
30
40

1.2296
1.2250
1.2200

 15.43
 10.11

 6.991
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Data extracted from (with interpolation in some cases):

Honig, P., Principles of Sugar Technology, p. 31, Elsevier Publishing Co., New York, 1953.

Swindells, J.F., Snyder, C.F., Hardy, R.C. and Golden, P.E., Viscosities of Sucrose Solutions at 
Various Temperatures: Tables of Recalculated Values, Supplement to N.B.S. Circular 440, 
U.S. Government Printing Office, Washington, 1958.

CRC Handbook of Chemistry and Physics, 59th Edition, The Chemical Rubber Co., 
Cleveland, OH, 1978-79.

The Merck Index, 9th Edition, Merck & Co., Rahway, NJ, 1976.

Liquid or Solution Temperature 
(ºC)

Density
 (g/cm3)

Viscosity 
(mPas)

Water 26
32
38

0.9968
0.9951
0.9930

 0.8737
 0.7679
 0.6814

n-Butanol 25
32
40

0.8058
0.8003
0.7940

 2.59
 2.18
 1.78
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E.  SOURCES OF DISPERSING AIDS

Dispersant Source

Aerosol OT
Aerosol 22

American Cyanamid Company, Process Chemicals Department, One-T 
Cyanamid Plaza, Wayne, NJ 07470

Calcium Chloride Can be purchased at most laboratory supply houses.

Calgon
Calgon T

Calgon Corporation, Water Management Division, Calgon Center, P. O. Box 
1346, Pittsburgh, PA 15230

Cobalt Citrate Shepherd Chemical Company, Cincinnati, OH 45212

Cobaltous Chloride Can be purchased at most laboratory supply houses.

Daxad 23, 30 Hampshire Chemical Corporation, 55 Hayden Avenue, Lexington, MA 
02173

Dispex 40 Allied Colloids, 2301 Wilroy Road, Suffolk, VA 23434

FC-134, -161 and -170 3M Company, Chemical Division, 

St. Paul, MN 55141

Igepal CO-530 GAF Corporation, 1361-T Alps Road, Wayne, NJ 07470

Lomar D Henkel, 300 Brookside Avenue, Ambler, PA 19002

Oleic Acid Can be purchased at most laboratory supply houses.

Renex 648
Tween 20
Atlas  G-3300 

ICI Americas, Inc., Chemical Division, New Concord ville Pike, 
Wilmington, DE 19897

Triton X-100
Tamol SN

Rohm and Haas Company, Independence Mall West, Philadelphia, PA 19105

Sodium Silicate 
“N” Brand

Philadelphia Quartz Company, 1301-T E. Fort Avenue, Baltimore, MD 
21230

Tetrasodium
Pyrophosphate (TSPP)

Can be purchased at most laboratory supply houses.

Zonyl A, S-13  E. I. DuPont de Nemours and Company, Dyes and Chemical Division, 1000-
T Market Street, Wilmington,  DE 19898
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F.  DATA REDUCTION

The volume frequency data corresponding to standard size parameter classes is derived by 
deconvolution. The particle size for each class is derived by multiplying its size parameter 
by the wavelength of light produced by the laser in each instrument. The volume 
frequency data are expressed as a fraction of the total. 

The reference for calculation of various statistics is the ASTM Manual on Presentation of 
Data and Control Chart Analysis, Sixth Edition, by American Society for Testing and 
Materials. Other calculations have references as noted.

In the following calculations, log() always refers to log base 10. ln() refers to natural log.

Scattering Model Generation

Mie and Fraunhofer Calculations

Scattering models are theoretically derived patterns of light scattered by ideal, spherical 
particles of a known refractive index, based on Mie theory. The refractive index of the 
particle relative to the surrounding medium and the ratio of the diameter of the particle to 
the wavelength of the light are the two distinguishing parameters for each pattern. A 
simpler, diffraction-only Fraunhofer theory can also be used; it is independent of 
refractive index. The algorithms used for performing the Mie and Fraunhofer calculations 
as well as description of the theories are found in Absorption and Scattering of Light by 
Small Particles by Bohren and Huffman.

Volume Normalization

The Mie and Fraunhofer calculations give scattered light intensities and extinction 
coefficient for an individual particle. These intensities are normalized by particle volume 
so that all stored patterns are for a unit volume of sample.

Polarization

The calculations provide scattered intensities for light polarized parallel to and 
perpendicular to the polarization of the incident light. These two components are recorded 
separately. At the time the model is used, they are combined based on the polarization of 
the laser in the instrument.

Size Parameters

Models are calculated for a standard set of size parameters, or ratios of particle diameter to 
wavelength. The actual diameters represented must be calculated by multiplying the size 
parameter by the wavelength produced by the laser in each instrument.
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Size Subclasses

Each size class represents a continuum of sizes spanning the class interval. The Mie and 
Fraunhofer algorithms calculate a pattern for a single, discrete size. A representative 
scattering pattern for each class is computed by a weighted average of scattering patterns 
for different sizes spanning the class, called subclasses. The interval between the 
subclasses is 1/4 the interval between size classes. In addition to the five subclasses 
spanning the class interval (including both ends of the interval), the nearest subclass in 
each adjacent class interval is included for a total of seven subclasses combined in each 
class. This provides a fairly smooth transition in size class patterns. The patterns are 
combined using a cosine2 weighting function, with coefficients of 
{0.1464,0.5,0.8536,1.0,0.8536,0.5,0.1464}.

Angle Subclasses

Each angle class represents a continuum of angles spanning the class interval. The Mie 
and Fraunhofer algorithms calculate scattered light intensity for a set of discrete angles. 
An average intensity for each angle class must be computed by averaging over its angle 
interval. Scattering patterns for large particle sizes contain very high frequency changes in 
intensity with angle, requiring averaging over many discrete angles to compute an 
accurate average intensity. Patterns for small particle sizes have much less detail and 
require fewer discrete angles for accurate averaging. 

For averaging, each angle subclass intensity is weighted by its fraction of the total area 
subtended by the angle class, which is proportional to the cosine of the angle.

Scattering Vector

Plotting the scattered intensity data versus the magnitude of the scattering vector q is 
useful for comparing data on scattering independently of the scattered wavelength:

where

N = refractive index of surrounding medium
 = wavelength of light in a vacuum
 = scattering angle

q
4N


----------- 
    


2
--- 
 sin=
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Deconvolution

Deconvolution is the process of determining what distribution of scattering models for 
different size classes provides the best fit to the measured scattered intensity data for a 
sample. The inputs to deconvolution are a set of scattering models for different size classes 
and a set of measured scattered intensity vs. angle data. The output is a volume frequency 
distribution by size class that best fits the measured intensity data. 

The best fit is determined by a weighted, regularized nonnegative least squares method 
which minimizes |Ax - b| where A is a matrix of scattering models and regularization 
constraints, b is the measured intensity pattern, and x is the size distribution resulting from 
the fit. The matrix A and vector b are modified to weight the contribution of error for each 
measured intensity.

After A and b are constructed, the nonnegative least squares fit (NNLS) is performed as 
described in Solving Least Squares Problems, C.L.Lawson and R.J.Hanson, Prentice-
Hall,1974, p.160, with modifications described below.

Angle Classes and Size Classes

Each angle class with measured intensity data is included in the deconvolution. 

For each scattering model at one of the predefined size classes, a minimum amount of 
intensity data for the first lobe of the scattering pattern is required in order to characterize 
adequately the scattering model for that size class. This is expressed as the Minimum 
Fraction of First Lobe Classes.

For a given size class, let M be the index of the angle class where the first minimum in the 
intensity pattern occurs. 

Let N be the first angle class for which significant intensity data was measured, i.e. the 
first angle class with a Signal Fraction greater than or equal to the Minimum Significant 
Signal Fraction.

Then if (M - N) / M is greater than or equal to the Minimum Fraction of First Lobe 
Classes, the class is included. The largest size class satisfying this criterion is the largest 
class to be used in deconvolution, or the Maximum Size Class. The number of classes 
from this class to the smallest size class (inclusive) is the Number of Size Classes.

If the number of measured intensity data points is less than the Number of Size Classes, 
the Minimum Size Class is increased to make the number of intensity data points and the 
Number of Size Classes equal.
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Regularization

The result of the NNLS deconvolution is regularized by adding an additional set of 
constraints to minimize the second derivative of the solution vector (the frequency 
distribution). These constraints are weighted by an overall regularization parameter 
(RegParam = RegParamHigh, RegParamMed, or RegParamLow) based on the user input 
degree of smoothing from the Material Properties dialog. The regularization constraints 
form a tridiagonal submatrix appended to the matrix A as extra rows, with corresponding 
0’s in b. If there are M angle classes and N size classes, for angle class j and size class k:

   

using A k,-1 = A k,M = 0

AM+k,k-1 = Gk for k>0

AM+k,k = -2 x Gk

AM+k,k+1 = Gk for k>N

AM+k,i = 0 for all other i

bM+k = 0

Modifications to NNLS

After A and b are constructed as above, NNLS is performed as described in Lawson and 
Hanson with the following modifications:

Maximum Number of Iterations

A maximum number of iterations are performed before the result is returned.

Check for Repeats

After each iteration, the result is checked against each of the most recent iterations. If it is 
identical to any of them, the process is stopped and the result returned.

Fk  Ak j 1– 2 Ak j Ak j 1++– 2

j
=

Gk RegParam 1
Fk
-----ln=
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Dual Vector 

The dual vector in NNLS steps 2,3,4 is calculated for largest step size rather than for 
steepest descent. After vector w is calculated as in step 2, it is modified:

To shorten computation time by eliminating the addition of size classes that make an 
insignificant contribution, w j is tested against a cutoff value greater than 0:

where

DualThresh= the Dual Vector Threshold and the maximum intensity values 
as defined above.

Nonnegative Tolerance Parameter 

A Nonnegative Tolerance Parameter (referred to as Tau in L&H p.80-81) is used.

Also, this value times the sum of the solution vector is used instead of 0 as the lower limit 
for nonnegative elements in the solution vector (p.161 step 7).

Weighted Residual

The contribution of an individual intensity error to the total error or residual of the least 
squares fit is weighted by the fraction of the total intensity signal due to scattering (as 
opposed to background), and by the magnitude of the intensity:

Weighted Residual = 

wj

wj

Eij Eij 2
-----------------------------------=

cutoff DualThresh MaxModelIntensity
100

MaxIntensity
-----------------------------------=

Wi

ISCATi

ITOTi

----------------
 
 
  2

 ISCATi
  0.7–

=

ESQi
Wi

ISCATi
IFITi

–

IFITi

----------------------------------
 
 
  2

=

100 
ESQi
Wi

-------------------

 
 
 
  0.5
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where

Wi = weighting factor for intensity point i
ISCATi = scattered intensity for point i
ITOTi = total intensity (scattered plus background) for point i
IFITi = model fit intensity for point i
ESQi = error squared for point i
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Input Quantities

Standard Particle Size Classes and Standard Size Parameter Classes

For the predefined size classes:

The diameter interval bounds are spaced geometrically and the average diameter for each 
interval is the geometric mean of the high and low diameters of the interval. The low 
diameter for one interval or class is the high diameter for the next interval or class. For a 
diameter range of 0.1 to 1000.0 and 40 classes per decade:

ClassFact= ratio between adjacent class 
= ratio between adjacent class averages 
= 101/40 = 1.05925372518

The ratio between a class average and either of its class bounds is 

1.059253725181/2 = 1.0292005272

The average diameter array has 193 elements:

AvgDiam[193] =  {0.040,0.042,0.045,0.047,0.050,0.053...,1883.6,1995.3,2113.5, 
2238.7,2371.4,2511.9}

The diameter interval array has 173 elements: 

IntvlDiam[152] = {0.039,0.041,0.043,0.046,0.049,0.052,...,1938.7,2053.5,2175.2, 
2304.1,2440.6,2585.2}

For a laser of the nominal wavelength, these particle size classes correspond to the size 
parameter classes for which the scattering models are generated and the deconvolution 
performed. Since all lasers will not have the nominal wavelength, a frequency distribution 
based on the standard particle size classes must be interpolated from the deconvolution 
distribution, which is based on the sizes derived from the actual laser wavelength and the 
standard size parameters:

ParticleDiameter = SizeParameter x Wavelength
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High/Low Diameter and Average Diameter

For the standard size classes:

Average Diameter is taken directly from the standard size class Average Diameter array 
AvgDiam[] above.

The High and Low Diameters for class i are:

HighDiami = IntvlDiam[i]
LowDiami  = IntvlDiam[i-1]

For user entered size tables:

The user entries are used as the IntvlDiam array as above, with the HighDiam and 
LowDiam values assigned from it. Note that there is always one less size interval than the 
number of entries in IntvlDiam.

AvgDiami is the geometric mean of HighDiami and LowDiami = 

(HighDiami x LowDiami)1/2
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Standard Sieve Sizes

ASTM E-11 standard sieve sizes and a few common sizes are used.

Sieve Number 
(in.)

Aperture Size
(m)

Sieve Number 
(in.)

Aperture Size
(m)

5 125000 No. 8  2360

4.24 106000 No. 10 2000

4 100000 No. 12 1700

3 1/2 90000 No. 14 1400

3 75000 No. 16 1180

2 1/2 63000 No. 18 1000

2.12 53000 No. 20 850

2 50000 No. 25 710

1 3/4 45000 No. 30 600

1 1/2 37500 No. 35 500

1 1/4 31500 No. 40 425

1.06 26500 No. 45 355

1 25000 No. 50 300

7/8 22400 No. 60 250

3/4 19000 No. 70 212

5/8 16000 No. 80 180

0.530 13200 No. 100 150

1/2 12500 No. 120 125

7/16 11200 No. 140 106

3/8 9500 No. 170 90

5/16 8000 No. 200 75

0.265 6700 No. 230 63

1/4 6300 No. 270 53

No. 3 1/2 5600 No. 325 45

No. 4 4750 No. 400 38

No. 5 4000 No. 450 32

No. 6 3350 No. 500 25

No. 7 2800 No. 635 20
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Graph Particle Size Intervals

The predefined standard particle size classes are always used in computing quantities for 
graphs. For merged or entered data, the extra data are shown at the intervals for which it 
was entered, except for the frequency data for which the predefined classes are extended 
to the range needed to make sure that all the frequency classes are of the same width. 

Interpolation

All interpolation is performed using the Akima semi-spline routine. Refer to BASIC 
Scientific Subroutines Vol. II, by F.R.Ruckdeschel, Copyright 1981 BYTE Publications/
McGraw Hill, p. 305. If the quantity to be used as either axis is a size quantity (diameter), 
the interpolation should be done on a log scale for that axis.

Merged Data

Merged data entries pre-empt compatible collected data; for example if overlap occurs, the 
merged data are reported and the overlapping sizes from the collected data are discarded. 

If sieve size data are entered for the merged data, the aperture size of the smallest sieve 
size used will not in general fall on a standard particle size class boundary. A `pbridge’ 
class must be constructed in this case extending from the minimum sieve aperture size to 
the next lower standard size class boundary. If the resulting class would be less than half 
the width (on the log diameter scale) of a standard size class, it is combined with the next 
lower standard size class which becomes the `bridge’ class. A cumulative coarser value is 
interpolated at the minimum aperture size from the collected data, which becomes the 
cumulative coarser value for the `bridge’ class. The frequency for the `bridge’ class can 
then be calculated from the cumulative coarser curve in the normal way. The `bridge’ class 
is treated as a collected data class for purposes of subsequent scaling and reporting.

If Autoscale percent/fraction of total sample is enabled on the Collected Data/ Merge Data 
dialog, the region of overlap between merge data and collected data is determined, and a 
scale (which is equal to the total frequency of the merged data in the overlap region over 
the total frequency of the collected data in the overlapped region) factor is determined. 
The collected data are then scaled by this factor. Finally, the frequency data over the whole 
range is rescaled to the total fraction accounted for by the merged data. All this is done in 
the Frequency fraction determined by the user (Volume/Area/Length/Number).

If Autoscale percent/fraction of total sample is disabled on the Collected Data/ Merge 
Data dialog, the entered percentiles/fractions for the merged data are used as is and the non 
overlapping portion of the collected data is scaled to be the percent/fraction passing the 
smallest sieve size used.
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Fundamental Quantities

Distribution Type (Volume, Area, Length, Number)

The base distribution data provided by the deconvolution is volume frequency fraction. 
Conversion of the distribution to area, length, or number is as follows for each size class:

or to convert back to Volume percent based on the others, 

These Formulae will automatically normalize the Frequency fractions to 100%. If there 
exists merged or entered data, the user may have chosen not to have this add up to 100%. 
If this is the case, a conversion into the style (Vol/Area/Len/Num) that he has chosen will 
also cause a rescaling to his chosen percentage, A conversion into a different style will 
automatically be rescaled to 100%. This affects the cumulative percentage as well as 
things like median diameter which are based on cumulative coarser. For distribution 
statistics, there is an implicit rescaling to 100%. 

Subsequent calculations based on the frequency distribution do not vary based on 
Distribution Type; therefore the formulas reference FreqFrac without specification of 
Distribution Type. 

AreaFreqFrac
VolFreqFraci / AvgDiami

VolFreqFrack / AvgDiamk
----------------------------------------------------------------------------=

LenFreqFraci

VolFreqFraci / AvgDiami 
2

VolFreqFrack / AvgDiamk 
2


--------------------------------------------------------------------------------=

NumFreqFraci

VolFreqFraci / AvgDiami 
3

VolFreqFrack / AvgDiamk 
3


--------------------------------------------------------------------------------=

VolFreqFraci

AreaFreqFraci / AvgDiami

AreaFreqFrack / AvgDiamk
-------------------------------------------------------------------------------=

VolFreqFraci

LenFreqFraci / AvgDiami 
2

LenFreqFrack / AvgDiamk 
2


--------------------------------------------------------------------------------=

VolFreqFraci

NumFreqFraci / AvgDiami 
3

NumFreqFrack / AvgDiamk 
3


-----------------------------------------------------------------------------------=
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Particle Size (Diameter/Radius)

Any particle size quantity or derived quantity having the same units can be expressed as 
radius or diameter.

Radius = Diameter / 2

Quantities include:

• Mean
• Mode
• Median
• Standard deviation (of the distribution)
• Confidence limits
• Size at User Defined Percentiles
• User Defined Sizes
• High particle size 
• Low particle size
• Average particle size
• Standard deviation for [n] tests of any of the above quantities

Percent/Fraction

Any cumulative quantity, frequency quantity, percentile, or derived quantity having the 
same units can be expressed as percent or fraction.

Pct = 100 x Frac

These include:

• Maximum Out of spec
• User Defined Percentiles 1 to 5
• Percent at User Defined Sizes 1 to 5
• Peak Report Minimum percent to report
• Peak Report Percent of distribution
• Cumulative Coarser/Finer
• Frequency
• Difference from reference
• Out of spec
• Standard deviation for [n] tests of any of the above quantities

Other quantities (Sample concentration, Beam obscuration) are calculated or stored as 
fractions but reported as percent.
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Cumulative Coarser/Finer, Retained/Passed

Any cumulative quantity can be expressed as Coarser or Finer (Retained or Passed on 
Tabular Report by Sieve Size).

For data defined by the standard class sizes (Summary, Tabular Defined by Size Class, 
Graphs):

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

 for all classes k such that AvgDiamk >

AvgDiami

or, equivalently

CumFracFineri = 1.0 - CumFracCoarseri-1 

CumFracRetaini = CumFracCoarseri-1 

CumFracPassi = 1.0 - CumFracCoarseri-1 

For Tabular Defined by Size Table or by Sieve Sizes:

CumFrac (Coarser or Finer, Retained or Passed) is calculated for the standard size classes 
as defined above. CumFrac is then interpolated from CumFrac vs. Particle Size at each 
Particle Size in the Size Table or Aperture Size in the Sieve Table.

CumFracCoarseri FreqFrack=

CumFracFineri FreqFrack=

CumFracRetaini FreqFrack=

CumFracPassi FreqFrack=
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Frequency

Frequency is always calculated for a class. It is always the difference in the 
CumFracCoarser at the upper bound and the lower bound of the class. If this is a standard 
class, it is calculated as follows

FreqFraci = CumFracCoarseri-1 - CumFracCoarseri

If it is not a standard class, The value of CumFracCoarser is interpolated at the two 
endpoints. 

User-Entered Percentile Size

If the UserPctn is larger then the total percentage accounted for by any merged or user 
entered data, then “ ***** ” is printed.

UserPctDiamn = Diameter interpolated from HighDiami vs. CumFracCoarseri at 
UserPctn

User-Entered Size Percent

UserDiamFracn = CumFracCoarser interpolated from CumFracCoarseri vs. 
HighDiami at UserDiamn

Peak Report Quantities

DiffFreqFraci = FreqFraci / log(HighDiami / LowDiami )

Starting at the small particle size end of the frequency distribution,

1. Scan DiffFreqFraci for a local maximum, i.e. DiffFreqFrack > DiffFreqFrack+1  and 
DiffFreqFrack > DiffFreqFrack-1 

AvgDiamk is the mode of the candidate peak.

2. If an unresolved peak remains from step 3 of the preceeding peak, the LowDiam from 
that unresolved peak is the LowDiam for this candidate peak. Otherwise, scan 
DiffFreqFraci from class k toward smaller particle sizes to find a local minimum, 

i.e. DiffFreqFracm  = 0  

or  DiffFreqFracm < DiffFreqFracm+1  and  DiffFreqFracm < DiffFreqFracm-1 

If DiffFreqFracm < (DiffFreqFrack* Minimum Peak Valley Decrease),LowDiamm is 
the LowDiam of the candidate peak. Otherwise, this is an unresolved peak and will 
be added to the previous peak.
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3. Scan DiffFreqFraci from class k toward larger particle sizes to find a local minimum, 

i.e.  DiffFreqFracn  = 0  

or  DiffFreqFracn < DiffFreqFracn+1  and  DiffFreqFracn < DiffFreqFracn-1 

If DiffFreqFracn < (DiffFreqFrack* Minimum Peak Valley Decrease), HighDiamn is 
the HighDiam of the candidate peak. Otherwise, this is an unresolved peak and will 
be added to the next peak. Record the LowDiam for this unresolved peak for use on 
the next peak and repeat from step 1.

4. Sum values of FreqFraci from i=m to i=n, but include only half of the FreqFrac 
values for end classes m and n. This is to split the frequency data between two 
adjacent peaks. 

If this is an unresolved peak as determined in step 2, add the sum to the Fraction of 
Distribution for the preceding peak and set the preceding peak’s HighDiam to n. 

Otherwise, if the sum is greater than or equal to the Minimum Fraction to Report, the 
candidate peak is qualified and the sum is the Fraction of Distribution. Other peak 
quantities are calculated using the same formulas as for the entire distribution, except 
only the range from class m to class n is used.

Otherwise, the candidate peak is disqualified.

5. In either case, peak identification repeats from step 1, starting with class n. When the 
end of the distribution is reached by scanning in either step 1 or step 3, peak 
identification is complete.

NOTES: 

In step 1 if the end of the distribution is reached on an increasing frequency slope, i.e. 
DiffFreqFrack > DiffFreqFrack-1, then class k is treated as the mode of a candidate peak 
and as the high size end of the candidate peak.

If the beginning or end of the distribution is reached while scanning for a local minimum 
in step 2 or step 3, the beginning or ending class is treated as the local minimum.

For calculating Standard Deviation for N Tests, peaks from the various tests are simply 
matched by their order, i.e. Peak 1 from Test 1 is matched with Peak 1 from Test 2, etc.. If 
all tests do not have the same number of peaks, Standard Deviation for N Tests is reported 
as “N/A.” If the peak numbers are not the same, and the user chose average of n tests. A 
single row is filled in with all N/A (including the peak number). 
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Size Statistics

Standard Deviation of Quantity for N Tests

For Quantity, substitute the variable name for which the standard deviation is being 
determined. The subscript k refers to the test number.

If NumTests <= 1, StdDevTestQuantity = 0. Else:

Mode

For a mode calculation, the definition of the standard classes is extended over the range of 
input for all the data; frequencies are calculated for these classes. It is this frequency data 
that are used in determining the peak quantities so that all the classes are of the same 
width.

ModeDiam = AvgDiami such that DiffFreqFraci is the maximum DiffFreqFrac

Median

MedianDiam = Diameter interpolated from HighDiam vs. CumFracCoarser at 
CumFracCoarser = .5. If the calculation is being done on a peak, the interpolation point is 
at CumFracCoarser = (CumFracCoarserm + CumFracCoarsern)/2.

MeanTestQuantity
Quantityk

NumTests
---------------------------------=

StdDevTestQuantity
Quantityk MeanTestQuantity– 2

NumTests 1–
-----------------------------------------------------------------------------------------------------=
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Arithmetic Calculations

Standard Deviation (of the distribution):

Standard Deviation (of the distribution):

Coefficient of Variation:

Skewness:

Kurtosis:

+x 

where x is the user-selected number.

–x 

where x is the user-selected number.

MeanDiam
FreqFraci AvgDiami

FreqFraci
-----------------------------------------------------------------=

StdDevDiam
FreqFraci (AvgDiami MeanDiam 2–

FreqFraci
-------------------------------------------------------------------------------------------------------=

CoefVar StdDevDiam
MeanDiam

----------------------------------=

Skew
FreqFraci (AvgDiami MeanDiam 3 / FreqFraci–

FreqFraci (AvgDiami MeanDiam 2 / FreqFraci– 
3/2

---------------------------------------------------------------------------------------------------------------------------------------------------------=

Kurt
FreqFraci (AvgDiami MeanDiam 4 / FreqFraci–
FreqFraci (AvgDiami MeanDiam 2 / FreqFraci– 

2
----------------------------------------------------------------------------------------------------------------------------------------------------- 3–=

PlusNSig MeanDiam x StdDevDiam+=

MinusNSig MeanDiam x StdDevDiam–=
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Geometric Calculations

Mean:

GeoMeanDiam = 10  

Standard Deviation (of the distribution):

Standard Deviation of Log (size):

Skewness of Log (size):

Kurtosis of Log (size):

+x:

where x is user-selected number.

–x:

where x is user-selected number.

FreqFraci  AvgDiami log
F reqFraci

-----------------------------------------------------------------------------

GeoStdDevDiam 10
StdDevLogDiam

=

StdDevLogDiam
FreqFraci AvgDiami  GeoMeanDiam log–log 2

FreqFraci
---------------------------------------------------------------------------------------------------------------------------------------------=

SkewLog
FreqFraci AvgDiami  GeoMeanDiam log–log 3 / FreqFraci

FreqFraci AvgDiami  GeoMeanDiam log–log 2 / FreqFraci 
3/2

-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

KurtLog
FreqFraci AvgDiami  GeoMeanDiam log–log 4 / FreqFraci
FreqFraci AvgDiami  GeoMeanDiam log–log 2 / FreqFraci 

2
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 3–=

PlusNSigLog 10
GeoMeanDiam  x log(GeoStdDevDiam+ log

=

MinusNSigLog 10
GeoMeanDiam   x–  log(GeoStdDevDiam log

=
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Material Formulae

Relative refractive index

Relative refractive index is the complex quotient of the complex Particle refractive index 
and the real Analysis Liquid refractive index:

Sample Concentration

This is calculated exclusively for the collected and deconvoluted data.

BeamObscuration is obtained from collected data.

BeamLengthm = 5000
ExtCoefi = extinction coefficient for size class i, available from scattering model

Specific Surface Area

This is calculated exclusively for the collected and deconvoluted data.

ParticleDensity is obtained from the Material Properties.

RelRefIdx Re  ParticleRefIdx Re 
LiquidRefIdx

---------------------------------------------------=

RelRefIdx Im  ParticleRefIdx Im 
LiquidRefIdx

---------------------------------------------------=

ConcFrac BeamObscuration log

 
3
2
--- BeamLengthm 

ExtCoefiVolFreqFraci / AvgDiami
VolFreqFraci

-------------------------------------------------------------------------------------------------–

-------------------------------------------------------------------------------------------------------------------------------------------------------------=

SurfArea

6 
VolFreqFraci / AvgDiami 

VolFreqFraci
---------------------------------------------------------------------------

Particle Density
--------------------------------------------------------------------------------------=
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Specification/Reference Quantities

Out of Spec

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution.

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Coarse Specification distribution interpolated if the bins are of different size. This is 

always the average of all the tests in that sample file1.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Fine Specification distribution interpolated if the bins are of different size. This is always 
the average of all the tests in that sample file*.

If { SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFracCoarseri-1 

Else if { SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1 }

OutSpecFracCoarseri = SampCumFracCoarseri-1  - FineSpecCumFracCoarseri-1 

Else  OutSpecFracCoarseri = 0

or 

OutSpecFracFineri = -OutSpecFracCoarseri-1 

OutSpecFracRetaini = OutSpecFracCoarseri-1 

OutSpecFracPassi = -OutSpecFracCoarseri-1 

Difference from Reference

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Reference Specification distribution interpolated if the bins are of different size. This is 
always the average of all the tests in that sample file*.

DiffRefCoarseri = SampCumFraci - RefCumFraci

1 Always using the average of the tests in reference files is done so 
that printing out reports on a file will not affect its use as a reference.
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or

DiffRefFineri = -DiffRefCoarseri-1 

DiffRefRetaini = DiffRefCoarseri-1 

DiffRefPassi = -DiffRefCoarseri-1 

Maximum Out of Spec

MaxOutSpecFrac = maximum (abs value (OutSpecFraci ) )

Pass/Fail by Specification

If MaxOutSpecFrac = 0

PassFail = “PASSED by Specification”

ElsePassFail = “FAILED by Specification”
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SPC Report Variables

Regression Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares 
method. Refer to BASIC Scientific Subroutines Vol. II, by F.R.Ruckdeschel, Copyright 
1981 BYTE Publications/McGraw Hill, p. 16. If there is only a single point, or all N points 
have the same x-value, there can be no line of best fit in the standard form.

The coefficient of Correlation for this line is also calculated in the usual way. Refer to 
Mathematical Handbook for Scientists and Engineers, by Granino A Korn, and Theresa 
M. Korn, Copyright 1961, 1968 McGraw Hill, Sec 18.4.

Xave
xi

N
------------=

Yave
yi

N
------------=

Slope
Sum xi XAve–  yi YAve– 

xi XAve– 2
--------------------------------------------------------------------------=

x

xi XAve– 2
N

----------------------------------------=

y

yi YAve– 2
N

----------------------------------------=

Cov x y 
xi XAve–  yi YAve– 

N
---------------------------------------------------------------------=

CorrelationCoef Cov x y 
xy

------------------------=
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Control Chart Variables

Mean
yi

N
------------=

StdDev
y Mean– 2
N 1–

--------------------------------------=

CoefVaar StdDev
Mean

-------------------=

PlusNSig Mean n StdDev+=

MinusNSig Mean n StdDev–=
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G.  FORMAT OF EXPORTED DATA

This appendix gives the format for sample files exported in ASCII text. All character 
strings are delimited with quotation marks; columns are separated with a comma and 
white space.

The following types of data can be exported:

• Particle Size
• Intensity

Particle Size Data

Record
Number Information Conveyed Form

1 File status
1 = complete
2 = analyzing
4 = entered
8 = no analysis

integer

2 Sample identification quoted string
(40 characters)

Merged Data (if present in sample file)

1 Blank line

2 Merged data indicator “Merged Data”

3 Distribution type
0 = volume
1 = area
2 = number
3 = mass

integer

4 Number of points integer

5 Particle size, cumulative fraction/percent
(units as per the data presentation settings, 
repeated for each point)

floating point,
floating point

Collected Data

1 Blank line

2 Test data identifier “Test n:” where n 
= test number
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Intensity Data

Record
Number Information Conveyed Form

3 Distribution type
0 = volume
1 = area
2 = number
3 = mass

integer

4 Number of points integer

5 Particle size, cumulative fraction/percent
(units as per the data presentation settings, repeated for 
each point)

floating point,
floating point

Records 1 through 5 repeated for every test in sample file. 
Test data identifier is changed accordingly.

Record
Number Information Conveyed Form

Intensity Data 

1 Blank line

2 Test data identifier “Test n:” where n 
= test number

3 Beam obscuration floating point

4 Polarization floating point

5 Laser wavelength floating point

6 Number of points integer

7 Bounding angle class, intensity
(repeated for each point)

floating point,
floating point

8 Bounding angle class floating point

Records 1 through 8 repeated for every test in sample file. 
Test data identifier is changed accordingly.
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Record
Number Information Conveyed Form

Background Data

1 Background data identifier “Background:”

2 Number of points integer

3 Bounding angle class, intensity
(repeated for each point)

floating point,
floating point

4 Bounding angle class floating point

Records 1 through 4 repeated for every test in sample file. 
Background data identifier is changed accordingly.
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H.  BACKGROUND QUALITY

The results from a background measurement show intensity versus angle when no sample 
is present in the system to scatter light. When all of the sample has been rinsed from the 
system and the cell is clean (as indicated by Curve A) in the illustration shown below), the 
background data will show the lowest possible light intensity levels, decreasing by about 
10 orders of magnitude from a maximum at 0.0025 degrees to a minimum near 48 degrees. 
The intensity will normally rise between 36 degrees and 44 degrees. Sharp steps at the 
boundaries between beam angles (e.g. at approximately four degrees) and other fine 
details are evident in the intensity curve. This is because unscattered, stray light is being 
measured, which varies discontinuously with incident beam angle.

When the system is inadequately rinsed or the cell is dirty, higher intensities are seen 
especially at larger angles (as indicated by Curve B). The data also appear to be smoother, 
showing less sharp detail. This is because contaminants are present and scattering light in 
a smooth, continuous fashion. These contaminants may be (1) particles (or bubbles) 
suspended in the liquid, (2) particles adhered to the inside of the cell, or (3) smudges, 
fingerprints, dust, etc. on the outside of the cell, on the detector lens, or on the collimator 
lens.
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To aid in recognition of a dirty system, the previous background data are shown overlaid 
with each new set at the end of the background measurement. If the current background 
curve is higher than the previous, some contamination may exist. Note that some small 
fluctuations in intensity at large angles can occur due to slight variations in the dissolved 
oxygen content, or variations in the amount of surfactant in the liquid.

For your convenience and as a reference for a good background, a sample file containing 
background and sample data from the instrument calibration and checkout is included with 
your instrument calibration files. This file is named MRMxxx.SMP (where xxx = 
instrument serial number) and is located in the \5205\Data directory. This file shows what 
a background looked like when the instrument was new and clean, and provides a valuable 
point of reference. You may wish to select this file for overlay on the current background 
report.

If a contaminated background is indicated, perform 1 to 3 rinse cycles to remove any 
remaining suspended particles; then remeasure the background. If background data do not 
return to the minimum level, (1) check the analysis liquid for contaminants, or (2) try 
preparing a fresh batch of analysis liquid. Excess dissolved oxygen or bacterial growth 
may cause problems in liquid that has been allowed to stand for more than a few days. If 
the problem persists, drain the system and remove and clean the cell following the 
instructions provided in Chapter 9. Reinstall the cell and repeat the background 
measurement.

If frequent cell cleaning is necessary it may be that the system is not being thoroughly 
rinsed, or that samples are being improperly dispersed. Excessive sample adherence to the 
cell is an indication of inadequate dispersion.
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I.  MASTERTECH INSTALLATION

This appendix describes how to install the MasterTech 052 autosampler. The MasterTech 052 
Autosampler allows you to queue up to 18 samples and transfer them to the Saturn DigiSizer 
analyzer automatically for analysis. After installation, its operation should be verified to make 
sure that it is operating properly before actual analyses are attempted.

Removing Packing Material from the Unit

Carefully remove the MasterTech and its components from the shipping carton. Remove all 
packing material and verify that all items listed on the packing list are included. 

Equipment Damage or Loss During Shipment

If equipment is damaged or lost in transit, make note of the damage or loss on the freight bill. 
The freight carrier, not Micromeritics, is responsible for all damage or loss occurring during 
shipment. If you discover damage or loss of equipment during shipment, report the condition 
to the carrier immediately.

Equipment Return

Micromeritics strives to ensure that all items arrive safely and in working order. Occasionally, 
due to circumstances beyond our control, a customer may receive equipment which is not in 
working order. When equipment has been damaged (either during shipment or in use) and you 
wish to return the equipment to Micromeritics for repair or replacement, follow the steps 
below:

1. Pack the MasterTech in its original shipping carton if possible. If the original carton is 
unavailable, for a nominal fee Micromeritics can provide another carton for your use.

2. Tag or otherwise identify the defective equipment, noting the defect and, if possible, the 
circumstances under which the defect occurred.

3. Reference the sales order or purchase order number for the MasterTech, and provide the 
date the it was received.

4. Notify the Micromeritics Service Department of the defect and request shipping 
instructions. The Service Department will assign a Returned Materials Authorization 
(RMA) number. Write the RMA number on the outside of the carton.
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Installing the MasterTech

Place the MasterTech on a tabletop and proceed with the following instructions.

Selecting the Voltage

The MasterTech leaves the factory set for 120 VAC and with the line fuse removed. The cor-
rect setting of the universal power entrance must be checked and the appropriate fuse installed 
before the MasterTech can be operated. The MasterTech is designed to operate with either 
100, 120, 220, or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the power 
connector which is located on the rear panel of the unit.

1. Make sure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power 
connector at the rear of the MasterTech.

3. Pull the voltage selector card straight out of the power connector housing.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.

Voltage Selector Card
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4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed side facing the power ON/OFF switch.

6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement, as shown 
in the following illustration.

a. Observe the position of the fuse block, using the previous figure for reference. If the 
single-fuse arrangement is desired, position the fuse block so that the side with the 
single-fuse slot and the jumper bar is away from the cover.  

If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

Pin

Voltage

Fuse Block

Fuse

Retaining Screw

Cover

Jumper Bar

Fuse Block

Fuse Block

Fuse

Cover

Fuses

Double-Fuse Arrangement Single-Fuse Arrangement

The power cord should be disconnected from the MasterTech when installing or 
replacing fuses. Failure to do so could result in electrical shock.
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b. If the fuse block is positioned properly for the fusing desired, proceed to Step c.  

If the fuse block is not positioned properly for the fusing desired:

1) Remove the fuse block retaining screw.
2) Lift the fuse block from the cover.
3) Rotate the fuse block.
4) Mount the fuse block to the cover.
5) Replace the retaining screw.

c. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

7. Insert fuse block and cover assembly into input power connector (as shown in the 
following illustration) and snap it into place. Once the fuse block and cover assembly are 
in place, the position of the indicator pin shows the input power selected.

The fuses used in the MasterTech must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
MasterTech.

Power Source Fuse

100-120 VAC 3AG, 2.00 Amp Slow-Blow

200-240 VAC 5x20 mm, 1.25 Amp Slow Blow (Type T)
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Turning on the MasterTech

1. Make sure the proper operating voltage and fuse are selected and in place.

2. Plug the power cord into an appropriate power outlet.

3. Place the POWER ON/OFF switch in the ON ( | ) position. The +5 and +24 LEDs on the 
rear panel and some of the LEDs in the front panel switches should illuminate.

4. Press the ARM AUTO/LOAD switch on the front panel of the MasterTech. The arm 
should rise to the LOAD position, which is used for removal and replacement of the tray.

The ultrasonic probe should not be turned on at this point. Observe the indicator on 
the ULTRASONIC PROBE AUTO/ON switch on the front panel of the MasterTech. If the 
ON indicator is illuminated, press the switch to turn off the probe; the AUTO indicator 
should illuminate.

Ultrasonic Probe 
Auto/On Switch

Arm Auto/Load 
Switch
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Installing the Ultrasonic Probe

1. Place the POWER switch on the rear panel of the MasterTech in the OFF (O) position.

2. Attach the probe cable to the connector labeled Ultrasonic Probe.

3. Ensure that the probe tip is attached to the probe; if not, attach it before proceeding. A 1/4-
in. probe tip is supplied with the MasterTech; a 1/8-in. tip is also available (refer to 
Ordering Information).

4. Insert the cylinder into the arm, positioning it so that the longer slots slide over the 
protrusions inside the arm.

5. Insert the probe into the cylinder.

Make sure that power is not being supplied to the unit before starting this procedure.

Probe Cable
Ultrasonic Probe

Probe Tip

Cylinder

Cylinder Slots (one on each side)

Arm

Position the shorter slots of the cylinder over the protrusions if you are using the 1/8-
in. probe.
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Installing the Beaker Tray

1. Place the POWER switch in the ON position.

2. Make sure the arm of the MasterTech is in the LOAD (uppermost) position; the LOAD 
LED will be illuminated. If the LED is not illuminated, press the ARM AUTO/LOAD 
switch.

3. Hold the tray firmly by the outside edge. Notice that the bottom of the tray has small slots 
positioned radially outward from the inside edge. Place the tray on the MasterTech so that 
the arm passes through the center opening of the tray.

4. Make sure the drive pin is lined up into a radial slot on the bottom of the tray. The position 
of the tray does not matter at this point.

Beaker Tray

Slot

Drive Pin
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Installing Sample Transfer Tubing

This section contains one set of instructions for installing the sample transfer tubing in a 
MasterTech with serial number 500 or below, and one set of instructitons for a MasterTech 
with serial number 501 or above. Follow the instructions for your unit.

MasterTech with Serial Number 500 or Below

The MasterTech accessories kit contains two pieces of flexible tubing. One piece of tubing is 
for installation inside the MasterTech arm. The other piece of tubing is installed inside the liq-
uid sample handler, allowing for connection to the MasterTech.

1. Ensure that the MasterTech POWER switch is in the ON position.

2. Make sure the arm is in the LOAD (uppermost) position; the LOAD LED is illuminated. If 
the LED is not illuminated, press the ARM AUTO/LOAD switch.

3. Press the end of one segment of flexible tubing over the sample transfer tube until there is 
at least 1/2-in. overlap.

4. Unlatch the pump housing and unscrew the plastic knob on the rear of the pump. 

5. Thread the tubing through the pump as shown above and attach it to the rigid tubing 
labeled L (left) or R (right). Choose the side that will be adjacent to the liquid sample 
handler; for example, choose the left (L) rigid tubing if the MasterTech is to be placed to 
the right of the liquid sampler handler.

6. Close and latch the housing. Tighten the plastic knob on the rear of the pump sufficiently 
to prevent tubing slippage but not enough to restrict flow through the tubing.

Sample Transfer tube

Flexible Tubing

Arm

Rigid Tubing

Pump

Pump Housing Latch

Plastic knob

Pump Housing
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MasterTech with Serial Number 501 or Above

1. Make sure that the arm is in the Load (uppermost) position. When the arm is in the Load 
position, the Load LED is illuminated. If the LED is not illuminated, press the ARM 
AUTO/LOAD switch.

2. Unscrew the two thrumbscrews from the cover of the pump housing, then remove the 
cover.

3. A 21-in. segment of flexible tubing is shipped with the MasterTech. Remove the cover 
from one of the steel tubes labeled L (Left) or R (Right). Choose the steel tube labeled 
with the side of the MasterTech from which you want the fluid to be discharged. Then 
attach one end of the flexible tubing to the steel tube.

Load position

A                                                        B

A                                                                B
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4.  Loop the tubing around the pump rollers in a clockwise direction, using one hand to hold 
the two ends of the tubing loop in the two grooves at the base of the pump.

5. Insert the key between the pump rollers near the left side of the pump base, with the key 
blade between the tubing and the plate on the top of the rollers. 

6. Turn the key clockwise so the tubing presses into the groove until the key is stopped by the 
peg in the right side of the pump body.
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7. Slide the key out, then place the cover over the pump, wiggling it slightly to align it with 
the pump body and press it into place. Then insert and tighten the two thumbscrews only 
tight enough to secure the cover.

8. Attach the other end of the flexible tubing to the Sample Transfer tube on the front of the 
MasterTech as shown below.

9. With the instrument schematic displayed, enable Manual Mode. Right-click the 
MasterTech Pump icon and select Turn On.

10. The pump should begin operating. If the pump does not start or is sluggish, pull on the 
long end of the tubing to create tension and pull excess tubing out of the pump, no more 

                                                                            A                                                                   B  
520-42805-01 (Rev H) - Nov 2018                                       I-11 



Appendix I Saturn DigiSizer II 5205
than 1/4-in. should be required. (Loosen the thumbscrews if necessary.) When the pump is 
operating freely, hand-tighten the two thumbscrews, then turn the pump off.

11. Press the ARM AUTO/LOAD switch to place the arm in the AUTO position.
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Connecting to Liquid Sample Handler

The following steps are common to both liquid sample handlers. After performing these steps, 
advance to the section applicable to the liquid sample handler you have connected to your 
analyzer.

1. Select Unit [n] > Drain > DigiSizer to remove any liquid that may be in the liquid sample 
handler.

2. Turn off the liquid sampler and the analyzer.

3. Remove the retaining screws on the right side of the liquid sample handler, then loosen the 
captive thumb screw on the rear panel.

4. Lift off the cover and set aside.

Standard Liquid Sample Handler

1. Locate the analysis liquid inlet tubing on the inside of the liquid sample handler. 

2. The analysis tubing has a connector approximately two inches from the inlet fitting; 
remove this connector.

3. Using the T-connector supplied in the MasterTech accessories kit, reconnect the tubing 
using the two larger ends of the T-connector.

Remove this connector

Analysis Liquid tubing

T-connector
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4. Insert the remaining piece of flexible tubing through the hole provided on the base of the 
sample handler.

5. Guide the tubing through the hole in the front chassis (just below the rinse pump) and 
connect it to the remaining barbed fitting of the T-connector.

6. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of Installing Sample Transfer Tubing. 

7. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

MasterTech Flexible tubing

Barbed connector

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
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Low-Volume Liquid Sample Handler

1. Locate the T-fitting of the stainless steel tubing of the drain manifold.

2. Use the 7/16- and the 1/2-in. wrenches provided in the accessories kit for this step. Hold 
the T-fitting secure with the 7/16-in. wrench, then use the 1/2-in. wrench to loosen and 
remove the topmost nut.

3. Remove the stainless steel plug from the nut. Be sure to store the plug in a secure location. 
If the MasterTech is disconnected, this plug will need to be reinstalled in the liquid sample 
handler.

4. Insert the stainless steel connector into the nut (the barbed end should be on the outside).

5. Reattach the nut to the T-fitting; tighten finger-tight. Then, using the two wrenches as 
shown above, tighten the nut 1/4 turn.

6. Insert one end of the flexible tubing (provided in the accessories kit) through the hole 
provided on the base of the sample handler.

T-fitting
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7. Guide the tubing through the hole in the front chassis and connect it to the barbed fitting of 
the T-connector. 

8. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of Installing Sample Transfer Tubing. 

9. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

Tubing connected to fitting

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
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Connecting Cables

1. Place the MasterTech to the appropriate side (the side designated when installing the 
sample transfer tubing) of the liquid sample handler.

2. Make sure the power switches on the ultrasonic probe (if installed), analyzer, liquid 
sample handler, and MasterTech are in the OFF positions.

3. Insert one end of the serial cable into the connector labeled RS-232 Spare on the rear 
panel of the Liquid sample handler.

4. Insert the other end of the cable into the connector labeled RS232 on the back of the 
MasterTech. 

Verifying Operation

To verify operation, manually move each subsystem using the manual control option of the 
Saturn DigiSizer analysis program.

1. Turn on the Saturn DigiSizer system components in the following order:

a. Ultrasonic probe (if installed)

b. MasterTech autosampler; allow MasterTech to initialize before turning on the liquid 
sample handler

c. Liquid sample handler

d. Saturn DigiSizer

2. Start the Saturn DigiSizer software; initialization may take a few minutes.

3. Fill a beaker with approximately 80 mL of water.

4. Place the beaker in the number 1 position of the tray.

5. To test the ultrasonic probe, remove it from the holder and insert the tip of the probe well 
into the water.

NEVER operate the ultrasonic probe without having the tip immersed into a liquid. 
Doing so may harm the probe and/or the driving electronics. 

DO NOT let the tip of the probe come in contact with a glass beaker. Doing so may 
shatter the beaker.
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6. While holding the probe tip underwater, press the ultrasonic probe AUTO/ON switch. You 
will hear a high-pitched sound, indicating that the probe is working properly.

7. Press the ultrasonic probe AUTO/ON switch again to turn off the probe.

8. Place the probe back into the holder.

9. Select Unit [n] > Enable Manual Control. If the instrument schematic is not displayed, 
select Show Instrument Schematic.

10. Ensure that the Arm AUTO/LOAD switch on the front panel of the MasterTech is in the 
AUTO position.

11. Select Unit [n] > Initialize MasterTech.

A message is displayed indicating that initialization is in progress. The tray on the Master-
Tech rotates in a counterclockwise direction for one beaker position; the arm lowers to the 
Rinse position and returns.

The tray then continues to rotate until position 1 is reached. The beaker inserted in the tray 
in Step 4 should now be directly under the arm of the MasterTech. Make sure the beaker 
contains approximately 80 mL of water.

12. On the instrument schematic, select the symbol representing the MasterTech arm.

DO NOT press the ultrasonic probe AUTO/ON switch unless the probe and its cable 
are properly connected to the MasterTech. Doing so may harm the driving electronics.

MasterTech 
portion of the 
instrument 
schematic

When manual mode is enabled, components on the instrument schematic have 
shortcut menus displaying the options available for that component. Select the 
component, then click the right mouse button to access its menu. 
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In each instruction for this step, first access the pop-up menu:

a. Select Move Arm Down two times.

b. Select Ultrasonic On; you will hear a high-pitched sound, indicating that the probe is 
operational. 

c. Select Ultrasonic Off to turn off the probe.

d. Select Stirrer On; the stirrer begins to operate.

e. Select Stirrer Speed Fast.

f. Select Move Arm Up.

g. Select Stirrer Off.

h. Select Move Arm Up.

i. Select Move To Beaker and enter the beaker position; note that the display is updated 
to reflect the position of the beaker tray. The picture on the screen will reflect whether 
or not a beaker is present.

13. Place the MasterTech pump switch on the front panel in the AUTO position, then select 
the MasterTech pump on the schematic. In each instruction in this step, first access the 
shortcut menu:

a. Select On; the MasterTech pump should begin operating (you will hear a whirring 
sound and the pump will begin to operate).

b. Check the direction of the flow of the MasterTech pump:

Select Flow Direction Load; allows suspension to flow from the MasterTech to the 
Saturn DigiSizer system for analysis.

Select Flow Direction Rinse; allows suspension to move from the Saturn DigiSizer 
system to the MasterTech. This direction is used to rinse the sample from the stirrer 
and transfer tube on the MasterTech.

c. Select Off to turn the pump off.

MasterTech Arm

MasterTech Pump Beaker Position
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14. Rinse and prime the tubing of the MasterTech:

a. Place an empty beaker in position 2 of the MasterTech tray.

b. Select Unit [n] > Rinse > MasterTech then DigiSizer.

c. Specify 2 as the beaker position, then click OK.

This concludes verification of operation of the MasterTech. If everything performed as 
described above, the system should be fully operational. If you encounter any problems, refer 
to the troubleshooting section of the operator’s manual.
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J.  LIQUID SAMPLE HANDLER INSTALLATION

This appendix describes how to install liquid sample handlers in the event you wish to use 
both types available, the standard one or the low-volume one. These instructions are written 
with the assumption that a liquid sample handler is currently attached to the DigiSizer.

Disconnecting the Current Liquid Sample Handler

The following steps are common to both liquid sample handlers.

1. Select Unit [n] > Drain > DigiSizer to remove any liquid that may be in the liquid sample 
handler.

2. Turn off the liquid sample handler and the analyzer.

3. Open the front panel of the analyzer.

4. Loosen all three screws on the cover of the sample cell compartment; remove the cover 
and set aside.

5. Disconnect the sample transfer tubing from the upper and lower connectors of the sample 
cell holder.

Sample cell compartment

Upper connector

Sample cell holder

Lower connector
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6. Grasp the liquid sample handler and slowly pull it away from the DigiSizer; store in an 
appropriate location.

Installing the Liquid Sample Handler

The Liquid Sample Handler is available in two configurations: 

• Standard unit: includes a reservoir that holds 500 to 600 mL of dispersed sample. This 
model is best suited for samples containing coarse particles, or for those of high density. 

• Low-Volume unit: includes a reservoir that holds 100 to 120 mL of dispersed sample. 
This model is best suited for analyses where the sample quantity or dispersion liquid is 
limited, or where the dispersion liquid may be hazardous or difficult to dispose.

The liquid sample handler transfers the sample to the analyzer for analysis. Precut tubing is 
provided for this purpose; if you are installing the:

• Standard unit, the tubing is 1.27-cm (1/2-in.) diameter (2 pieces)
• Low-volume unit, the tubing is 0.79-cm (5/16-in.) diameter (1 piece)

Both configurations are installed similarly; differences are noted.

1. Place the liquid sample handler in position next to the analyzer.

2. Remove the two plugs from the ports on the side of the sample handler.

• If you are installing the Low-volume unit, the tubing on the upper port is installed; 
remove the plug from the end of the tubing.

3. Install the tubing onto the connectors provided on the left side of the liquid sample 
handler. One piece of tubing is approximately 2 inches longer than the other; install this 
piece on the upper connector and the shorter one on the lower connector.

Longer piece on upper port.

This piece of tubing is 
already installed if you have 
the Low-volume unit.

Shorter piece on lower port.
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• If you are installing the Low-volume unit, the tubing on the upper port is installed; 
install the tubing supplied with the unit on the lower port.

4. Slide the liquid sample handler toward the analyzer, guiding the tubing through the ports 
on the right side of the analyzer.

Do not allow the analyzer and liquid sample handler to touch; metal-to-metal contact may 
cause vibrations and, thus, inaccurate data.

5. Open the front panel of the analyzer (if not still open).

6. Attach the sample transfer tubing to the sample cell holder as shown below.

7. Attach the RS232 communications cable as follows:

a. Connect one end of the cable to the port labeled RS232 From Saturn Analyzer on the 
rear panel of the liquid sample handling unit.

b. Connect the other end of the cable to the port labeled Sample Handling Unit RS232 
on the rear panel of the analyzer.

Upper Tubing port

Saturn DigiSizer Liquid Sample Handler

Lower Tubing port

Upper connector

Sample cell holder

Lower connector
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8. Plug the liquid sample handler’s power cord into an appropriate power source. The liquid 
sample handler is equipped with universal power input; therefore, voltage selection is 
unnecessary.
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INDEX

Symbols
# symbol, 6-16
$ symbol, 6-11, 8-10

A
Adding an analyzer, 4-11
Advanced format, 8-3

creating sample information file, 3-14, 5-8
sample defaults, 8-6
specifying defaults for, 3-3, 8-6

Advanced Sample Information dialog, 5-8
All file status, 2-16
Analyses, performing

MasterTech Automatic method, 3-26, 6-15
MasterTech Schedule method, 3-28, 6-18
QuickStart method, 3-24, 6-10
Sample Analysis method, 3-22, 6-4

Analysis Conditions dialog, 5-11
Analysis conditions file

listing file statistics, 3-30
Analysis conditions files, 5-11

creating offline, 4-1
generating a list, 5-42
printing contents, 5-40

Analysis liquid
adding to list, 5-17
adding to list (Background dialog), 6-22
changing, 3-10
density and viscosity values, D-1
different from rinse liquid, 6-45

Analysis program
exiting, 5-46
for offline data manipulation, 4-1
installing, 4-1
installing upgrade, 4-10
reinstalling, 4-8
uninstalling, 4-21
using, 2-11
See also Software

Analyzer
adding another, 4-11
changing ethernet connection, 4-18
cleaning, 9-4
description, 1-5
front panel, 2-1
moving from one computer to another, 4-13
preparing for idle periods, 2-10

rear panel, 2-2
removing, 4-17
removing from computer, 4-17
specifications, 1-8
turning on and off, 2-9

Analyzing file status, 2-16
Angle classes, F-3
Arm

MasterTech, 6-38
rotation, 6-37
switch, MasterTech, 2-7

ASCII format, 5-44, G-1
exporting data, 5-44

Autodilute, 6-5
Autorinse, 5-14, 6-26
Autoscale, 5-29
Autoscale options, 7-11
Axis

coordinates, viewing, 7-28
properties, editing, 7-26
range, 7-11

Axis Properties dialog, 7-26

B
Background

current, date and time, 7-6
determining acceptable, H-1
generating report, 3-34, 7-6
measuring, 3-8, 6-22

Background command
Reports menu, 7-6
Unit menu, 6-22

Background liquid
See Analysis liquid

Background Measurement dialog, 6-22
Background Options dialog, 5-29
Background report, 7-6

example of, 7-36
Basic format, 8-3, 8-4

creating sample information file, 3-12, 5-5
specifying defaults for, 3-1, 8-9

Basic Sample Information dialog, 5-5
Beaker tray, MasterTech

aligning, 6-31
installing, I-7

Beam angle, 5-13
Beam obscuration

guidelines, 6-7, B-3
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high, 6-8, 6-13
low, 6-8, 6-13

Board ID dialog, 6-44
Bookmarks tab, 2-21
Browse push button, 2-14, 5-21

C
Calculations, F-1
Calibration dates, 6-44
Calibration file

reinstalling, 4-20
Cancel dialog, MasterTech, 6-17, 6-21
Cancel push button, 2-14
Cascade windows, 2-20
Cautions

detector lens, 9-5
Cautions, defined, 1-3
CCD, 1-5, 6-38
Cell

See Sample cell
Center line, 7-15
Check boxes, 2-14
Circulate before data collection, 5-12
Close All command, 5-39
Close command, 5-39
Close Reports command, 7-5
Coefficient of variation, 7-16
Collected data, 5-34, F-19
Collimator lens, cleaning, 9-7
Combined report, 5-24

example of, 7-29
Complete file status, 2-16
Concentration

See Sample
Confidence interval, 7-16
Connectors, front and rear panels, 2-1
Continue push button, 6-28
Continuous scan, 6-36
Control Chart command, 7-13
Control Chart Graph dialog, 7-14
Control Chart options dialog, 7-13
Control Chart report, 7-13

generating, 3-38
selecting statistics, 7-16

Control Chart Sample Selection dialog, 7-15
Control Chart Summary Statistics dialog, 7-16
Controls, front and rear panel, 2-1
Cross hair, axis, 7-28
Cross-references, 2-24
Cumulative Fraction Table Options, 5-25
Curve Properties dialog, 7-25
Curve thickness, changing, 7-22

D
Data

collected, 5-34, F-19
deconvoluted, F-19
entered, 5-37
exported format, G-1
exporting in ASCII format, 5-44
external, 5-35
intensity, exporting, 5-44
manipulation offline, 4-1
merged, 5-34, F-10
particle distribution, exporting, 5-44
plotting type, 5-27
points, labeling, 7-11
reduction, F-1
smoothing, 5-18
truncating, 5-18

Data presentation command, 8-11
Dates push button, 2-16
Deconvolution, F-3, F-4

data, F-19
Default Style dialog, 7-22
Defaults

 See also Sample defaults
for report fonts, 7-22

Defaults, sample
Advanced format, 8-6
for parameter files, 8-6

Density and viscosity values, D-1
Detector, 1-8
Detector Display dialog, 6-36
Detector Expose dialog, 6-36
Detector lens, 1-8

cleaning, 9-5
Dialog boxes, about, 2-13
Difference from Reference report

choosing file for, 5-20
selecting, 5-27

DigiSizer Model Management Utility dialog, 4-5
DigiSizer Rinse dialog, 6-26
Directories window, 2-17
Dispersant

sources, E-1
Dispersion

methods, B-1
types, C-1

Drain command, 6-31

E
Enable Manual Control command, 6-32
Entered data, 5-37
Entered file status, 2-16
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Error messages, A-1
2400 series, A-1
2500 series, A-8
4200 series, A-12
unnumbered, A-31

Ethernet
switch, connecting, 4-11

Exit command, 5-46
Exiting the analysis program, 5-46
Export command, 5-44
Exporting sample files, 3-31, 5-44
Extensions, file name, 2-18
External data, 5-35
External Data dialog, 5-35

F
File

destination, 5-41
exporting, 5-44
name, default extensions, 2-18
name, included as part of identification, 8-7, 8-10
printing to, 7-4
Sample information file, 2-18
selecting, 2-15
status, 2-16

File menu, 5-1
Close All command, 5-39
Close command, 5-39
description, 5-1
Exit command, 5-46
Export command, 5-44
List command, 5-42
Open command, 5-3
Print command, 5-40
Save all command, 5-39
Save As command, 5-38
Save command, 5-38

Filter
air, replacing, 9-10
laser, 6-35

Find command, 2-25
Flow rate, 5-12

background measurement, 6-23
Fraunhofer theory, F-1
Front panel

DigiSizer, 2-1
Liquid sample handler, 2-4
MasterTech, 2-6

Function keys
 See Shortcut keys

Fuse
replacing, analyzer, 9-11
replacing, MasterTech, I-4

Fuse type
MasterTech, I-4

G
Goodness of Fit report, 5-30

example of, 7-37
Graph

copying as metafile, 7-27
editing in sample file, 5-27
editing onscreen, 7-25
legend, editing, 7-26
push button, 7-14

Graph Overlay Samples dialog, 5-21
Graphic, showing in report title, 5-20

H
Help menu, 2-20
Histogram, 5-27, 7-22, 7-26

I
Index, online, 2-24
Indicators, front and rear panels, 2-1
Inorganic material, 1-5
Installation

analysis program, 4-1
analysis program, subsequent, 4-8
MasterTech 052, I-1

Instrument log, 6-42
viewing from operational window, 6-4

Instrument schematic
description of components, 6-32
manual control, 6-32
showing, 6-40
viewing from operational window, 6-4

Intensity control switch, MasterTech, 2-6
Intensity data, exporting, 5-44
Interpolation, F-10

L
Label data, 7-11
Laser, 1-8, 6-35

filter, 6-35
polarization, F-1

Legend Properties dialog, 7-26
Lens, 1-8
Lens, collimator

See Collimator lens
Lens, detector

See Detector lens
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Light scattering, 1-5
Limit lines, 7-15
Linear supply breaker, 2-3
Links, 2-23
Liquid

See Analysis liquid
Liquid level, 6-10

adjusting, 6-8, 6-13
Liquid sample handler, 1-6

front panel, 2-4
installing, J-2
rear panel, 2-5

List command, 5-42
List, generating, 3-30, 5-42
Load from MasterTech command, 6-25
Local disk, 4-6
Log Probability report, 5-31
Log Report Settings dialog, 6-42
LSHU

See Liquid sample handler
LSHU configuration options dialog, 6-45

M
Manual control, 6-32

accessing shortcut menus, 6-32
MasterTech, 1-7

connecting cables, I-17
connecting to DigiSizer, I-17
front panel, 2-6
fuse type, I-4
initializing, 6-31
installing beaker tray, I-7
installing sample transfer tubing, I-8
installing ultrasonic probe, I-6
rear panel, 2-8
turning on, I-5
verifying operation, I-17
voltage, selecting, I-2

MasterTech Automatic command, 6-15
MasterTech Automatic dialog, 6-15
MasterTech Load dialog, 6-25
MasterTech Operation Cancel dialog, 6-17, 6-21
MasterTech Rinse dialog, 6-28
MasterTech Schedule command, 6-18
MasterTech Schedule dialog, 6-18
MasterTech Schedule Insert dialog, 6-18
MasterTech Then DigiSizer Rinse dialog, 6-29
MasterTech Treatment dialog, 5-14
Material

See Sample material
Material Properties dialog, 5-15
Material properties file

listing file statistics, 3-30

Material properties files
creating offline, 4-1
generating a list, 5-42
printing contents, 5-40

Menu bar, 2-19
Menu structure, 2-19
Merged data, 5-34, F-10
Metafile, copying graphs as, 7-27
Mie theory, F-1
Models, 4-5

disk space required, 4-5
generating, 5-17
installing, 4-5

Monitor resolution, 1-10
Moving an analyzer to another computer, 4-13

N
Push button

Graph, 7-14
Next push button, 2-14
No analysis file status, 2-16
Notes, defined, 1-3
Number of tests, 6-5

O
Online manual

cross references, 2-24
index, 2-24
printing options, 2-26
using, 2-21
See also Operator’s manual

Open command, 5-3
Open Report command, 7-5
Operator’s manual

conventions, 1-3
online, 2-21
organization, 1-1

Option presentation command, 8-3
Options menu, 8-1

Data presentation command, 8-11
Option presentation command, 8-3
Parameter files directory command, 8-12
Sample defaults command, 8-6
Service Test Mode, 8-2

Options push button, 5-17
Organic material, 1-5
Out of Specification report

selecting, 5-27
specifying files for boundaries, 5-21

Overlay Settings dialog, 5-28
Overlays

for all tests in same file, 5-28
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for multiple samples, 5-28
generating, 3-41
specifying, 5-21
two graphs in same file, 5-28

P
Parameter File Directory Selection dialog, 8-12
Parameter files, 3-15, 5-4

Analysis conditions, 5-11
Analysis conditions, creating, 3-15
creating offline, 4-1
establishing defaults, 8-6
generating a list, 5-42
Material properties, 5-15
printing contents, 5-40
Report options, 5-19
saving from sample information file, 5-38
specifying location, 8-12

Parameter files directory command, 8-12
Particle

diameter, B-3
distribution data, exporting, 5-44

Particle Size Table report
editing, 5-25

Password, restricted format, 8-4
Peak

Summary report, 5-33
valley depth, 5-22

Peak Detection Settings dialog, 5-22
Polarization, F-1
Power indicator will not illuminate, 9-11
Power, turning on and off, 2-9
Prev push button, 2-14
Print command, 5-40
Printing to a File

description, 5-41
PSD History Options dialog, 7-17
PSD History report, 7-17

generating, 3-40
Pump

analysis liquid, 6-33
circulating, 6-33
MasterTech, 6-38
rinse, 6-33
turning on and off, 6-32

Pump Speed Setting dialog, 6-33
Pump switch, MasterTech, 2-7
Push button, 2-13

Browse, 2-14
Cancel, 2-14
Continue, 6-28
Dates, 2-16
Next, 2-14

Prev, 2-14
Replace, 2-15
Resume, 2-15
Save as default, 7-12
Suspend, 2-15

Q
QuickStart

Autodetect each new sample, 6-14
prompt for files, 6-12

QuickStart command, 6-10
QuickStart dialog, 6-10

R
Radio buttons, 2-13
Rear panel

DigiSizer, 2-2
Liquid sample handler, 2-5
MasterTech, 2-8

Recalculate archived SPC results, 7-15
Reference Angle dialog, 6-37
Refractive index, 5-18
Regression report, 7-10

generating, 3-36
Regression Report command, 7-10
Regression Report Options dialog, 7-10
Regression Report Sample Selection dialog, 7-11
Regularization, F-4
Removing an analyzer, 4-17
Replace push button, 2-15
Report Options dialog, 5-19
Report options files, 5-19

creating offline, 4-1
defining, 3-20
generating a list, 5-42
listing file statistics, 3-30
printing contents, 5-40

Reports
calculations, F-1
closing, 7-5
Combined, editing, 5-24
displaying company logo in title, 5-20
examples of, 7-28
generating, 3-32, 7-3
generating offline, 4-1
graphs, editing in sample file, 5-27
graphs, editing onscreen, 7-25
header, 7-19
legend, editing, 7-26
Log probability, 5-31
onscreen, shortcut menus for, 7-23
opening, 7-5
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saving in other formats, 7-22
selecting, 2-17
selecting fonts, 7-22
SPC, 7-7
Summary, editing, 5-31
tabular, editing in sample file, 5-25
Tabular, editing onscreen, 7-23
title, 5-20
Tool bar, 7-20
zoom feature, 7-27

Reports menu, 7-1
Background command, 7-6
Close Reports command, 7-5
Control Chart command, 7-13
Open report command, 7-5
PSD history command, 7-17
Regression Report command, 7-10
SPC Report Options command, 7-7
Start Report command, 7-3

Reservoir, 6-34
cleaning, 9-8

Restricted format, 8-3, 8-4
Results, showing, 6-41
Resume push button, 2-15
Rinse after analysis, 5-13
Rinse command, 6-26
Rinse operation, performing

DigiSizer, 3-5
DigiSizer and MasterTech, 3-7
MasterTech, 3-6

Rosin Rammler report, 5-30
Rotation Move dialog, 6-37
RS232 connections, J-3

S
Sample

dispersion, B-1
resuspension, 6-15
transfer tubing, installing, I-8

Sample Analysis command, 6-4
Sample Analysis dialog, 6-4
Sample cell

cleaning, 9-4
removing, 6-31

Sample concentration, B-3
adjusting, 6-8, 6-13
calculations, F-19
large particles, B-4
medium-sized particles, B-4
monitoring automatically, 6-5
small particles, B-4

Sample defaults, 8-6
Advanced format, 8-6

specifying, Advanced format, 3-3
specifying, Basic format, 3-1, 8-9

Sample defaults command, 8-6
Sample Defaults dialog

Advanced format, 8-6
Basic format, 8-9

Sample dispersion, B-1
Sample handler

 See Liquid sample handler
Sample information files, 5-4

Advanced format, 5-4, 5-8
Basic format, 5-4, 5-5
creating, 3-12
creating offline, 4-1
defaults for Advanced format, 8-6
exporting, 3-31, 5-44
listing statistics, 3-30, 5-42
number of tests allowed, 6-5
printing contents, 5-40
Restricted format, 5-10
specifying defaults, 8-6

Sample Log report, 5-33
Sample material

adding to list, 5-16
large particles, B-4
medium-sized particles, B-4
small particles, B-4

Sample SPC Options dialog, 7-8
Samples push button

Control Chart report, 7-15
PSD History report, 7-18
Regression report, 7-11, 7-18

Saturn DigiSizer system
See System

Save all command, 5-39
Save As command, 5-38
Save as Default push button, 7-12
Save command, 5-38
Scattering Model Advanced Options dialog, 5-17
Schematic

See Instrument schematic
Select Dates dialog box, 2-16
Selecting reports, 2-17
Sensor, liquid level, 6-34
Service Test Mode command, 8-2
Setup program

adding an analyzer, 4-11
moving an analyzer to another computer, 4-13
reinstalling analysis program, 4-10
reinstalling calibration files, 4-20
removing an analyzer from the computer, 4-17
uninstalling software, 4-21

Shortcut keys, 2-11
for Select Dates dialog, 2-16
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instrument schematic in manual control, 6-32
list of, 2-12

Shortcut menu, 2-11
Show Instrument Log command, 6-42
Show Instrument Schematic command, 6-40
Show Results command, 6-41
Show Status command, 6-41
Sieve size, 5-35, F-9

specifying defaults, 8-11
Sieve Table dialog, 8-11
Signal fraction, minimum, 5-18
Size classes, F-3
Smoothing, specifying, 5-18
Software

installing, 4-1
installing upgrade, 4-10
reinstalling, 4-8
uninstalling, 4-21
using, 2-11
See also Analysis program

SPC Analysis Conditions Options dialog, 7-8
SPC Percentile Options dialog, 7-9
SPC Report Options command, 7-7
SPC Report Options dialog, 7-7
SPC reports, 3-35

generating, 3-35
selecting options for, 7-7
 See also Control chart reports
 See also Regression report

SPC Size Options dialog, 7-9
Specifications, 1-8
Spreadsheet, saving data for, 7-22
Standard Class Size Table report, 5-25
Standard Sieve Table report, 5-25
Start Report command, 7-3
Start Report dialog, 7-3
Status dropdown list, 7-4
Status window, showing, 6-41
Summary Peaks dialog, 5-33
Summary Percentiles dialog, 5-32
Summary report, 5-31

example of, 7-38
Summary Sizes dialog, 5-32
Summary Statistics button, 7-16
Suspend push button, 2-15
System

draining, 6-31
preparing for idle periods, 2-10
turning on and off, 2-9

T
Table of Contents, online, 2-23
Tabular report, 7-11

editing, 5-25
examples, 7-30

Text, copy graph data as, 7-27
Thumbnails tab, 2-26
Tile windows, 2-20
Title Properties dialog, 7-27
Tool bar, reports window, 7-20
Troubleshooting, 9-1
Truncate data, 5-18
Truncate table at distribution limits, 5-26
Tubing

MasterTech, I-8

U
Ultrasonic Intensity Setting dialog, 6-35
Ultrasonic probe

installing, MasterTech, I-6
replacing probe tip, 9-12

Ultrasonic Probe switch, MasterTech, 2-6
Unit Configuration command, 6-44
Unit IP Setup dialog, 6-45
Unit menu, 6-1

Background command, 6-22
Drain command, 6-31
Enable Manual Control command, 6-32
Load from MasterTech command, 6-25
MasterTech Automatic command, 6-15
MasterTech Schedule command, 6-18
QuickStart command, 6-10
Rinse command, 6-26
Sample Analysis command, 6-4
Show Instrument Log command, 6-42
Show Instrument Schematic command, 6-40
Show Results command, 6-41
Show Status command, 6-41
Unit Configuration command, 6-44

User parameters, 5-9, 8-8

V
Valve, closing and opening, 6-32
Verifying operation, MasterTech, I-17
View, 6-4
Viscosity and density values, D-1
Voltage

requirements, MasterTech, 1-11
requirements, sample handler, 1-9
selecting for MasterTech, I-2

W
Warnings, defined, 1-3
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Waste valve, 6-34
Windows

environment, 1-6
menu, 2-20

X
Xaxis, 7-11
Xaxis Order By, 7-14

Y
Yaxis, 7-11

Z
Zoom feature, 7-27
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